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Getting Started

Welcome to IBM® Sterling Gentran:Director® Application Integration
subsystem, IBM’s Electronic Data Interchange (EDI) mapping software for
the Windows operating system. Sterling Gentran:Director provides you with
the tools you need to tranglate your application filesto EDI standard formats
for documents you send to your partners (outbound mapping), and to
translate EDI standard formatsto your application format for documents that
you receive from your partners (inbound mapping).

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 1
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What's in this Manual

2 May 2011

This manual contains atutoria for Sterling Gentran:Director Application
Integration subsystem, using the TRADACOMS standard. This tutorial
includes an inbound mapping example (purchase order) and an outbound
mapping example (invoice). The purpose of thistutorial isto break the
mapping process into concise and understandabl e steps, using examples that
will enable you to understand and master the tasks and processes required to
create your own maps.

To access reference information, refer to the Sterling Gentran: Director
Application Integration online Help or IBM® Serling Gentran: Director®
Release 5.5 Application Integration User Guide. For additional information
on the various tasks described in this manual, refer to the IBM® Serling
Gentran: Director® Release 5.5 User Guide.

Thismanual assumesthat you arefamiliar with usinga
PC and with Microsoft® Windows functions,
including:

n Theterminology used to describe mouse and
cursor actions.

n Theterminology used to describe Windows-
specific attributes, including dialogue boxes, icons,
windows, and buttons.

This manual also assumesthat you are familiar with

EDI concepts, EDI standards structure, your internal

application format, data mapping concepts, and

Serling Gentran:Director.

The IBM® Serling Gentran: Director® Release 5.5 Tutorial Guideis
organised into chapters. A brief description of the chapter contents follows.

e Chapter 1, Getting Sarted explains the content, organization,
conventions, and system requirementsin this guide. This chapter briefly
describes how to build maps using Sterling Gentran:Director
Application Integration and how to customize global display options. It
also introduces mapping and Sterling Gentran:Director.

*  Chapter 2, Inbound Purchase Order (ORDERYS) uses a step-by-step
approach to explain the tasks and procedures necessary to create an
export map for aTRADACOM S inbound (ORDERS) purchase order.

e Chapter 3, Outbound Invoice (INVOIC) uses a step-by-step approach to
explain the tasks and procedures necessary to create a system import
map and an import map for a TRADACOMS outbound (INVOIC)
invoice.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Getting Started What’s in this Manual

» The Glossary contains definitions of mapping and Application
Integration subsystem terms and concepts.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 3
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Conventions in

this Manual The different typefaces used in this manual are as follows:

4 May 2011

Creating a new map

NEW..

F1

Thistypeface is used for emphasis or to indicate a
chapter or section in this manual or other Sterling
Gentran:Director manuals.

This typeface indicates a button in the program.
Click the button with your mouse, or press TAB
until the button is highlighted, then pressENTER
to execute that command.

Thistypeface indicates a key that you need to press
on your keyboard. A plus sign (+) between key
names indicates a combination of keysto be
pressed together (e.g., ALT + TAB).

The different icons used in this manual are as follows:

Thisicon indicates a caution that alertsyou to the
potential loss of information. Please read any text

Thisicon indicates a note that gives you additional
information on the current subject.

preceded by thisicon carefully.

Thisicon indicates helpful tips, suggestions, shortcuts,
and alternative actions.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Getting Started Introducing Mapping

Introducing Mapping

A map isaset of instructions that you define in the Sterling Gentran: Director
Application Integration subsystem to indicate the relationship between your
application file and the EDI standards. A map also defines how the system
trand ates data.

Inbound  For inbound mapping, the system translates your trading partner’s EDI
standard formatted business document to your application file format. To
translate inbound data, you must create an export map in the Sterling
Gentran:Director Application | ntegration subsystem because the system is
exporting to your application file.

Outbound For outbound mapping, the system trand ates your application file format to
EDI standard formats, so you can send documents to your partners. To
tranglate outbound data, must to create an import map and a system import
map. You must create an import map because the system isimporting from
your application file. The import map defines how to move data from your
application file (flat file definition) to the EDI standard-formatted
documents that your partner expects to receive from you. When an
application file contains multiple documents, you must create a system
import map to specify which trading relationship (established in Partner
Editor) corresponds to which document in the application file so the system
knows the import map to use to process the document.

Translation The map you create is the source from which you compile atranslation

Objects object. A translation object isaset of rules that instructs the translator how
to convert afile from one format to another. Each function performed during
tranglation requires a trandation object. Trandation objects control all
Sterling Gentran:Director EDI translation functions. Trang ation objects can
be either system translation objects or user translation objects. System
trangl ation objects control the creation and separation of interchanges,
functional groups, and transaction sets. They are also used to generate and
reconcile functional acknowledgements. User translation objects control
data entry, importing, exporting, document turnaround, and creating printed
reports. All required system trandlation objects are automatically installed
with Sterling Gentran:Director.

Sterling Gentran:Director Application Integration alows you to generate
import, export, and document turnaround translation objects. The IBM®
Sterling Gentran:Director® Forms Integration subsystem enables you to
generate data entry and print transl ation objects. Once you generate a
trand ation object using the Sterling Gentran:Director Application

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 5
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Application File
Format
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Integration subsystem (or the Sterling Gentran:Director Forms Integration
subsystem), you must register the translation object with Sterling
Gentran:Director (see the IBM® Serling Gentran: Director® Release 5.5
User Guide for more information). In addition, you must establish correct
trading relationships for all trading partners. To establish atrading
relationship, you must specify the appropriate transl ation object name that
the trandator uses to trand ate the data. (See the IBM® Serling

Gentran: Director® Release 5.5 User Guide for more information.)

The diagram below illustrates the inbound and outbound translation process:

Export Translation Object

'

Application
Inbound L» L»

Sterling

Outbound -«—— Gentran:Director -
EDI Application

i

Import Translation Object

When you create an import map, you must define to Sterling
Gentran:Director your application file format and the EDI standard format in
which your partners expect to receive the documents. When you create an
export map, you must define to Sterling Gentran:Director the EDI standard
format in which your partners will send documents and your application file
format (how the data needs to be formatted for your application to process
it).

If you are creating an import or export map, you must define your
application to the Sterling Gentran:Director Application Integration
subsystem. In Sterling Gentran:Director terminology, your application fileis
also referred to as afixed-format file or apositional file. Your application file
must contain all the field information that you either extract from your
partner’s document (if the map is inbound) or that you need to send to your
partner (if the map is outbound).

The map components that you define your application file are:

* A group isalooping structure that contains related records and/or

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial
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EDI File Format

groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is alowed to repeat is
exhausted. If you create a group that is subordinate to another group (a
sub-group), this corresponds to a nested looping structure (aloop within
aloop). The application (positional) fileisagroup and is visualy
represented the same way as other groups and sub-groupsin the
Application Integration subsystem: (T

» Arecord contains agroup of related fields. A record occurs once or
repeats multiple times. A record isvisually represented in the
Application Integration subsystems as: 0

» Afield isthe smallest piece of information defined in the application
file. A field isthe application map component that is mapped (linked) to
a corresponding EDI element. It isvisually represented in the
Application Integration subsystems as. @

After afield has a mapping operation performed against it, ared
checkmark is displayed over the field icon.

Before you define your application file format, obtain alayout of the
necessary records, fields, and groups. Each map component is arranged
sequentialy in the order that it is most logical for the system to process.
Each level of your application file must be created sequentially. For
example, your application file contains records and groups. The records
contain fields and the groups contain records and/or sub-groups. This means
that you must create records and groups before you create the subordinate
fields.

The EDI file must contain fields for al information that you expect to
receive from your partner (if the map isinbound) or send to your partner (if
the map is outbound).

The Sterling Gentran:Director Application Integration subsystem generates
an EDI file, based on the standard (agency), version, transaction set, and
release (for the TRADACOMS standard only) you selected. The system
includes all the groups, segments, composites, and elements defined by the
standards agency for the document version you selected. If you are creating
an import or export map, you typically customize the system-generated EDI
file by modifying the map component properties, and using specialized
Sterling Gentran:Director functions to manipulate the EDI file structure.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 7
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Map Components
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If you want to use a specialized version of an EDI standard that is not
available in the Sterling Gentran:Director standards database, it may be
appropriate for you to define the EDI file yourself.

The specific EDI map components that you use depend on the type of map
you are creating. Thisincludes the standard, version, and transaction set
(document) selected, and the groups, segments, composites, and elements
your company reguires. We recommend that you determine which map
components you will use before generating or defining an EDI file.

The map components that Sterling Gentran: Director uses to define the EDI
fileformat are:

A group isalooping structure that contains related segments and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is alowed to repeat is
exhausted. Groups are defined by the EDI standards. A group that is
subordinate to another group is a sub-group (this correspondsto a nested
looping structure —aloop within aloop). The EDI fileisagroup and is
visually represented the same way as other groups and sub-groupsin the
Application Integration subsystem: (T

A segment contains a group of related elements or composite data
elements that combine to communicate useful data. Segments are
defined by the EDI standards. A segment occurs once or repeats
multiple times. A segment is visually represented in the Application
Integration subsystems as:

A composite is a data el ement that contains two or more component
data elements or sub-elements. Composites are defined by the EDI
standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards). A composite isvisually represented in the Application
Integration subsystems as. -&

An element is the smallest piece of information defined by the EDI
standards. An individual element has different meanings depending on
the context. Elements are typically not considered useful until combined
into segments. An element is the EDI map component that is mapped
(linked) to a corresponding application field to move data to and from
the EDI file. An element is visually represented in the Application
Integration subsystem asthe following:

After an element has a mapping operation performed against it, ared
checkmark is displayed over the element icon.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial
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Please see the IBM® Serling Gentran: Director® Release 5.5 Application
Integration User Guide for more information on customizing map
component properties and on using specialized Sterling Gentran:Director
functions to manipulate the EDI file structure.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 9
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Introducing the Application Integration Subsystem
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Navigation

May 2011

The Sterling Gentran:Director Application Integration subsystem enables
you to translate your application filesto EDI standard formats for documents
you send to your partners (outbound mapping), and to translate EDI standard
formatsto your application format for documents that you receive from your
partners (inbound mapping).

You can access the Sterling Gentran:Director Application Integration
Window in one of four different ways:

»  Click the menu option from the Main Menu Bar.

e Click the appropriate button on the Main Toolbar.

»  Click the appropriate part of the map.

e Click amap component with the right mouse button to access a short-
cut menu, which contains all the functionsthat are currently available
for that map component. The content of the short-cut menus varies,
depending on the type and level of the selected map component.

When you start Serling Gentran:Director Application
Integration, the Main Menu Bar contains a subset of
menu items. A full set of menu itemsisdisplayed after
you create a new map or open (load) an existing map.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial
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The Sterling Gentran:Director - Application Integration Window appears as
follows:

Control Menu

Minimize/Maximize Buttons
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Main Toolbar ——

The Control Menu contains the following commands: Restore, Move,
Size, Minimize, Maximize, and Close.

The Title Bar contains the name of the application. You can use thisto

move the position of the EDI Director window on your desktop.

The Minimize button reduces the window to an icon.

The M aximize button enlarges the window to its maximum size.

The Main Menu Bar contains the following drop-down menus
(detailed descriptions of each of the commands on these menus are

May 2011
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found in the online Help). Unavailable items are dimmed.

Fils

Hew Chrl+M . T
Lopy trl+
%Ipen... Ctl+0 Paste Cilsiy w Statuz Bar
Lloze .
Save Chil+5 Create Sub k gctwa.te Expand Branch
= e » Deactivate Ezpand Al
Save Az belete Del |_k— Unexpand Branch
Compile [ Witk Show Active Only
Print... Ctrl+F B Equalize
_T!n TH Seszion Bules Generate TOF 4
Print Setup... Constarts Generate LIEF]
Pritit Ta File... Spntax Takens =
Eade Lists et Tirit
1 Pet_B50.map —
Detailz
Exit Eird..

L & Help Contents
Tile Index
Arange lcons Using Help
w 1 Pet_850.map About GEMTRAN: Server - Application Integration. ..

 TheMain Toolbar givesyou access to some of the most common
operations in the Application Integration subsystem. Unavailable items
are dimmed. The Main Toolbar is a dockable toolbar, so you can affix it
to any edge of the client window. The Main Toolbar isillustrated below:

New Cut Constants Split Unlink
‘ Sa‘ve Pa|ste Code Lists ‘ Deactivate
NEEEBEEEEEEEEEE R E
|
Op‘en CoLy Syntax Acti\late GenLrate
. . Tokens . TDF
Compile Session Promote Link
Rules
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Customizing Global Display Options

The Sterling Gentran: Director Application I ntegration subsystem allows you
to customize the display of mapsin several different ways. The global
display optionsthat are established apply to all maps. This section explains
how to perform the following:

» Customizing global display options

» Displaying links (global option)

You can set or change global map display options at any time.

Customizing
Global Display Complete the following steps to customize global (for all maps) display

Options options:

1. Select Preferences... from the Options menu to display the Preferences
dialogue (the Treetab is displayed by default). The Preferences dialogue
isaproperty sheet that enables you to set global defaults for Sterling
Gentran:Director.

Preferences E

Tree |Links | Standard Formatsl PositionalDefauItsI Files | Eonfirmationsl

These settings customize the look of the file format tree.

Colavrs... |
v Show record descriptions Font... |

v Show figld descriptions

k. I Cancel Help

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 13
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2. Toturn on the default display of group, record (segment), and field
(element) descriptions, select the appropriate options.

You typically want all descriptions displayed for reference. But
depending on the size of your monitor, it may be easier to see the entire
map if the descriptions are not displayed.

You may want to experiment with shrinking the size of
thefont for the map (see Customizing Global Fontsin
the IBM® Sterling Gentran:Director® Release 5.5
Application Integration User Guide) beforeyou turn off

the display of descriptions.

3. Click OKto save changes and exit the Preferences dialog.

Customizing

Global Display Mapping Links are the visual linesthat connect a field/element on the Input
of Links side of the map to afield/element on the Output side of the map.

Complete the following steps to customize the global display of mapping
links:

1. Select Preferences... from the Options menu to display the Preferences
diaog.

2. Click theLinkstab to display the linking options. The Links tab enables
you to set the default display of mapping links.

Preferences

Tree  Links |Standard Formatsl PositionalDefauItsI Files I Eonfilmationsl

Theze settings control how links are shown bebween the input and output file formats.

& Shaw no links
" Show links to or from the curently selected element.

= Shaw links ta or fram all visible elements

14 May 2011 IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Getting Started Customizing Global Display Options

The optionsin the Links section of the Preferences dialog enable you to
select:

* Show nolinks
Do not visually display mapping links.

»  Show linksto or from the currently selected element
Display only the mapping links for the currently selected field (this
option enables you to concentrate on the selected field and removes
the confusion of viewing many links at once).

e Show linksto or from all visible elements
Display all the mapping links.

The option you select is the default for all maps.
3. Click OKto save changes and exit the Preferences dialog.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 15
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Building a Map with Application Integration
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This section defines how to proceed with building a map using the Sterling
Gentran:Director Application Integration subsystem.

1

Preparation and Analysis

Obtain alayout of your application file and determine how it
corresponds with the EDI standard you will be using. Determine how
you will move data to or from each application field.

Set Global Defaults (first time only)

Thefirst time you use the Sterling Gentran:Director Application
Integration subsystem, you should establish the default date format that
the system will use. Please see the IBM® Serling Gentran: Director®
Release 5.5 User Guide for more information on setting the global date
defaullt.

Create, Save, and Name a New Map
Please see Creating the Export Map on page 30 for more information on
creating, saving, and naming a map.

Activatethe Appropriate EDI Groups, Segments, and Elements
Please see Activating EDI Map Components on page 37 for more
information on activation.

Define your Application File Format
Please see Defining Your Application File Format on page 42 for more
information on defining your application file format.

Map the Appropriate Data for Each Application Field
Please see Mapping Your Data on page 64 for more information on
mapping your data.

Compilethe Translation Object

Please see Compiling the Map on page 95 for more information on
compiling the trandation object and translation object naming
conventions.

Print the Mapping Report
Validate and review the map, and make modifications as needed. Please
see Printing the Report on page 97 for more information on printing the

mapping report.
Register the Translation Object with Sterling Gentran:Director

Please see the IBM® Serling Gentran: Director® Release 5.5 User
Guide for more information on registering translation objects.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial
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10.

11

Createthe Appropriate Trading Relationship

Establish the appropriate trading relationship in Sterling
Gentran:Director for your trading partners. Please see the IBM®
Serling Gentran: Director® Release 5.5 User Guide for more
information on creating trading relationships. The trading relationship
that you will usein thistutorial (PETZONES) is provided in the
TUTORIAL folder. You need to import the partner profile
(PETZONE3.PAR) into Sterling Gentran:Director before you begin this
tutorial. Please see the IBM® Serling Gentran: Director® Release 5.5
User Guide for more information on importing trading rel ationships.

Test the Translation Object

Obtain test data from your partner(s) and process the data. Verify
acknowledgement processing (if applicable). Verify communications
with your network.

For these tutorials, we have provided test datafor the transl ation objects
you create. The following table describes how to locate that test data:

Translation Object Test Data
Type Name
Inbound (export) PETTSTTLINT
Outbound PET_TINV.TXT

(system import and import)

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 17
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IBM® Sterling Customer Center provides awealth of online resources that
are available around the clock to enrich your business experience with
IBM® Sterling Gentran®. By using Sterling Customer Center, you gain
access to many salf-support tools, including a Knowledge-Base,
Documentation, Education, and Case Management. Access Sterling
Customer Center at http://customer.sterlingcommerce.com.

Once logged in, select Support Center from the top navigation menu, and
then locate Sterling Gentran product-specific support information from the
left navigation menu.

Additionally, our Customer Support Reference Guide outlines our support
hours, contact information, and key information that will enhance your
support experience with us. For detailed information about Customer
Support, please refer to the Customer Support Reference Guide accessible
from the login page. (http://customer.sterlingcommerce.com)

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial
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Inbound Purchase Order (ORDERS)

Thistutorial exercise defines the step-by-step tasks that are necessary for
you to create a map that will be used to trandate TRADACOMS purchase
orders (ORDERYS) that you receive from your trading partner.

This chapter explains all the tasks and processes associated with creating a
map for an inbound purchase order, including the following:

e Mapping analysis

»  Creating the new map

e Activating EDI map components

*  Verifying EDI Delimiters

»  Defining your application file format

*  Mapping your data

e Finalising the map

online Help for that function. The online Help system
containsfield definitions and other detailed
information.

Q Press F1 from any area of the system to access the

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 19
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Mapping
Analysis
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Thistutorial exercise is meant to be completed in its entirety. We
recommend that you complete each task sequentially, without referring to
the completed map that is provided with the installation program (although
you may want to verify your completed map with the model).

The purpose of completing each task in thistutorial in sequential order as if
it were your own scenario, is to teach you not only how to perform the
individual mapping tasks, but also to teach you alogical approach and
methods that should be used when you create your own map.

In thistutorial exercise, your company is MWT Manufacturing Co., which
manufactures awide variety of suppliesfor pet stores. Your company sells
pet supplies directly to large pet supply retail chains. You need to create a
map that will enable your company to translate the purchase orders that you
receive from one of your trading partners, Pet Zone (alarge pet supply
retailer). After the purchase orders are translated into your application file
format, they can be processed through your order processing system, and
your company can ship the goods to Pet Zone.

You have an existing application file layout from your order entry
department that defines the information your system needs to process the
order. And, from discussions with Pet Zone, you know the data content of
the orders that your partner will be sending you.

Thefirst step in creating a map is the analysis of the mapping requirements.
Thisisthe most important step in creating a successful map. If the analysis
you perform is complete, you will have al the information you need to
create the map in an efficient and logical manner. If you omit this critical
step and proceed directly to creating the map, it islikely that creating the
map will be amuch longer and arduoustask, and the map may beinvalid due
to oversights and omissions.

Regardless of whether you are trandlating data inbound or outbound,
mapping analysis involves the following steps:

1. Anaysing your application file format

2. Analysing your partner(s) EDI file format

3. Correlating your application and the EDI file formats
After you complete these steps, you can begin creating the map.
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Analysing Your Thefirst step of mapping analysisis analysing your application file format,
Application File becausethisis probably the component that is the most familiar to you. In
Format thistutorial, your application file format containsall theinformation that you
need to extract from the purchase order your partner sends you, so that your
system can process the purchase order correctly, and your company can fill
the order correctly.

You must define your application file format to the Application Integration
subsystem. If your company has an existing application file format, asin this
tutorial, you should obtain the record layout from the appropriate person. If
you did not have an existing application file format, you would need to
create one by determining which fields are necessary to process the data
correctly, and then grouping the fields logically under records.

The application file layout for thistutorial isasfollows:

Min Max
Length  Length

Field Name Description

Header Record (POHEADER) 1 per message
CUSTNUMHDR X Customer Number String 1 8
PODATEHDR X Purchase Order Date Dt/Tm 8 8
(DD/MMIYY)
PONUMHDR X Purchase Order Number String 1 22
POTYPCODE Purchase Order Type Code String 0 2
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD2 Ship To Address Line 2 String 0 35
SHIPTOCITY Ship To City String 0 35
SHIPTOSTATE Ship To State, Province, or String 0 35
Country
SHIPTOPOSTALCODE Ship To Postal Code String 0 9
CUSTNAME Customer Name String 0 35
CUSTADD1 Customer Address Line 1 String 0 35
CUSTADD2 Customer Address Line 2 String 0 35
CUSTCITY Customer City String 0 35
CUSTSTATE Customer State, Province, or String 0 35
Country
CUSTPOSTAL CODE Customer Postal Code String 0 9
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Field Name Description L;\:igth Lx]a;h

DELDATE X Delivery Date Dt/Tm 8 8
(DD/MM/YY)

NUMLINEITEMS X Number of Line Items Number (NO) |1 6

PO Detail Group (PODetailGroup) up to 200,000 per message
Detail Record (PODETAIL) 1 per message

CUSTNUMDET Customer Number String 1 8

PODATEDET Purchase Order Date Dt/Tm 8 8
(DDIMMIYY)

PONUMDET X Purchase Order Number String 1 22

CUSTPROCODE X Customer Product Code String 1 30

UPCCODE X UPC Code String 1 30

CONSUMER UNITS Consumer Units in Trading Unit Number (NO) |0 15

UOM Unit of Measure String 0 7

UNITPR Unit Price Number (R2) |0 14

QTYORD X Quantity Ordered Number (NO) |1 9

Description Record (PODESC) up to 5 per message

CUSTNUMDESC X Customer Number String 1 8

PODATEDESC X Purchase Order Date Dt/Tm 8 8
(DD/IMM/YY)

PONUMDESC X Purchase Order Number String 1 22

DESC Description String 0 81

Summary Record (POSUMMARY) 1 per message

CUSTNUMSUM Customer Number String 1

PODATESUM Purchase Order Date Dt/Tm 8 8
(DD/MM/YY)

PONUMSUM X Purchase Order Number String 1 22

NUMLINEITEMSUM X Number of Line Items Number (NO) |1 6

22 May 2011

The above table contains the minimum information necessary to define your
application file format to the Application Integration subsystem (name,
mandatory status, description, data type, and field length). Each record
contains a group of logically-related application fields. These fields will
contain the information from the EDI file that your system needs to process
the purchase order. The group contains logically-related application records.
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Analysing the EDI
File

Each record contains a key (consisting of three fields) that ensures that the
same identifying information islocated at the beginning of each record. Your
application contains arecord key so that each record can be identified
individually. The record key for this purchase order consists of your
partner’s customer number, the purchase order date, and the purchase order
number. The records and the group are defined as follows:

» The POHEADER (header) record contains the purchase order type
code, shipping and customer information, delivery date information,
and the number of lineitemsin the purchase order. This header recordis
mandatory and occurs once for each purchase order trand ated.

e The PODetailGroup (detail information) contains all the line item
information for the order, including the item, unit of measure, price,
quantity ordered, and the description information. Each PODetail Group
can occur up to 200,000 times per order trandated. This equals a
maximum order of 200,000 items. The information within the
PODetail Group is further segregated by record.

» The PODETAIL (detail) record contains line item code number,
consumer unitsin trading unit, unit of measure, price, and quantity
ordered. The PODETAIL record occurs once per PODetail Group.

»  The PODESC (description) record contains descriptive information
about the line item ordered. The PODESC record can occur up to five
times per PODetail Group, so multiple descriptive terms can be used for
each item. For example, if thelineitemisa“dog collar,” the description
fields may be “red,” “large,” and “leather.”

The POSUMMARY (summary) record contains the total number of line
itemsin the purchase order. The POSUMMARY record occurs once for
each purchase order trand ated.

Now that you have thoroughly analysed your application file format, the
next step isto determine the requirements of the purchase order that you will
receive from your partner(s).

To analyse the EDI file, you must first determine what your trading
partner(s) will be sending you. You and your partner(s) need to agree on
which standard, version, and message you will use. In thistutorial, we are
using the TRADACOMS standard, version ANAOOL, message ORDERS
(purchase order message), release 9. It isimportant to know the information
that your partner(s) will send you within the purchase order, and what data
will be contained in each element used.

It isvery helpful to review the EDI standard(s) that you will use before
analysing the EDI file. Obtain an EDI standard manual for each standard and
version that you will use. Standard manuals are available from EDI standard
agencies.
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The TRADACOMS standard uses a header with each interchange
(ORDHDR for the ORDERS message). The header message contains
information that pertains to each message in the interchange. Sterling
Gentran:Director copies the header segments to the beginning of each
document, to ensure that all the relevant information is contained in the
document. Therefore, you will need to load the header message (ORDHDR)
into the ORDERS EDI file, so that al the segments and elements are
available for use.

After discussing with your partner(s) what they will send, determining which
segments and elements your company requires, and reviewing the EDI
standard, you can list the map components that you will heed to make
available for use (activate). When Sterling Gentran:Director generates the
EDI side(s) of the map, the system includes all the groups, segments,
composites, and elements that are defined by the standard agency for the
version of the message you selected. The system activates all the groups,
segments, composites, and elements that are defined as “mandatory” (must
be present) by the standard. The system does not enable you to deactivate the
mandatory groups, segments, composites, and elements.

When tranglating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elementsthat are not defined as mandatory by the standard, but that you have
determined that you need to use in mapping.

For this tutorial, the map components that are required but not currently
active are the following (the composite column is informational only, so you
will know where to locate the appropriate element):

Group Segment Comp. Element
ORDHDR SDT SIDN SIDO
(already active) (already active)

CDT CIDN CIDO
(already active)
CNAM
CADD CADO
CAD1
CAD2
CAD3
CAD4

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Inbound Purchase Order (ORDERS) Getting Started

Group Segment Comp. Element
CLO CLOC CLOO
(already active)
CNAM
CADD CADO
CAD1
CAD2
CAD3
CAD4
ORD ORNO ORNO
(already active) (already active) ORN2
CDO07
DIN LDAT
OLD OLD:2 SPRO SPR1
(already active)
CPRO CPR1
UNOR UNOO
CD04
OQTY OQTO0
OUCT ouco
TDES TDEO
TDE1

When you activate a conditional group or segment, the
mandatory subordinate segmentsand elementsare
automatically activated.

The majority of the elementsyou activate will be mapped to your application
file. However, there are three elements (SDT SIDN SIDO, CDT CIDN CIDO,
and OLD:2 SPRO SPR1) that you activate because your partner will send
you datafor them in order to be compliant with the TRADACOMS standard.
You do not need thisinformation in your application file; therefore, you will
not map these three elements to your application file.

Also, we recommend that you set up a Document Name for each map to
make the identification of a message created by this map easier in Sterling
Gentran:Director. The Document Name allows you to differentiate between
messages in the document browsers in Sterling Gentran:Director.

To set up a Document Name, you must select an element or field in the map
that contains data that will distinguish the messages translated by this map.
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Reconciling Your
Application File
and the EDI File

Then, the Name field of the document browsers that contain this message
will contain the data from the selected element or field. You can choose any
element or field as the Document Name, but we strongly recommend that
you select an element or field that occurs only once in the message and has a
data type of “String”. For a purchase order, the document name istypically
the Customer’s Order Number.

After you complete the analysis of the EDI file and your application, the
final step in mapping analysisis correlating the two components.

To reconcile your application file format with the EDI file, for each
application field you must determine where the information with which you
need to populate the field islocated in the EDI file, and how you can map
that information to the application. To map information to afield, you can
use linking, standard rules, extended rules, or a combination of the three.

Linking (simple mapping) enables you to map afield or element from the
input side of the map to afield or element on the output side of the map. The
link between two map components (hereafter referred to asfields) isvisually
represented with aline connecting the two fields.

Standard rules give you access to functions that are necessary for mapping
operations that are more complex than simplelinking, but lessinvolved than
extended rules.

Extended rules enable you to use a Sterling Gentran: Director proprietary
programming language to perform virtually any mapping operation you
require.

We recommend that you determine which mapping operations will be
required on afield-by-field basis for your application file.

The following mapping operations (by application field) will be required for
this tutorial:

Field Name Description Ol\p/)lzfeﬁiig?\s
Header Record (POHEADER) 1 per message
CUSTNUMHDR Customer Number Extract Application ID from Partner
record
PODATEHDR Purchase Order Date Link to ORD ORNO ORN2
PONUMHDR Purchase Order Number Link to ORD ORNO ORNO
POTYPCODE Purchase Order Type Code Link to ORD CDO07
SHIPTONAME Ship To Name Link to CLO CNAM
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Field Name

Description

Mapping
Operations

SHIPTOADD1 Ship To Address Line 1 Link to CLO CADD CADO
SHIPTOADD2 Ship To Address Line 2 Link to CLO CADD CAD1
SHIPTOCITY Ship To City Link to CLO CADD CAD2

SHIPTOSTATE

Ship To State, Province, or
Country

Link to CLO CADD CAD3

SHIPTOPOSTALCODE

Ship To Postal Code

Link to CLO CADD CAD4

CUSTNAME Customer Name Link to CDT CNAM
CUSTADD1 Customer Address Line 1 Link to CDT CADD CADO
CUSTADD2 Customer Address Line 2 Link to CDT CADD CAD1
CUSTCITY Customer City Link to CDT CADD CAD2
CUSTSTATE Customer State, Province, or Link to CDT CADD CAD3
Country

CUSTPOSTALCODE Customer Postal Code Link to CDT CADD CAD4
DELDATE Delivery Date Link to DIN LDAT

NUMLINEITEMS

Number of Line Items

Link to OTR LORD

PO Detail Group (PODetailGroup) up to 200,000 per message

Detail Record (PODETAIL) 1 per message

CUSTNUMDET Customer Number Extract Application ID from Partner
record

PODATEDET Purchase Order Date Link to ORD ORNO ORNZ2 using
extended rule

PONUMDET Purchase Order Number Link to ORD ORNO ORNO using
extended rule

CUSTPROCODE Customer Product Code Link to OLD:2 CPRO CPR1

UPCCODE UPC Code Extract Partner xref by partner item from

subtable “PRODCODE”

CONSUMERUNITS

Consumer Units in Trading Unit

Link to OLD:2 UNOR UNOO

UoM

Unit of Measure

Link to OLD:2 UNOR CDO04

UNITPR

Unit Price

Link to OLD:2 OUCT OUCO
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Mapping
Operations

Field Name Description

QTYORD Quantity Ordered Link to OLD:2 OQTY OQTO

Description Record (PODESC) up to 5 per message

CUSTNUMDESC Customer Number Extract Application ID from Partner
record
PODATEDESC Purchase Order Date Link to ORD ORNO ORNZ2 using

extended rule

PONUMDESC Purchase Order Number Link to ORD ORNO ORNO using
extended rule

DESC Description Link to OLD:2 TDES TDEO and OLD:2
TDES TDEL1 after concatenating them
with an extended rule

Summary Record (POSUMMARY) 1 per message

CUSTNUMSUM Customer Number Extract Application ID from Partner
record

PODATESUM Purchase Order Date Link to ORD ORNO ORN2

PONUMSUM Purchase Order Number Link to ORD ORNO ORNO

NUMLINEITEMSUM Number of Line ltems Link to OTR LORD

You must also determine whether or not you will need to use code tablesto
convert datafor the map. If you need to use tables, you must decide whether
to create a code table in Sterling Gentran:Director that can only be used with
this map, or add the table to either the partner relationship or the internal
system partner in Partner Editor. In thistutorial, you need to map
information from a cross-reference table to trandate your partner’s code for
apurchased item and your code for the sameitem. A cross-referencetableis
used when you and your partner each reference an item by a different name
(or number). Please see the IBM® Serling Gentran: Director® Release 5.5
User Guide for more information on cross-reference tables.

You do not need to createthis cross-referencetable—it
isincluded with the PETZONES3 partner
(PETZONE3.PAR) that isprovided with the tutorial
data when you install Sterling Gentran:Director.
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My Value Partner Value Description Reference Data
12345678901234 555666411 Large Dog Collar Red
23456789012345 555666817 Spring Breeze Cat Litter 5 Kg Bag
34567890123456 555666908 Small Beef Basted Rawhide Bones Bag of 12
45678901234567 555666321 X-Large Food Bowl Black
56789012345678 555666287 FatKat Kitty Bed Blue with White Trim
67890123456789 555666413 Catnip Mouse Toy

After you finish correlating your application file format and EDI file on
paper, you can begin creating the map.
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Thefirst task in creating a new map is to define the format that will be used
for the input and output sides of the map. In this example, you are creating
an export map so Sterling Gentran:Director can translate a purchase order
that your partner sends you to your application file. Therefore, the input side
of the map needsto reflect the TRADACOM S ORDERS purchase order that
you will receive. Instead of defining the ORDERS message to the system
yourself, you want the Application Integration subsystem to use the
standards database on your system to build the purchase order according to
the standard. The output side of the map needs to reflect your application
file, which you will define to the Application Integration subsystem.

Complete the following steps to create the export map for the Inbound
Purchase Order:

1. Select New from the File menu to display the Create New Translation
Object dialogue.

Function |Impc-rt
[ata Sace I j Cancel |
r Input Format

Type Iﬁ ™| e Standards

Sgency I j

Y ErSr I j

Irarsachion I j

Feleaze I 'l
r— Dutput Forrnat

Type Iﬂ I= | Wse Standards

SOency I j

s I j

Tratsacticn I j

BElease Iﬂ

2. Fromthe Tranglation Object Function drop-down list box, select

“Export”.

Complete the Input Format section of the dialogue. This section
contains the format of the data that will be translated by the Sterling
Gentran:Director system.
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10.

From the (Input Format) Type drop-down list box, select “EDI” asthe
type of format for the input data.

Click the Use Standards check box, because you selected “EDI” in the
Type field and because you want the system to use the standards
database on your system to build the purchase order according to the
standard.

To select a data source name from which Application Integration will
access EDI standards, select one from the Data Source drop-down list
box. This DSN will be prompted the next time you create a map.

From the Agency drop-down list box, select “[A] Tradacoms’ asthe
EDI standard you will be using for the input side of the map.

From the Version drop-down list box, select “[ANAQO1]
TRADACOMS UNITED KINGDOM?" as the version of the standard
you will use. The versions that are available depend on which standard
you selected.

From the Transaction drop-down list box, select “ [ ORDERS] ORDER
DETAILS’ asthetransaction set (message) you will use. The
transactions that are available depend on which standard and version
you selected.

From the Release drop-down list box, select “9” as the message version
you will use. The message versions that are available depend on which
message (transaction) you selected.

Now you need to complete the Output Format section of the dialogue.

From the Type drop-down list box, select “Positional” as the type of

format for the output data. Sterling Gentran:Director uses the term
“positiona” to describe any flat file that you create.
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The Create New Trandlation Object dialogue should now look like this:

Create Hew Translation Object

Function I Export
Data Source GEMTR&MN Standards <
~ Input Format I J ﬂl
Tupe lﬂ ¥ Use Standard:
Agency I [&] Tradacamns j
‘Wersion I[ANAEIDH TRADACOMS UNITED KINEj
Tranzaction I[DHDEHS] ORDER DETAILS j

Release IEI "I

— Dutput Format

Tupe IPUsitionaI "I I | e Gtandarnd

AGEnc I j
TSI I j
Iratizactior I j

HElEaze I N I

11. Click OK to generate the new map (the generation may take afew
seconds). The new map is displayed in the Sterling Gentran:Director -
Application Integration Window.

#* GENTRAM:Director - Application Integration [GENTRAM1]

5 File Edit Functions “iew Option: ‘Window Help ;lilil
Dlc|d| | 2=l ==0LE sl o]o] ol =
gDHDEHS-M-DHDEH DETAILS - OUTPUT M- 1 =

CLO -+-1 CUSTOMER'S LOCATION
ORD -1 ORDER REFEREMCES

{7 OLD -k4- 935333
OTR -M-10ORDER TRAILER

. -
«| | » 1 | »

For Help, press F1 o
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12.

After you create a new map, it isimportant to define the details of the
map and save it. The Save function writes (saves) the map with current
focusto disk.

Q We recommend that you save your maps as often as

possible, to mitigate the possible loss of additions or
modificationsin the event of a hardware or system
error.

Select Save from the File menu to display the Translation Object Details
dialogue.

Aukhor Diesciiption Traredation Object Funcbon Bpetem
Ezport |
I I a |—I Cancel I
Mermon Conbrd

Major weigioh IEI Minar version IEI Compiled on

Agency

Yerean

Aelesrs

F Group

EDI Associaliors:

Tramsacion  |OFDERS | [OADER DETAILS

Irput Output

F ITra:Iau:u'n:t I_ I I

[AHADT | [ TRADACOMS UINIT
I

|
I
—

IEIHDEFIE |

13.

14.

15.

In the Author field, type your name. Thisfield typically contains the
name of the person who created the map.

In the Description field, type “PET T ANAOO1 9 ORDERS Export”.
Thisfield must be unique because it isused by the system to identify the
map. We recommend that you use the following identifying
characteristics: the partner that this map is used for, the standard, the
version, the release, the type of transaction this map uses, and the
direction of the map (e.g., Import, Export, etc.). For example, “PET T
ANAO0O01 9 ORDERS Export” isthe description of a map used with
partner Pet Zone, for a TRADACOMS version ANAQOL release 9
Purchase Order (ORDERS), that is received Inbound (Export).

Verify that the type of map shown in the Trangation Object Function
drop-down list box is“Export”.
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16. Complete the Major and Minor fields to designate a version number for
thistranslation object. Type“1” asthe version number inthe Mgjor field

17. Thelnput and Output fields (Agency, Version, Transaction, Release, and
F Group) contain information only if the Input and/or Output sides of

and accept “0” asthe release number in the Minor field.

Whenever any major changes are madeto your map,
increase the version to the next real number (e.g., 2.0,
3.0). If you make a minor change to the map, increase
the version by a percentage point (e.g., 2.1, 2.2).

the map are of EDI format. For the tutorial, DO NOT change the
information in these fields.

Q The system allows you to change theinformation in the

Input and Output fields, but modifying this
information will not alter the content of the map. An
example of when you may wish to alter thesefieldsisif
you want the map to reflect a standard version that is
not loaded on your system. You can changethe version
on thisdialogue, and then physically alter the map to
be compliant with that version.

The Translation Object Details dialogue should now look like this:

Aukhor Dasciiption Tranedation Object Function Eptem
Stari M&001 90ADERS Exporl | |[Export |
™ I P I P u | Cancal I
Margion Cion ol

Mapx veimon I'I_ Mmar rerzon IEI_ D:rn|:|'||=:|l:n|

Agency

WErERIN

Ralesa

F Group

EDl Axronialiors:

Transschon IUHDEHE IEIHDEH DETAILS | |

Ingut Dutput

F ITra:Iacu'ns r I

I.d\.H-'-".UTI ITH.-!-.DADIIMELINIT | |

]
OADERS | |
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18. Click OK to save the translation object details and access the Save As
dialogue.

Save As HE
Save in: IEMGDS j gl I: =

Pet_ginv.map
Pet_eord.map

File name:  [SENTRAN1.map

Save az lype: IMaps [*.map) j Cancel |

19. The“Savein” drop-down list box should reflect the drive\folder where

Sterling Gentran:Director isinstalled. The default is GENTRAN
Director\Maps. If the current subfolder is not the correct one, select the
appropriate subfolder.

20. Type“PET_TORD.MAP’ asthe name of the map in the “File name”
field. You allocate a filename to a map when you save the map for the
first time or use the Save Asfunction to save a copy of the map under a
different name. The name of the map must be one to eight unique
characters that define the map in a meaningful way. For example,
“PET_TORD.MAP” isthe name of amap for aTRADACOMS
Purchase Order (ORDERS) for partner Pet Zone.

The default file extension for mapsis.MAP. Using this extension
distinguishes map files from other types of files, such astransation
objects. The naming conventions in Sterling Gentran:Director are as
follows:

*  The source map (map created in Sterling Gentran:Director) should
be named using the file extension .M AP (e.g., PET_TORD.MAP).

»  The compiled translation object (trandlation object that is the result
of compiling the source map) should be hamed using the same
filename that was allocated to the source map, with the file
extension .TPL (e.g., PET_TORD.TPL).

We recommend that you use these naming conventions to distinguish
source maps and compiled translation objects from other types of files.
We also recommend that you use the same filename (different file
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extension) for a source map and the transl ation object that was compiled
from it.

Be very careful not to overlay the source map with the
compiled translation object. Usethe.TPL fileextension
to distinguish the translation object.
The Save As dialogue should now look like this:

Save As EHE
Sawve jn: |@ Maps j gl E

Pat_einvy.map
Pet_sord map

File name:  [GENTRANT map

Save az type: IMapS [* map] j Cancel |

21. Click SAVE to save the map.

After you complete each section of thistutorial or when
any changes are applied to the map, you should save
the map by selecting Save from the File menu.

Now that you have finished creating and saving the new Export map, you
need to define the Input and Output sides of the map.

Loading the

ORDHDR The TRADACOMS standard uses a header with each interchange

Message (ORDHDR for the ORDERS message). The header message contains
information that pertains to each message in the interchange. Sterling
Gentran:Director copies the header segments to the beginning of each
document, to ensure that all the relevant information is contained in the
document. Therefore, you will need to load the header message (ORDHDR)
into the ORDERS EDI file, so that all the segments and elements are
available for use.

36 May 2011 IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Inbound Purchase Order (ORDERS) Creating the Export Map

Complete the following steps to load the ORDHDR message into the
ORDERSEDI file:

1. Highlight the ORDERS ORDER DETAILSEDI fileicon. Select Create
Sub from the Edit menu.

2. Select Transaction Set... from the Create Sub cascading menu to display
the Insert Transaction Set From Standards dialogue. You will be
prompted to select a data source. Do so and then click OK.

Insert Transaction Set From Standards
Agency | j )% |
‘Wersion I j : :
Trahzaction | j
Release Iﬁ

3. From the Agency drop-down list box, select “[A] Tradacoms’ asthe
EDI standard you will use for the inserted message.

4. From the Version drop-down list box, select “[ANAQO1]
TRADACOMS UNITED KINGDOM" as the version of the standard
you will use. The versions that are available depend on which standard
you selected.

5. From the Transaction drop-down list box, select “|ORDHDR] ORDER
FILE HEADER” as the transaction set (message) you will use. The
transactions that are available depend on which standard and version
you selected.

6. From the Release drop-down list box, select “9” asthe message version
you will use. The message versions that are available depend on which
message (transaction) you selected.

7. Click OK to load the ORDHDR message into the ORDERS EDI file as
a subordinate group.

Activating EDI
Map The map components for an EDI File are the following:
Components @  EpiFile

Segment
Loop (Group)

Composite Element
Element

..l-'lg]’
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The map components for a Positional File are the following:
g Positional File

O Record
] Loop (Group)
’ Field

The specific EDI map components that you will use depends on the type of
map you create, the standard, version, and transaction set (message)
selected, and which segments and el ements your company requires. We
recommend that you determine which segments and elements you will use
before starting this step.

When Sterling Gentran:Director generates the EDI side(s) of the map, the
system includes al the groups, segments, composites, and elements that are
defined by the standard agency for the version of the message you selected.
The system activates all the groups, segments, composites, and elementsthat
are defined as “mandatory” (must be present) by the standard. The system
does not enable you to deactivate the mandatory groups, segments,
composites, and elements. By default, Sterling Gentran:Director displays
active map components with a black fount, and inactive map components
with agrey fount (dimmed). In the example below, the ORDHDR group,
TYP segment, SDT segment, and the SIDN composite are mandatory, so
they are already activated by the system. You also need to usethe SDT SIDN
SIDO element (a conditional element), so you need to activate it.

SFORCHDA M- 1 OROEA FILE HEADER

T¥P -M-1 THAMSACTION TYPE DETAILS
50T -1 SUFPLIER DETAILS

22 SIDN M-

fe

=
LY
&

When tranglating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elementsthat are not defined as mandatory by the standard, but that you have
determined that you need to use in mapping.

Complete the following steps to activate the required conditional segments
and elements:

1. Double-click the groups, segments, and compositesthat are listed in the
table below to open them. The table below contains the groups,
segments, and elements that you will need to activate. The composite
(Comp.) column is provided for your information, so you will know

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Inbound Purchase Order (ORDERS) Creating the Export Map

where to locate the appropriate element(s). Opening all the necessary
groups, segments, and composites before you start to activate allows
you to scroll down the map and activate the segments and elements

sequentially.

Group Segment Comp. Element
ORDHDR SDT SIDN SIDO
(already active) (already active)

CDT CIDN CIDO

(already active)

CNAM

CADD CADO

CAD1

CAD2

CAD3

CAD4

CLO CLOC CLOO

(already active)

CNAM

CADD CADO

CAD1

CAD2

CAD3

CAD4
ORD ORNO ORNO
(already active) (already active) ORN2

CDO07

DIN LDAT

OLD OLD:2 SPRO SPR1

(already active)

CPRO CPR1
UNOR UNOO

CD04
OQTY OQTO0
OUCT ouco

TDES TDEO

TDE1
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When you activate a conditional group or segment, the
mandatory subordinate segments, composites, and
elements are automatically activated.

2. Click the Activate button on the Main Toolbar.

Click each inactive segment that you need to use. Thiswill activate the
segments.

If you accidentally click a segment that you did not
mean to activate, click the segment with the right
mouse button to access the shortcut menu. Select
Deactivate from the shortcut menu.

4. Click each inactive element that you need to use. Thiswill activate the
elements.

If you accidentally click an element that you did not
mean to activate, click the element with theright
mouse button to access the shortcut menu. Select
Deactivate from the shortcut menu.

5. Once you have activated all the necessary groups, segments, and
elements, click the Activate button on the Main Toolbar to turn
activation mode off.

Verifying EDI

Delimiters If you are using an EDI standard that contains composite elements or sub-
elements, you must verify that Sterling Gentran:Director is specifying the
correct delimiters. Delimiters are flags that you define to the system as
separating specific EDI components. Delimiters are necessary for all
variable field-length standards, because the datais compressed (and the
leading zeroes and trailing blanks are removed). Since thefieldsvary in
length, the system needs a flag to determine where one element ends and
another begins. For example, an element delimiter marks the beginning of a
new element.

Although verifying EDI delimitersin Sterling
Gentran:Director ismandatory only if you areusing a
standard with composite elementsor sub-elements, we

recommend that perform thistask regardless of which
standard you use.
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Complete the following steps to verify EDI delimiters:

1. Click the ORDERS ORDER DETAILS EDI fileicon with the right
mouse button to access the shortcut menu. Select Properties... from the
shortcut menu to display the EDI File Format Properties dialogue.

LUl Hile | ormat |'roportics

Neme |DRDERS Dieec |ORDER DETAILS il

[ Stizam z=gmente
Canc=l
oo

M Specify defaulla [T Daegntzsecod [

Tag DO ehraber -
Elerment Defmiter +

Seament Dalmiter Ii
Sub Elernert Delmker |
Raleaza Chalactal 3

Decmal Sepaialor .

1RRRnN

2. Inthe EDI Syntax section, verify that the Specify defaults check box is
selected.

3. Verify therequired delimiters for the TRADACOMS standard. If the
delimiters differ from the defaultsin the table below, type either the
character or the hexadecimal value in the correct field. The default
delimiters for TRADACOMS are the following:

TRADACOMS TRADACOMS
Default Hex
Default Character
Value
Tag Delimiter = (equal sign) 0x3D
Element Delimiter + (plus sign) 0x2B
Segment Delimiter ' (single quote) 0x27
Sub Element Delimiter : (colon) 0x3A
Release Character ? (question mark) Ox3F
Decimal Separator . (full stop) 0x2E

4. Click OKto exit the EDI File Format Properties dialogue.
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If either side of your map is positional (fixed-format), you must define your
application file format to Sterling Gentran:Director. In this tutorial, the
output side of the map is positional. Your application file must contain al the
information that you need to extract from your partner’s message, so that
your system can process the data accurately.

Before you define your application file format, you should obtain alayout of
the necessary groups, records, and fields. The groups will contain related
records and the records will contain related fields. Each map component will
be arranged sequentially in the order that it is most logical for the system to
process. Therefore, each level of your application file format must be created
sequentially.

For example, your application file format contains records and groups. The
records contain fields and the group contains records. You must create
records and groups before you create the subordinate fields and records.

Thefirst record in your application fileis usually the header record. Thefirst
record will be subordinate to the icon in the application side (output) of the
map.

The POHEADER (header) record contains the purchase order type code,
shipping and customer information, delivery date information, and the
number of line items in the purchase order. This header record is mandatory
and occurs once for each purchase order translated.

We recommend that you include a header record in
each application file. The header record typically is
mandatory and repeats only once (not a looping
structure).

Complete the following steps to create the first application record
(POHEADER):

1. Click the Positional Fileicon to highlight it (Output for an inbound
map).

2. Select Create Sub from the Edit menu. Select Record from the
cascading menu.
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The Positional Record Properties dialogue is displayed.

I'ozilianal lecoid 'roperbics
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3. IntheNamefield, type“POHEADER” asthe record identification code.
Do not use spaces or hyphens(-) in the Namefield. You
can usethe underscore () to separate words.

4. IntheDescfield, type“Header Record” asthe description of the record.
Thisfield isused to provide a brief explanation of the record, which will
allow you to differentiate it from similar records.

5. IntheTag field, type “HDR” asthe record identification code <TAG>.
For example, arecord is recognised by the system as the following:

<TAG>[Field_1][Field_2]
The record TAG for each record enables the system to recognise that
record and then determine the mapping requirements.

We recommend that you definetherecord tag on the
Positional Record Properties dialogue, instead of
defining fieldswith the purpose of explicitly containing
therecord tag.
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6. Inthe Position field, accept the default of “1” as the starting column

position of the tag in the data record.

7. IntheMin Usagefield, type“1” to make the header record mandatory.

Thisis the minimum number of times the record must repeat.

If theMin Usagefield contains“ 0" (zero), therecord is
conditional. If the Min Usage field containsa“1” or
greater, therecord ismandatory.

If you want the record to repeat (loop), type the maximum number of
timesit can repeat in the Max Usage field. However, for the header
record, we recommend that you always accept the default of “1” so it
remains arecord that only occurs once (not alooping structure).

The Positional Record Properties dialogue should now look like this:

I'ositional [lecord | "raparhics

B |
detfcation
H.,m]PI:IHEADEH
Dese |PO Header Fecard _
_F‘lu:-rn:lh:
Tag [HOR  Postion [1 | [0 UseKey Fidd
~Looping
i L) |1— ® Mamial
in Llzage
C vy
MaxUzage |1 {7 Loog End

~Specal Propeslies
& Normal
! Flosting

O wlikcand Abernoke Teg I Pastion |1

8. Click CK to create the POHEADER record.

The PODetailGroup (detail information) contains al the line item
information for the order, including the item, unit of measure, price, quantity
ordered, description, and the allowance and charge information. Each
PODetail Group can occur up to 200,000 times per order trandlated. This

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Inbound Purchase Order (ORDERS) Defining Your Application File Format

equals a maximum order of 200,000 items. The information within the
PODetail Group is further segregated by related records that repeat in
seguence until either the data ends or the maximum number of times that the
loop is allowed to repeat is exhausted.

Complete the following steps to create the PODetail Group at the same level
as the POHEADER record:

1. Click the POHEADER record to highlight it and select Insert from the
Edit menu. Select Group from the cascading menu.

The Group Properties dialogue is displayed.

Liroup | 'rapcrtics

| FaLE

Heme
Cenczl

[ eiiphion |
Mirimum Llaags |0 [T Promcte 1ecords bo patert
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FI==

7z |
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2. Inthe Namefield, type “PODetail Group” to indicate that this group
will contain all of the detail records. Thisis the segment loop
identification code.

Do not use spacesor hyphens(-) in the Namefield. You
can use the under score () to separate words.

3. IntheDescription field, type “ PO Detail Group” astheloop description.
Thisfield is used to provide a brief explanation of the loop.

Accept the default of “0” in the Minimum Usage field. Thisisthe
minimum number of times the loop must be repeated. For a conditional
loop, the minimum usage should always be“ 0" (zero). For amandatory
loop, the minimum usage should be “1” or greater.
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4. Inthe Maximum Usagefield, type “200000”. This indicates that this
group of records can repeat up to 200,000 times. The Group Properties
dia ogue should now look like this:

Guomp Froope ey

Meme | PO Dat=lG raup

[ e=rghion |F'|:I Cigtal Gioup

R
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5. Click CK to create the PODetail Group.

Creating the

PODETAIL and nthistutorial, the PODetail Group contains two subordinate records:
PODESC PODETAIL and PODESC. After you create the first subordinate record
Records (PODETAIL), you can define the subsequent record at the same level
(PODESC).

Complete the following steps to create the PODETAIL record:

1. Click the PODetailGroup to highlight it and select Create Sub from the
Edit menu. Select Record from the cascading menu.

The Positional Record Properties dialogue is displayed.
2. Inthe Namefield, type “PODETAIL” asthe record identification code.

Do not use spaces or hyphens(-) in the Namefield. You
can usethe underscore () to separate words.

3. IntheDescfield, type “Detail Record” as the description of the record.
Thisfield isused to provide a brief explanation of the record, which will
allow you to differentiate it from similar records.

4. IntheTagfield, type “DET” astherecord identification code <TAG>.
For example, arecord is recognised by the system as the following:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognise that
record and then determine the mapping requirements.
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Positional Record Properties dialogue, instead of
defining fieldswith the pur pose of explicitly containing
therecord tag.

Q We recommend that you definetherecord tag on the

5. Inthe Position field, accept the default of “1” as the starting column
position of the tag in the data record.

The Positional Record Properties dialogue should now look like this:

Fozitional Hecord Hraperticz

dertfication
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6. Click OKto create the PODETAIL record.
Complete the following steps to create the PODESC record:

1. Click the PODETAIL record to highlight it and select Insert from the
Edit menu. Select Record from the cascading menu to display the
Positional Record Properties dialogue.

2. Inthe Namefield, type “PODESC" the record identification code.
Do not use spaces or hyphens(-) in the Namefield. You
can usethe underscore () to separate words.

3. Inthe Descfield, type “Description Record” as a description of the
record. Thisfield is used to provide a brief explanation of the record,
which will allow you to differentiate it from similar records.
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In the Tag field, type “DES’ asthe record identification code <TAG>.
For example, arecord is recognised by the system as the following:

<TAG>[Field_1][Field 2]

The record TAG for each record enables the system to recognise that
record and then determine the mapping requirements.

We recommend that you definetherecord tag on the
Positional Record Properties dialogue, instead of
defining fieldswith the pur pose of explicitly containing
therecord tag.

In the Position field, accept the default of “1” as the starting column
position of the tag in the data record.

The Looping section of the Positional Record Properties dialogue
enables you to specify the minimum and maximum number of timesthis
record can repeat, and whether arecord is mandatory or conditional.
Alter this section only if the record is alooping structure. Otherwise,
accept the defaults.

Accept the default of “0” in the Min Usage field. Thisisthe minimum
number of times the record must repeat.

If theMin Usagefield contains“0” (zero), therecord is
conditional. If the Min Usage field contains“1” or

greater, therecord ismandatory.

In the Max Usage field, type “5” as the maximum number of times the
record can repeat.
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The Positional Record Properties dialogue should now ook like this:
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7. Click OK to create the PODESC record.

Creating the

POSUMMARY Thefinal record you need to create (POSUMMARY) is at the same level as
Record the POHEADER record and the PODetail Group.

The POSUMMARY (summary) record contains the total number of line
itemsin the purchase order. The POSUMMARY record occurs once for each
purchase order trandlated.

Complete the following steps to create the POSUMMARY record:

1. Click the PODetail Group to highlight it and select Insert from the Edit
menu. Select Record from the cascading menu to display the Positional
Record Properties dialogue.

Remember to select “Insert” from the Edit menu when
you want to create equal records/groups and select
“Create Sub” from the Edit menu to create
subordinate groups/recor ds/fields.

2. Inthe Namefield, type “POSUMMARY" asthe record identification
code.
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Do not use spacesor hyphens(-) in the Namefield. You
@ can use the underscore () to separate words.

3. Inthe Descfield, type “Summary Record” as the description of the
record. Thisfield isused to provide a brief explanation of the record,
which will allow you to differentiate it from similar records.

4. IntheTagfield, type“SUM” asthe record identification code <TAG>.
For example, arecord is recognised by the system as the following:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognise that
record and then determine the mapping requirements.

We recommend that you definethe record tag on the
Positional Record Properties dialogue, instead of
defining fieldswith the pur pose of explicitly containing
therecord tag.

5. Inthe Position field, accept the default of “1” as the starting column
position of the tag in the data record.

Accept the default of “0” in the Min Usage field. Thisis the minimum
number of times the record must repeat.

If theMin Usagefield contains“0” (zero), therecord is
conditional. If the Min Usage field contains“1” or
greater, therecord ismandatory.

Also, accept the default of “1” in the Max Usage field so the summary
record only occurs once (not alooping structure).
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Creating the
Application
Fields

The Positional Record Properties dialogue should now ook like this:
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6. Click OK to create the POSUMMARY record.
The application side of the map (output) should now look like this:

OUTPUT M- £
FOHEADER -M- 1 Header Record
PODetailGroup -C- 200000 PO Detail Grnupﬁ
PODETAIL -C- 1 Detai Hecnrdsj
FODESC -C- & Descoption Recaord
POSUMMARY -C- 1 Summany Recaord

Each record you create will contain a group of logically-related application
fields. These fields define the structure and content of the data that your
system needs to process the purchase order.

The easiest way to add application fields to arecord is to use the Positional
Field Editor. You will generally create the fields for the first record in the
application file (POHEADER), and then proceed with each sequential
record.
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Field Name

The application fields that you need to create are listed under their respective
recordsin the following table. The name, mandatory status, description, data
type, and field length for each field are given in the table.

Description

Header Record (POHEADER) 1 per message

Min Max
Length  Length

CUSTNUMHDR X Customer Number String 1 8
PODATEHDR X Purchase Order Date Dt/Tm 8 8
(DD/MM/YY)
PONUMHDR X Purchase Order Number String 1 22
POTYPCODE Purchase Order Type Code String 0 2
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD2 Ship To Address Line 2 String 0 35
SHIPTOCITY Ship To City String 0 35
SHIPTOSTATE Ship To State, Province, or String 0 35
Country
SHIPTOPOSTALCODE Ship To Postal Code String 0 9
CUSTNAME Customer Name String 0 35
CUSTADD1 Customer Address Line 1 String 0 35
CUSTADD2 Customer Address Line 2 String 0 35
CUSTCITY Customer City String 0 35
CUSTSTATE Customer State, Province, or String 0 35
Country
CUSTPOSTAL CODE Customer Postal Code String 0 9
DELDATE X Delivery Date Dt/Tm 8 8
(DD/MM/YY)
NUMLINEITEMS X Number of Line Items Number (NO) |1 6

PO Detail Group (PODetailGroup) up to 200,000 per message

Detail Record (PODETAIL) 1 per message

CUSTNUMDET Customer Number String 1

PODATEDET Purchase Order Date Dt/Tm 8 8
(DD/MM/YY)

PONUMDET X Purchase Order Number String 1 22

CUSTPROCODE X Customer Product Code String 1 30
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Field Name Description TDyagz Length Lg/rlz(th
UPCCODE X UPC Code String 1 30
CONSUMERUNITS Consumer Units in Trading Unit Number (NO) | O 15
UuoM Unit of Measure String 0 7
UNITPR Unit Price Number (R2) |0 14
QTYORD X Quantity Ordered Number (NO) |1 9

Description Record (PODESC) up to 5 per message
CUSTNUMDESC X Customer Number String 1 8
PODATEDESC X Purchase Order Date Dt/Tm 8 8
(DD/IMM/YY)
PONUMDESC X Purchase Order Number String 1 22
DESC Description String 0 81
Summary Record (POSUMMARY) 1 per message
CUSTNUMSUM X Customer Number String 1 8
PODATESUM X Purchase Order Date Dt/Tm 8 8
(DD/IMM/YY)
PONUMSUM X Purchase Order Number String 1 22
NUMLINEITEM SUM Number of Line Items Number (NO) |1 6

Complete the following steps to create the application fields for the
POHEADER record:

1. Click the POHEADER application record with the right mouse button to
access the shortcut menu.
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2. Select Edit Fields... from the shortcut menu to access the Positional

Field Editor dialogue.
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3. Ifthefield you are creating isthefirst field in the record, just click NEW
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details
section.

4. Inthe Namefield, type“CUSTNUMHDR”, which is the name of the
first field in the POHEADER record. Each application field must have a
unique name. It is useful to tag the end of each field that occursin
multiple records with a suffix that identifies the record that containsit.
For example, use the tag “HDR” for the Header record.

Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.

5. Click the Mandatory check box to identify it asarequired field. For this
example, the customer number must be present or el se your system will
not be able to identify who sent the purchase order.

6. Inthe Description field, type “ Customer Number” as the description of
the field. The description is used to provide a brief explanation of the
field that will alow you to differentiate it from similar fields.
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7.

10.
11

12.

13.

From the Data Type drop-down list box, select “ String” as the type of
the field, to specify that this field must contain a phanumeric data.

If you wanted to indicate the exact position of the field
in the record, you would type the starting position of
thefield in the Sart Posfield. You will want to specify
field start positionsif, for example, you will only be
using afew fields but you want them positioned exactly
in therecord.

In thistutorial, you will usethe alternativeto
specifying the start position of each field, which isto
add the fields sequentially in therecord and then use
the Auto Position function. Please see step 13. below for
mor e information on the Auto Position function.

If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format drop-down list box.

Inthe Min Length field, type “1” asthe minimum field length. If the
minimum length of the field is“0”, then accept that default in the Min
Length field.

Inthe Max Length field, type “8" as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify will be
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 52.

After you add the last field, click AUTOPOSI TI ON to automatically
position the fields in the record. The Auto Position function will
automatically calculate the start position in the record of each field
based on the criteriathat each field is positioned directly after the
previous field, and is of the length specified in the Max Length field.
Click YES to acknowledge the warning message that fields will be
sequenced in order.

Please notethat it isonly valid to usethe Auto Position
function if you define arecord tag on the Positional

Record Propertiesdialogue, and if you define every
field in therecord in the sequencethat each field
occurs (asyou are doingin thistutorial).
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The Positional Field Editor dialogue should now look like the following
(only the last eleven fields in the record are currently visible in the
Fields list box):
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14. When you finish adding fields to the POHEADER record, click CLOSE.

Complete the following steps to create the application fields for the
PODETAIL record:

1. Click the PODETAIL application record with the right mouse button to
access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialogue.

3. Ifthefield you are creating isthe first field in the record, just click NEW
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details
section.

4. Inthe Namefield, type“CUSTNUMDET"”, which is the name of the
first field in the PODETAIL record. Each application field must have a
unique name. It is useful to tag the end of the each field that occursin
multiple records with a suffix that identifies the record that containsit.
For example, usethetag “DET” for the detail record.
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Do not use spacesor hyphens(-) in the Namefield. You
@ can use the underscore () to separate words.

10.
11

12.

13.

Click the Mandatory check box to identify it asarequired field. For this
exampl e, the customer number must be present or else your system will
not be able to identify who sent the purchase order.

In the Description field, type “ Customer Number” as the description of
the field. The description is used to provide a brief explanation of the
field that will allow you to differentiate it from similar fields.

From the Data Type drop-down list box, select “ String” as the type of
the field, to specify that this field must contain a phanumeric data.

Q If you wanted to indicate the exact position of thefield

in the record, you would type the starting position of
thefield in the Sart Posfield. You will want to specify
field start positionsif, for example, you will only be
using afew fields but you want them positioned exactly
in therecord.

In thistutorial, you will usethe alternativeto
specifying the start position of each field, which isto
add the fields sequentially in therecord and then use
the Auto Position function. Please see step 13. below for
mor e information on the Auto Position function.

If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format drop-down list box.

Inthe Min Length field, type “1” as the minimum field length. If the
minimum length of thefield is“0”, then just accept that default in the
Min Length field.

Inthe Max Length field, type “8” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify will be
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 52.

After you add the last field, click AUTOPOSI TI ON to automatically
position the fields in the record. The Auto Position function will
automatically calculate the start position in the record of each field
based on the criteriathat each field is positioned directly after the
previous field, and is of the length specified in the Max Length field.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 57



Defining Your Application File Format

Inbound Purchase Order (ORDERS)

58

May 2011

Click YES to acknowledge the warning message that fields will be
sequenced in order.

Please notethat it isonly valid to usethe Auto Position
function if you define arecord tag on the Positional
Record Propertiesdialogue, and if you define every
field in therecord in the sequencethat each field
occurs (asyou are doing in thistutorial).

The Positional Field Editor dialogue should now ook like the
following:
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14. When you finish adding fields to the PODETAIL record, click CLOSE.

Complete the following steps to create the application fields for the
PODESC record:

1. Click the PODESC application record with the right mouse button to
access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialogue.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Inbound Purchase Order (ORDERS) Defining Your Application File Format

10.

If thefield you are creating isthe first field in the record, just click NEW
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details
section.

In the Name field, type “CUSTNUMDESC", which isthe name of the
first field in the PODESC record. Each application field must have a
unique name. It is useful to tag the end of each field that occursin
multiple records with a suffix that identifies the record that containsit.
For example, usethe tag “DESC” for the description record.

Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.

Click the Mandatory check box to identify it asarequired field. For this
example, the customer number must be present or el se your system will
not be able to identify who sent the purchase order.

In the Description field, type “Customer Number” as the description of
the field. The description is used to provide a brief explanation of the
field that will allow you to differentiate it from similar fields.

From the Data Type drop-down list box, select “ String” as the type of
the field, to specify that this field must contain al phanumeric data.

If you wanted to indicate the exact position of the field
in the record, you would type the starting position of
thefield in the Sart Posfield. You will want to specify
field start positionsif, for example, you will only be
using a few fields but you want them positioned exactly
in therecord.

In thistutorial, you will usethe alternativeto
specifying the start position of each field, which isto
add the fields sequentially in therecord and then use
the Auto Position function. Please see step 13. below for
mor e information on the Auto Position function.

If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format drop-down list box.

In the Min Length field, type “1" as the minimum field length. If the
minimum length of thefield is“0”, then accept that default in the Min
Length field.

In the Max Length field, type“8” as the maximum length of the field.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 59



Defining Your Application File Format Inbound Purchase Order (ORDERS)

11. To add thefield and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify will be
positioned below the field.

12. Createtherest of the fields according to the record layout table starting
on page 52.

13. After you add the last field, click AUTOPGsI TI ONto automatically
position the fields in the record. The Auto Position function will
automatically calculate the start position in the record of each field
based on the criteria that each field is positioned directly after the
previousfield, and is of the length specified in the Max Length field.
Click YES to acknowledge the warning message that fields will be
sequenced in order.

Please notethat it isonly valid to usethe Auto Position
function if you define arecord tag on the Positional
Record Propertiesdialogue, and if you define every

field in therecord in the sequencethat each field
occurs (asyou are doing in thistutorial).

The Positional Field Editor dialogue should now ook like this:
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14. When you finish adding fields to the PODESC record, click CLOSE.
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Complete the following steps to create the application fields for the
POSUMMARY record:

1

Click the POSUMMARY application record with the right mouse
button to access the shortcut menu.

Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialogue.

If thefield you are creating isthe first field in the record, just click NEW
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details
section.

In the Name field, type “ CUSTNUMSUM?”, which is the name of the
first field in the POSUMMARY record. Each application field must
have a unique name. It is useful to tag the end of each field that occurs
in multiple records with a suffix that identifies the record that contains
it. For example, “SUM” for the summary record.

Do not use spacesor hyphens(-) in the Namefield. You
can use the under score () to separate words.

Click the Mandatory check box to identify it asarequired field. For this
example, the customer number must be present or else your system will
not be able to identify who sent the purchase order.

In the Description field, type “Customer Number” as the description of
the field. The description is used to provide a brief explanation of the
field that will allow you to differentiate it from similar fields.

From the Data Type drop-down list box, select “ String” as the type of
the field, to specify that this field must contain alphanumeric data.

If you wanted to indicate the exact position of the field
in the record, you would type the starting position of
thefield in the Start Posfield. You will want to specify
field start positionsif, for example, you will only be
using a few fields but you want them positioned exactly
in therecord.

In thistutorial, you will usethe alternativeto
specifying the start position of each field, which isto
add the fields sequentially in therecord and then use
the Auto Position function. Please see step 13. below for
mor e information on the Auto Position function.
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10.
11

12.

13.

If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format drop-down list box.

In the Min Length field, type “1” asthe minimum field length. If the
minimum length of thefield is“0”, then just accept that default in the
Min Length field.

Inthe Max Length field, type “8" as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify will be
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 52.

After adding the last field, click AUTOPGsI TI ON to automatically
position the fields in the record. The Auto Position function will
automatically calculate the start position in the record of each field
based on the criteria that each field is positioned directly after the
previousfield, and is of the length specified in the Max Length field.
Click YES to acknowledge the warning message that fields will be
sequenced in order.

Please notethat it isonly valid to usethe Auto Position
function if you define a record tag on the Positional

Record Propertiesdialogue, and if you define every
field in therecord in the sequence that each field
occurs (asyou aredoing in thistutorial).
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The Positional Field Editor dialogue should now ook like the
following:
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14. When you are completely finished adding fields to the POSUMMARY
record, click CLOSE.

After defining your application file format to Sterling Gentran:Director, the
next step isto map the necessary data from the EDI file to your application

fields.
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Each record contains a group of logically-related application fields. These
fields will contain the information from the EDI file that your system needs
to process the purchase order. The group contains logically-related
application records.

Each record contains a three-field record key that ensures that the same
identifying information is located at the beginning of each record. Your
application file format contains a record key so that each record can be
identified individually. The record key for this purchase order consists of
your partner’s customer number, the purchase order date, and the purchase
order number.

This section examines each application field sequentially and describes the
mapping operations that you need to perform to map the appropriate data
into each field.

This section describes the actions necessary for you to map to each field in
the POHEADER (header) record. The POHEADER (header) record contains
the purchase order type code, shipping and customer information, delivery
date information, and the number of lineitemsin the purchase order. This
header record is mandatory and occurs once for each purchase order
translated.

The Application Integration subsystem allows you to use selected
information from the Sterling Gentran:Director Partner database in your
maps via a standard rule. You can map information from your trading
partner's profile in the Partner Editor to a selected element or field in the
map. The information that you can use in the map includes any field in a
table (location, lookup, or cross-reference) or data from the partner record.

For this map, you need to extract information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is a part of the record key for each record, it
appears four timesin the application file format, once in each record
(CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, and
CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. The customer number identifies which trading
partner sent the purchase order. This customer number is already part of the
partner definition for this partner, so you can map it from the partner
definition to each customer number field.
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Complete the following steps to map the customer number from the
document record:

1

Double-click the CUSTNUMHDR field (in the POHEADER record) to
display the Field Properties dialogue.

icld |'epeibics
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2.

If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

The Advanced section will be displayed only if you
previously clicked ADVANCED>> on a Field Properties
dialogue (during this session of Sterling
Gentran:Director), and did not click <<ADVANCED to
hide this section before closing the Field Properties
dialogue.

In the Advanced section, click the Use Standard Rule check box to
display the rule options.
Verify that the Select radio button is selected.

From the Table drop-down list box, select “Document record”. This
indicates that the system will update this field with selected information
from the document record.

Click the Exclusive check box to indicate that acompliance error should
be generated if the Select function does not find avalid entry.

From the Map From list box, choose “ Partner Key”. Thisisthefield that
contains the customer number for this partner.

From the Map To list box, choose “CUSTNUMHDR”. Thisisthe field
to which the information from the Partner Editor will be mapped.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 65



Mapping Your Data

Inbound Purchase Order (ORDERS)

66

PODATEHDR

May 2011

The Advanced section of the Field Properties dialogue should now look
like this:

Adwanced
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9. Click CK to add the standard rule to the CUSTNUMHDR field.

On the EDI side of the map, the purchase order date information is contained
in the ORD segment. The ORD segment contains order reference
information for the header part of the map, and repeats multiple times. You
need to map the date order placed by customer (ORD ORNO ORN?2) to the
PODATE field in each of the application records (PODATEHDR,
PODATEDET, PODATEDESC, and PODATESUM). The ORD ORNO
ORNZ2 element can be directly linked to the PODATEHDR field in the
POHEADER record.

Complete the following steps to map the date order placed by customer:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the ORD ORNO ORN2 element (Date Order Placed by
Customer). When you click the element, the cursor changesto a“Link
AITOW”: | e

Click the application field PODATEHDR in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the ORD
ORNO ORN2 element and the PODATEHDR field.
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PONUMHDR You can map the PONUMHDR field directly from the ORD ORNO ORNO
element (Customer’s Order Number), by using the Link function. The ORD
ORNO ORNO element can be directly mapped (linked) to the PONUMHDR
field in the POHEADER application record.

We recommend that you set up a Document Name for each map, to make the
identification of a message created by this map easier in Sterling
Gentran:Director. The Document Name allows you to differentiate between
messages in the document browsersin Sterling Gentran:Director.

To set up a Document Name, you must select an element or field in the map
that contains data that will distinguish the messages translated by this map.
Then, the Name field of the document browsers that contain this message
will contain the data from the selected element or field.

You can choose any element or field asthe Document
Name, but we strongly recommend that you select an
element or field that occursonly oncein the message
and hasadatatypeof “String”. For a purchase order,
the document nameistypically the customer’s order
number.

Mapping the customer’'s  Complete the following steps to map the customer’s order number:

order number L . . . .
If the Linking function is not currently active, click the Link button on

the Main Toolbar to turn on the Linking function.

2. Click the ORD ORNO ORNO element (Customer’s Order Number).
When you click the element, the cursor changesto a“Link
Arow”: ||k

Click the application field PONUMHDR in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the ORD
ORNO ORNO element and the PONUMHDR field.
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Complete the following steps to set up the document name for this purchase

name order:

1

Double-click the ORD ORNO ORNO element (Customer’s Order
Number) to display the Field Properties dialogue.
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If the Advanced section of the Field Properties dialogue is not currently
displayed, click ADVANCED>> to access this section, which enables
you to define rules.

In the Advanced section, click the Use Standard Rule check box, to
display the rule options.

Click the Update radio button.

From the Table/Key drop-down list box, choose “ Document record”.
Thisindicates that you are updating the document record in Sterling
Gentran:Director.

From the Field drop-down list box, choose “Document Name.” This
indicatesthat you are updating the Name field in the document browsers
with the contents of this element.
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7.

The Advanced section of the dialogue should now look like this:
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Click OK to set up the document name.

POTYPCODE You can map the POTY PCODE field directly from the ORD CDO07 element
(Order Code), by using the Link function.

SHIPTONAME

Complete the following steps to map the coded message function:

1

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the ORD CDO07 element (Order Code). When you click the
element, the cursor changesto a“Link Arrow”:  LIME

Click the application field POTY PCODE in the POHEADER record.

A lineisdisplayed, visualy illustrating thelink between the ORD CDOQ7
element and the POTY PCODE field.

On the EDI side of the map, the shipping name and address information is
contained in the CL O (Customer’s Location) segment. You need to map the
shipping information to the Ship To fields in the application header record.

Complete the following steps to map the ship to name:

1

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CLO CNAM element (Customer’s Name). When you click the
element, the cursor changesto a“Link Arrow”.

Click the application field SHIPTONAME in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the CLO
CNAM element and the SHIPTONAME application field.
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SHIPTOADD1 Completethe following steps to map the ship to address line 1:

1.

2.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CLO CADD CADO element (Customer’s Address Line 1).
When you click the element, the cursor changesto a“Link
AITowW”: | e

Click the application field SHIPTOADD1 in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the CLO
CADD CADO element and the SHIPTOADD1 application field.

SHIPTOADD2 Complete the following steps to map the ship to address line 2:

1.

2.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CLO CADD CAD1 element (Customer’s Address Line 2).
When you click the element, the cursor changesto a“Link Arrow”.

Click the application field SHIPTOADD2 in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the CLO
CADD CAD1 eement and the SHIPTOADD?2 application field.

SHIPTOCITY Complete the following steps to map the ship to city:

1.

2.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CLO CADD CAD2 element (Customer’s Address Line 3).
When you click the element, the cursor changesto a“Link Arrow”.

Click the application field SHIPTOCITY in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the CLO
CADD CAD?2 element and the SHIPTOCITY application field.

SHIPTOSTATE Complete the following steps to map the ship to state:

l.

2.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CLO CADD CAD3 element (Customer’s Address Line 4).
When you click the element, the cursor changesto a“Link Arrow”.

Click the application field SHIPTOSTATE in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the CLO
CADD CAD3 element and the SHIPTOSTATE application field.
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SHIPTOPOSTAL  Complete the following steps to map the ship to postal code:

CODE

1

2.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CLO CADD CAD4 element (Customer’s Post Code). When
you click the element, the cursor changesto a“Link Arrow”: | .y

Click the application field SHIPTOPOSTAL CODE in the POHEADER
record.

A lineisdisplayed, visualy illustrating the link between the CLO
CADD CAD4 element and the SHIPTOPOSTAL CODE application
field.

CUSTNAME Onthe EDI side of the map, the customer name and address information is
contained in the CDT (Customer Details) segment. You need to map the
customer name and address information to the Customer fieldsin the
application header record.

CUSTADD1

Complete the following steps to map the customer name:

1

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CDT CNAM element (Customer’s Name). When you click the
element, the cursor changesto a“Link Arrow”.

Click the application field CUSTNAME in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the CDT
CNAM element and the CUSTNAME application field.

Complete the following steps to map the customer addressline 1:

1.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CDT CADD CADO element (Customer’s Address Line 1).
When you click the element, the cursor changesto a“Link Arrow”.

Click the application field CUSTADD1 in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the CDT
CADD CADO element and the CUSTADD1 application field.

CUSTADD2 Complete the following steps to map the customer address line 2:

l.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.
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Click the CDT CADD CAD1 element (Customer’s Address Line 2).
When you click the element, the cursor changesto a“Link
Arow”: ||k

Click the application field CUSTADD2 in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the CDT
CADD CAD1 element and the CUSTADD?2 application field.

CUSTCITY Completethe following steps to map the customer city:

1.

2.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CDT CADD CAD?2 element (Customer’s Address Line 3).
When you click the element, the cursor changesto a“Link Arrow”.

Click the application field CUSTCITY in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the CDT
CADD CAD?2 element and the CUSTCITY application field.

CUSTSTATE Complete the following steps to map the customer state:

1.

2.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CDT CADD CAD3 element (Customer’s Address Line 4).
When you click the element, the cursor changesto a“Link Arrow”.

Click the application field CUSTSTATE in the POHEADER record.

A lineisdisplayed, visualy illustrating the link between the CDT
CADD CAD3 element and the CUSTSTATE application field.

CUSTPOSTAL  Complete the following steps to map the customer postal code:

CODE

72 May 2011

1.

2.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the CDT CADD CAD4 element (Customer’s Post Code). When
you click the element, the cursor changesto a“Link Arrow”.

Click the application field CUSTPOSTAL CODE in the POHEADER
record.

A lineisdisplayed, visualy illustrating the link between the CDT
CADD CAD4 element and the CUSTPOSTAL CODE application field.
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DELDATE

NUMLINEITEMS

PODetailGroup

PODETAIL
Record

On the EDI side of the map, the delivery date information is contained in the
DIN (Delivery Instructions) segment. You can map the delivery date directly
from the DIN LDAT element (Latest Delivery Date).

Complete the following steps to map the delivery date:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the DIN LDAT element (Latest Delivery Date). When you click
the element, the cursor changesto a“Link Arrow”:  LIMK

Click the application field DELDATE in the POHEADER record.

4. Alineisdisplayed, visualy illustrating the link between the DIN LDAT
element and the DELDATE application field.

You can map the NUMLINEITEMS field directly from the OTR LORD
element (Lines Ordered), by using the Link function. Later in this tutorial,
you will aso link the OTR LORD element to the NUMLINEITEMSUM
field in the POSUMMARY record.

Complete the following steps to map the number of lineitems:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the OTR LORD element (Lines Ordered). When you click the
element, the cursor changesto a“Link Arrow”.

3. Click the application field NUMLINEITEMS in the POHEADER
record.

4. Alineisdisplayed, visudly illustrating the link between the OTR
LORD element and the NUMLINEITEMSfield.

The PODetail Group (detail information) contains al the line item
information for the order, including the item, unit of measure, price, quantity
ordered, and the description information. Each PODetail Group can occur up
to 200,000 times per order translated. This equals a maximum order of
200,000 items. The information within the PODetail Group is further
segregated by record.

This section describes the actions necessary for you to map to each field in
the PODETAIL (detail) record. The PODETAIL (detail) record containsline
item code number, consumer unitsin trading unit, unit of measure, price, and
guantity ordered. The PODETAIL record occurs once per PODetail Group.
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CUSTNUMDET

The Application Integration subsystem allows you to use selected
information from the Sterling Gentran:Director Partner Editor in your maps
viaa standard rule. You can map information from your trading partner's
profile in the Partner Editor to a selected element or field in the map. The
information that you can use in the map includes any field in atable
(location, lookup, or cross-reference) or data from the partner key.

For this map, you need to extract information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is a part of the record key for each record, it
appears five timesin the application, oncein each record (CUSTNUMHDR,
CUSTNUMDET, CUSTNUMDESC, and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application. The customer number identifies which trading partner sent
the purchase order. This customer number is aready part of the partner
definition for this partner, so you can map it from the partner definition to
each customer number field.

Complete the following steps to map the customer number from the partner

definition:

1. Double-click the CUSTNUMDET field (in the PODETAIL record) to
display the Field Properties dialogue.
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2. If the Advanced section of the dialogueis not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

4. Verify that the Select radio button is selected.

From the Table drop-down list box, select “Document record”. This
indicates that the system will update this field with selected information
from the document record.

6. Click the Exclusive check box to indicate that acompliance error should
be generated if the Select function does not find avalid entry.
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7. From the Map From list box, choose “Partner Key”. Thisisthe field that
contains the customer number for this partner.

8. From the Map To list box, choose “CUSTNUMDET”. Thisisthe field
to which the information from the Partner Editor will be mapped.

The Advanced section of the Field Properties dial ogue should now look
like this:
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9. Click CK to add the standard rule to the CUSTNUMDET field.

PODATEDET OntheEDI sideof the map, the purchase order date information is contained
in the ORD segment. The ORD segment contains order reference
information for the header part of the map, and repeats multiple times. You
need to map the date order placed by customer (ORD ORNO ORNZ2) to the
PODATE field in each of the application records (PODATEHDR,
PODATEDET, PODATEDESC, and PODATESUM).

You can only map fields and elements that are at the same level. Therefore,
you cannot map to a group from a segment that does not repeat. For
example, you cannot map the date order placed by customer in the ORD
segment (which repeats once) directly to your application PODATEDET
field (which isincluded in the PODetail Group that repeats 200,000 times).

Therefore, to map the purchase order date to this application field, you need
to use an extended rule to extract the purchase order date from the ORD
ORNO ORD?2 element and move it to the PODATEDET field.
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Using an extended rule  Complete the following steps to create the extended rule:

1. Double-click the PODATEDET field to access the Field Properties
dialogue.
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2. If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Click RULE... to display the Field Level Extended Rule dialogue.

Flcld Level Latended Hulc

Fue
s K
+
| | *

Compie Einore

4. IntheRulelist box, type the following:
#PODATEDET = $ORDERS#0ORNZ2;
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The “SORDERS#0ORN2" is the addressing for the ORD ORNO ORD2
element. The system will execute this rule when it processes the
PODATEDET field.

5. Click COWPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the trand ation object,
after you complete the map. However, the system allows you to compile
each ruleindividualy, so that you can verify the accuracy of therule
after you createit.

The Compile function will compiletherule
interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated inthe
compilation process are displayed in the Errorslist
box.

6. Click OK to add the extended rule to the PODATEDET field.
7. Click CLOSE to exit the Field Properties dialogue.

PONUMDET The ORD ORNO ORNO e ement contains the customer’s order number. The
ORD segment does not repeat. You need to map the information from the
ORD ORNO ORNO element to the PONUMDET field. However, the
PONUMDET fieldisincluded in the PODetail Group, which repeats 200,000
times.

You can only map fields and elements that are at the same level. Therefore,
you cannot map to a group from a segment that does not repeat. For
example, you cannot map the customer’s order number in the ORD segment
directly to your application PONUMDET field.

Therefore, to map the customer’s order number to this application field, you
need to use an extended rule to extract the number from the ORD ORNO
ORNO element and move it to the PONUMDET field.
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Using an extended rule  Complete the following steps to create the extended rule:

1

Double-click the PONUMDET field to access the Field Properties
dialogue.
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If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

Click RULE... to display the Field Level Extended Rule dialogue.
In the Rule list box, type the following:
#PONUMDET = $ORDERS#ORNO;

The “SORDERS#0ORNOQ" is the addressing for the ORD ORNO ORNO
element. The system will execute this rule when it processes the
PONUMDET field.

Click COVPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the trang ation object,
after you complete the map. However, the system allows you to compile
each ruleindividualy, so that you can verify the accuracy of therule
after you createit.

The Compile function will compiletherule
interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated in the
compilation processaredisplayed in the Errorslist
box.

Click OK to add the extended rule to the PONUMDET field.
Click CLOSE to exit the Field Properties dialogue.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Inbound Purchase Order (ORDERS) Mapping Your Data

CUSTPROCODE
UPCCODE

My Value

12345678901234

The Application Integration subsystem enables you to use selected
information from the Sterling Gentran:Director partner database in your
maps via a standard rule. You can map information from your trading
partner's profile in the Partner Editor to a selected element or field in the
map. The information that you can use in the map includes any field in a
table (location, lookup, or cross-reference) or data from the partner record.

For this map, you need to map information from a cross-reference table for
the PETZONES partner profile, to translate your partner’s code for a
purchased item and your code for the same item. Your partner uses a
customer product code (CUSTPROCODE) for each item that is meaningful
to Pet Zone. However, your company uses a UPC code (UPCCODE) for
each item. After you and your partner determine what the equivalent
customer product codeis for each UPC code, you can create a cross-
reference table in the Partner Editor and use that information in your map.

A cross-reference table is used when you and your partner each reference an
item by a different name (or number). For example, if your unique name for
a“widget” is“wid” and your partner’s unique name for the same “widget” is
“1234", the system uses the cross-reference tabl e to trandlate the two names
for the “widget” item.

In this map, you have one code (UPC code) for each item ordered. Your
partner refers to the sameitem by a different code (customer product code).
You need to map the customer’sitem code from the OLD:2 CPRO CPR1
element (Customer’s Item Code) to the customer product code field
(CUSTPROCODE) on the application side of the map. Therefore, you must
use a cross-reference table to tranglate the customer product code to your
UPC code. You and your partner determined what the equivalent customer
product codeisfor each UPC code. In thistutorial, you the cross-reference
tableisincluded with the partner (PETZONE3.PAR) you will import later in
thistutorial into Partner Editor.

The following table contains the information in the cross-reference table.
The“My Vaue’ field contains your UPC code for theitem. The “Partner
Value’ field contains your partner’s customer product code for theitem. The
“Description” field contains a description (and size, if applicable) of the
item, and the Reference Data field contains additional quantity or colour
information.

Partner Value Description Reference Data

555666411 Large Dog Collar Red

23456789012345

555666817 Spring Breeze Cat Litter 5 Kg. Bag

34567890123456

555666908 Small Beef Basted Rawhide Bones | Bag of 12
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My Value Partner Value Description Reference Data
45678901234567 555666321 X-Large Food Bowl Black
56789012345678 555666287 FatKat Kitty Bed Blue with White Trim
67890123456789 555666413 Catnip Mouse Toy

Mapping the customer
product code

You do not need to create this cross-reference table — it
isincluded with the PETZONES3 partner
(PETZONE3.PAR) that is provided with the tutorial
data when you install Serling Gentran:Director.

Finally, you need to use a standard rule to map the translated value from the
CUSTPROCODE field to the UPCCODE field.

Complete the following steps to map the customer’s item code:
If the Linking function is not currently active, click the Link button on

the Main Toolbar to turn on the Linking function.

2. Click the OLD:2 CPRO CPR1 element (Customer’s Item Code). When
you click the element, the cursor changesto a“Link Arrow”: | .y

Click the application field CUSTPROCODE in the PODETAIL record.

4. Alineisdisplayed, visualy illustrating the link between the OLD:2
CPRO CPR1 element and the CUSTPROCODE field.

Translating Complete the following steps to translate your partner’s customer product
CUSTPROCODE to  code to your UPC Code for each item your partner ordered:

UPCCODE

1. Double-click the CUSTPROCODE field (in the PODETAIL record).

The Field Properties dialogue is displayed.

Fizld Fropoiticz

Name

IEUSTF‘HEII:EIDE

D eezcriplion IEu:th:ln'Ef Froduct Code

Canc=l

ala ™ aidation
M

[LEH]

Tppa Format

W Hiandalon |1

|:3|J

ferrs (2

of | &
AT
f 1)

80 May 2011

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Inbound Purchase Order (ORDERS) Mapping Your Data

2. If the Advanced section of the dialogueis not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Verify that the Select radio button is selected.

From the Table drop-down list box, select “Partner xref by partner
item”. Thisindicates that you will be using a cross-reference table and
trandating by your partner’sitem.

6. Inthe Sub Tablefield, type“PRODCODE". Thisisthe name of the
cross-reference table.

7. Click the Exclusive check box to signal the system that if thistrangation
fails, you want the system to generate an error.

8. From the Map From list box, choose “My Item”. Thisisthefield from
which the contents will be mapped.

9. From the Map To list box, choose “UPCCODE". Thisisthefield to
which the information from the Partner Editor will be mapped.

The Advanced section of the Field Properties dial ogue should now look
like this:
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10. Click OK to map from the cross-reference table.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 81



Mapping Your Data

Inbound Purchase Order (ORDERS)

CONSUMERUNITS

Changing the properties
of the OLD:2 UNOR
UNOO element

On the EDI side of the map, the consumer units information is contained in
the OLD:2 UNOR UNOO element (Consumer Unitsin Traded Units). The
OLD:2 UNOR UNOOQ element is defined as a string-type element in the
standard. However, you have determined that your partner will send you a
number-type element in NO format (formatted with an implicit decimal point
and no decimal place).

Therefore, you will need to change the properties of the OLD:2 UNOR
UNOO element to reflect the type and the format that you have determined
that your partner will send you. Then, you can map the consumer units
information directly from the OLD:2 UNOR UNOO element to the
CONSUMERUNITS application field.

Complete the following steps to change the type and format of the OLD:2
UNOR UNOO element:

Double-click the OLD:2 UNOR UNQOO element (Consumer Unitsin
Traded Units) to display the Field Properties dialogue.

2. From the Type drop-down list box, select “Number” to indicate that this
isanumber element. The system will prompt you with a message that
changing the field's data type will invalidate its format. Click YES to
acknowledge this message and proceed.

3. From the Format drop-down list box, select “NO” to indicate that this
element will be formatted with animplicit decimal point and no decimal
place.

The Field Properties dialogue should now look like this:
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Mapping the consumer
units
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4. Click OKto exit the Field Properties dialogue.

Complete the following steps to map the consumer units:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.
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UOM

UNITPR

QTYORD

2. Click the OLD:2 UNOR UNOO element (Consumer Unitsin Traded
Units). When you click the element, the cursor changesto a*“Link
AITow”: | i

3. Click the application field CONSUMERUNITS in the PODETAIL
record.

4. Alineisdisplayed, visualy illustrating the link between the OLD:2
UNOR UNOO element and the CONSUMERUNITSfield.

On the EDI side of the map, the measure indicator information is contained
inthe OLD:2 UNOR CD04 element (Measure Indicator). You can map the
unit of measurement directly from the OLD:2 UNOR CDO04 element to the
UOM application field.

Complete the following steps to map the measure indicator:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Clickthe OLD:2 UNOR CDO04 element (Measure Indicator). When you
click the element, the cursor changesto a“Link Arrow”.

Click the application field UOM in the PODETAIL record.

A lineisdisplayed, visualy illustrating the link between the OLD:2
UNOR CDO04 element and the UOM field.

On the EDI side of the map, the cost price information is contained in the
OLD:2 OUCT OUCO element (Cost Price). You can map the unit of
measurement directly from the OLD:2 OUCT OUCO element to the
UNITPR application field.

Complete the following steps to map the unit cost price:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the OLD:2 OUCT OUCO element (Cost Price). When you click
the element, the cursor changesto a“Link Arrow”.

Click the application field UNITPR in the PODETAIL record.

4. Alineisdisplayed, visudly illustrating the link between the OLD:2
OUCT OUCO element and the UNITPR field.

On the EDI side of the map, the quantity ordered information is contained in
the OLD:2 OQTY OQTO element (Number of Traded Units Ordered). The
OLD:2 OQTY OQTO0 element is defined as a string-type element in the
standard. However, you have determined that your partner will send you a
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number-type element in NO format (formatted with an implicit decimal point
and no decimal places).

Therefore, you will need to change the properties of the OLD:2 OQTY
OQTO element to reflect the type and the format that you have determined
that your partner will send you. Then, you can map the quantity ordered
directly from the OLD:2 OQTY OQTO0 element to the QTY ORD application
field.

Changing the properties Complete the following steps to change the type and format of the OLD:2

of the OLD:2 OQTY OQTY OQTO element:
OQTO element

1. Double-click the OLD:2 OQTY OQTO element (Number of Traded
Units Ordered) to display the Field Properties dialogue:
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2. Fromthe Type drop-down list box, select “Number” to indicate that this
isanumber element. The system will prompt you with a message that
changing the field's data type will invalidate its format. Click YES to
acknowledge this message and proceed.

3. From the Format drop-down list box, select “NQ” to indicate that this
element will be formatted with animplicit decimal point and no decimal
place.

The Field Properties dial ogue should now look like this:
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4. Click OK to exit the Field Properties dialogue.
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Mapping the quantity
ordered

PODESC Record

CUSTNUMDESC

Complete the following steps to map the quantity ordered:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Clickthe OLD:2 OQTY OQTO0 element (Number of Traded Units
Ordered). When you click the element, the cursor changesto a*“Link
AITow”: | e

Click the application field QTY ORD in the PODETAIL record.

A lineisdisplayed, visualy illustrating the link between the OLD:2
OQTY OQTO element and the QTYORD field.

This section describes the actions necessary for you to map to each field in
the PODESC (description) record. The PODESC (description) record
contains descriptive information about the line item ordered. The PODESC
record can occur up to five times per PODetail Group, so multiple descriptive
terms can be used for each item. For example, if the lineitem isa*“dog
collar,” the description fields may be “red,” “large,” and “leather.”

The Application Integration subsystem allows you to use selected
information from the Sterling Gentran:Director Partner Editor in your maps
viaa standard rule. You can map information from your trading partner's
profile in the Partner Editor to a selected element or field in the map. The
information that you can use in the map includes any field in atable
(location, lookup, or cross-reference) or data from the partner key.

For this map, you need to extract information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is a part of the record key for each record, it
appears four times in the application file format, once in each record
(CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, and
CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. The customer number identifies which trading
partner sent the purchase order. This customer number is already part of the
partner definition for this partner, so you can map it from the partner
definition to each customer number field.
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Complete the following steps to map the customer number from the partner
definition:

1

Double-click the CUSTNUMDESC field (in the PODESC record) to
display the Field Properties dialogue.
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If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Verify that the Select radio button is selected.

From the Table drop-down list box, select “Document record”. This
indicates that the system will update this field with selected information
from the document record.

Click the Exclusive check box to indicate that acompliance error should
be generated if the Select function does not find avalid entry.

From the Map From list box, choose “Partner Key”. Thisisthe field that
contains the customer number for this partner.

From the Map To list box, choose“CUSTNUMDESC". Thisisthefield
to which the information from the Partner Editor will be mapped.
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The Advanced section of the Field Properties dialogue should now ook
like this:
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9. Click OK to add the standard rule to the CUSTNUMDESC field.

PODATEDESC OntheEDI side of the map, the purchase order date information is contained
in the ORD segment. The ORD segment contains order reference
information for the header part of the map, and repeats multiple times. You
need to map the date order placed by customer (ORD ORNO ORN?2) to the
PODATE field in each of the application records (PODATEHDR,
PODATEDET, PODATEDESC, and PODATESUM).

You can only map fields and elements that are at the same level. Therefore,
you cannot map to a group from a segment that does not repeat. For
example, you cannot map the date order placed by customer in the ORD
segment (which repeats once) directly to your application PODATEDESC
field (which isincluded in the PODetail Group that repeats 200,000 times).

Therefore, to map the purchase order date to this application field, you need
to use an extended rule to extract the purchase order date from the ORD
ORNO ORD2 element and move it to the PODATEDESC field.
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Using an extended rule  Complete the following steps to create the extended rule:

1

Double-click the PODATEDESC field to access the Field Properties
dialogue.
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6.
7.

If the Advanced section of the dialogueis not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

Click RULE... to display the Field Level Extended Rule dialogue.
In the Rule list box, type the following:
#PODATEDESC = $SORDERS#ORN2;

The “SORDERS#0ORNZ2" is the addressing for the ORD ORNO ORD2
element. The system will execute this rule when it processes the
PODATEDESC field.

Click COWPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the translation object,
after you complete the map. However, the system allows you to compile
each rule individually, so that you can verify the accuracy of therule
after you createit.

The Compile function will compiletherule
interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated in the
compilation processwill bedisplayed in the Errorslist
box.

Click OK to add the extended rule to the PODATEDESC field.
Click CLOSE to exit the Field Properties dialogue.
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PONUMDESC The ORD ORNO ORNO element contains the customer’s order number. The
ORD segment does not repeat. You need to map the information from the
ORD ORNO ORNO element to the PONUMDESC field. However, the
PONUMDESC field isincluded in the PODetail Group, which repeats
200,000 times.

You can only map fields and elements that are at the same level. Therefore,
you cannot map to a group from a segment that does not repeat. For
example, you cannot map the customer’s order number in the ORD segment
directly to your application PONUMDESC field.

Therefore, to map the customer’s order number to this application field, you
need to use an extended rule to extract the number from the ORD ORNO
ORNO element and move it to the PONUMDESC field.

Using an extended rule  Complete the following steps to create the extended rule;

1

Double-click the PONUMDESC field to access the Field Properties
diaogue.

I 121d | tepribics
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If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

Click RULE... to display the Field Level Extended Rule dialogue.
In the Rule list box, type the following:
#PONUMDESC = $ORDERS#0ORNO;

The “$ORDERS#0ORNO" is the addressing for the ORD ORNO ORNO
element. The system will execute this rule when it processes the
PONUMDESC field.

Click COVPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the translation object,
after you complete the map. However, the system allows you to compile
each rule individually, so that you can verify the accuracy of therule
after you create it.
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Using an extended rule

interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated in the
compilation processwill bedisplayed in the Errorslist
box.

6. Click OK to add the extended rule to the PONUMDESC field.
7. Click CLOSE to exit the Field Properties dialogue.

Q The Compile function will compiletherule

The DESC field is avail able so your partner can describe theitem in afree-
form format. You can map the DESC field (description) by using an
extended rule to concatenate the OLD:2 TDES TDEO (Traded Unit Descr.
Line 1) and OLD:2 TDES TDE1 (Traded Unit Descr. Line 2) elements, and
map the concatenated string to the DESC field in the PODESC record.

Complete the following steps to create the extended rule:
1. Double-click the DESC field to access the Field Properties dialogue.
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2. If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

Click RULE... to display the Field Level Extended Rule dialogue.
In the Rule list box, type the following:
#DESC =$OLD#TDEO+" " + $OLD#TDEZL,;

The “$OLD.#TDEQ" is the addressing for the OLD:2 TDES TDEO
element. The“+” concatenates the character strings. The* ” isablank
space, to distinguish the two concatenated lines of text. The
“$OLD.#TDE1" isthe addressing for the OLD:2 TDES TDE1 element.
The system will execute this rule when it processes the PONUMDET
field.
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5. Click COVPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the trang ation object,
after you complete the map. However, the system allows you to compile
each ruleindividualy, so that you can verify the accuracy of the rule
after you createit.

The Compile function will compiletherule
interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated inthe
compilation process will be displayed in the Errorslist
box.

6. Click OK to add the extended rule to the PONUMDESC field.
7. Click CLOSE to exit the Field Properties dialogue.

POSUMMARY

Record This section describes the actions necessary for you to map to each field in
the POSUMMARY (summary) record. The POSUMMARY (summary)
record contains the total number of line items in the purchase order. The
POSUMMARY record occurs once for each purchase order translated.

CUSTNUMSUM The Application Integration subsystem allows you to use selected
information from the Sterling Gentran:Director Partner Editor in your maps
viaastandard rule. You can map information from your trading partner's
profilein the Partner Editor to a selected element or field in the map. The
information that you can use in the map includes any field in atable
(location, lookup, or cross-reference) or data from the partner key.

For this map, you need to extract information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is a part of the record key for each record, it
appears four times in the application file format, once in each record
(CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, and
CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. The customer number identifies which trading
partner sent the purchase order. This customer number is already part of the
partner definition for this partner, so you can map it from the partner
definition to each customer number field.
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Complete the following steps to map the customer number from the partner
definition:

1

Double-click the CUSTNUMSUM field (in the POSUMMARY record)
to display the Field Properties dialogue.
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If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Verify that the Select radio button is selected.

From the Table list box, select “Document record” to indicate that the
system will update this field with selected information from the
document record.

Click the Exclusive check box to indicate that acompliance error should
be generated if the Select function does not find avalid entry.

From the Map From list box, choose “ Partner Key”. Thisisthefield that
contains the customer number for this partner.

From the Map To list box, choose “CUSTNUMSUM?”. Thisisthefield
to which the information from the Partner Editor will be mapped.
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The Advanced section of the Field Properties dialogue should now ook
like this:
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9. Click OK to add the standard rule to the CUSTNUMSUM field.

PODATESUM Onthe EDI side of the map, the date information is contained in the ORD
segment. The ORD segment contains order reference information for the
header part of the map, and repeats multiple times. You need to map the date
order placed by customer (ORD ORNO ORN2) to the PODATE field in each
of the application records (PODATEHDR, PODATEDET, PODATEDESC,
and PODATESUM). The ORD ORNO ORNZ2 element is already directly
linked to the PODATEHDR field in the POHEADER record. You will also
map the ORD ORNO ORNZ2 element directly to the PODATESUM
application field.

Complete the following steps to map the date order placed by customer:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the ORD ORNO ORN2 element (Date Order Placed By
Customer). When you click the element, the cursor changesto a“Link
AITowW”: | |k

Click the application field PODATESUM in the POSUMMARY record.

4. Alineisdisplayed, visudly illustrating the link between the ORD
ORNO ORN2 element and the PODATESUM field.

PONUMSUM You can map the PONUMSUM field directly from the ORD ORNO ORNO
element (Customer’s Order Number), by using the Link function. The ORD
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ORNO ORNO element is already mapped (linked) to the PONUMHDR field
in the POHEADER application record, so you will add an additional link
from this element to the PONUMSUM field in the POSUMMARY record.

Complete the following steps to map the customer’s order number:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the ORD ORNO ORNO element (Customer’s Order Number).
When you click the element, the cursor changesto a“Link
AITOW”: | e

Click the application field PONUMSUM in the POSUMMARY record.

A lineisdisplayed, visualy illustrating the link between the ORD
ORNO ORNO element and the PONUMSUM field.

You can map the NUMLINEITEMSUM field directly from the OTR LORD
element (Lines Ordered), by using the Link function. The OTR LORD
element is already mapped (linked) to the NUMLINEITEMSfield in the
POHEADER application record, so you will be adding an additional link
from this element to the NUMLINEITEMSUM field in the POSUMMARY
record.

Complete the following steps to map the number of lineitems:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the OTR LORD element (Lines Ordered),. When you click the
element, the cursor changesto a“Link Arrow”.

3. Click the application field NUMLINEITEMSUM in the
POSUMMARY record.

4. Alineisdisplayed, visudly illustrating the link between the OTR
LORD element and the NUMLINEITEMSUM field.

After you complete the mapping operation for thisfinal application field, the
icons representing each of the application fields should be bisected by ared
tick (except the UPCCODE field in the PODETAIL application record). The
red tick indicates that a mapping operation has been performed against the
field.
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Finalising the Map

After you create the map, define your application file format, and perform
the appropriate mapping operations, you need to finalise the map. To
complete the mapping process, you need to save the map, compile the
trandation object, print and review the Sterling Gentran:Director report, and
test the map.

Compiling the
Map The Compile function compiles the map and generates a translation object.
The map that you created using Sterling Gentran:Director
(PET_TORD.MAP) isasource map. When that source map is compiled, the
result isa compiled translation object.

Thistrandation object will need to be registered with the Sterling
Gentran:Director system before you can use it. You will use the Compile
function after the map is completed and saved.

Complete the following steps to compile a map and generate a translation
object:

1. Select Save from the File menu to save the source map, prior to using
the Compile function.

2. Select Compile from the File menu to display the Run-Time Trandlation
Object Name dialogue.

Run-Time Transzlation Object Hame HE

Save jn: IaTransDbi j gl E E

File: name: IF'et_tUrd.T FL

Save 5 type: | Translation Objects [~ TFL] =l Cancel |

3. The“Filename” field will automatically contain “pet_tord.tpl”. Thisis
the name of the trandation object, using the default . TPL file extension
and our recommendation that you name the translation object (.TPL
file) the same filename (one to eight characters long) as you named the
map (.MAP file). Preserving the same filename (with different file
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extensions) means that the relationship between the source map and the
compiled trand ation object will remain evident.

Be very careful not to overlay the source map with the
compiled translation object. Usethe.TPL fileextension
to distinguish the translation object.

4. Changethe Drive and Folder where the compiled trandglation object will
be stored, if necessary.

Do NOT storethe compiled translation object in the
GENTRAN Director\RegTransObj subfolder. This
subfolder isreserved for storing a copy of each
translation object you register with Serling
Gentran:Director.

5. Click SAVE and the system will compile the map and generate a
trand ation object. The Compile Error dialogue is displayed. Verify that
no errors occurred and click OK to exit the dialogue. The date on which
the transl ation object was compiled will be automatically loaded into the
Compiled on field on the Trand ation Object Details dialogue.
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6. Select Save from the File menu to save the source map with the
Compiled on date.

7. You must register this translation object with the Sterling
Gentran:Director system before you can use it. See the IBM® Serling
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Printing the

Gentran: Director® Release 5.5 User Guide for information on
registering a trandlation object.

Report The Sterling Gentran:Director report enables you to validate and review the

map, and make modifications as needed. If you review the report and
determine that the map isincorrect, you should refine the mapping process
as many times as necessary (make the modifications, save the map,
recompile the translation object, and print the report again).

Complete the following steps to print the Sterling Gentran:Director report:

1. Select Print from the File menu to access the Print Options dialogue.

Print Dptions

— Report zections

¥ Print branching diagram ':
¥ Fiint record details ﬂl
¥ Print mapping details
¥ Print extended rules

¥ Print code lists

W Include only active objects

2. Accept the defaults on this dialogue (all options checked), so the report

will include all sections and only the activated map components. Click
OK and the Print dialogue is displayed.

Set the appropriate options. Click OK if you do not need to change
Setup options, and the mapping report will be printed.

Click SETUP... if you need to access printer setup information (to select
a specific printer, paper orientation, or size and source of paper). The
Print Setup dialogueis displayed.

Set the appropriate options. Click OK if you do not need to change Print
Options (dithering, intensity control, or print true type as graphics), and
you will return to the Print dialogue. Click OK on the Print dial ogue and
the mapping report will be printed.

Click OPTI ONS... if you need to access printer setup options
information. The Options dialogue is displayed.
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Testing the

5.

Set the appropriate options. Click OK to return to the Print Setup
dialogue. Click OK on the Print Setup dialogue to return to the Print

dialogue. Click OK on the Print dialogue and the mapping report will be
printed.

Translation After you compile the map, print and verify the report, and register the

Object trandation object with Sterling Gentran:Director, you should test the
tranglation object to verify that the datais translated correctly. To test the
compiled translation object, you should obtain test data from your partner(s)
and processthe data. You should also verify acknowledgement processing (if
applicable) and verify communications with your network.

May 2011

Complete the following steps to test the inbound (export) translation object
you just created:

1

Register the PET_TORD.TPL tranglation object with Sterling
Gentran:Director. Please see the IBM® Serling Gentran:Director®
Release 5.5 User Guide for more information on registering a
tranglation object.

Import the PETZONE3.PAR partner relationship into Sterling

Gentran:Director. Please see the IBM® Serling Gentran: Director®
Release 5.5 User Guide for more information on importing a partner.

The default full path for the partner fileis: C:\Program Files\Sterling
Commerce\ GENTRAN DirectonTUTORIAL\PETZONE3.PAR

Verify (in Partner Editor) that the PET T ANAOOL 9 ORDERS Export
tranglation object is selected for the Inbound Relationship. Please see
the IBM® Serling Gentran: Director® Release 5.5 User Guide for more
information on selecting inbound translation objects.

Use the Process File option in Sterling Gentran: Director to process the
datafile (PETTSTTL.INT) through the translation object. The datafile
will belocated in the TUTORIAL subfolder under the folder where

Sterling Gentran:Director isinstalled.

The default full path for the datafileis: C:\Program Files\Sterling
Commerce\GENTRAN DirectonNTUTORIAL\PETTSTTL.INT

After the message istrandated, it will be located in the In Documentsin

Sterling Gentran:Director. Export the message to ensure that it was
trandated correctly. Please see the IBM® Serling Gentran: Director®
Release 5.5 User Guide for more information on exporting files.
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Thistutorial exercise defines the step-by-step tasks that are necessary for
you to create a map that will be used to translate your application file to
TRADACOMSinvoices (INVOIC) that you send to your trading partner.

This chapter explains all the tasks and processes associated with creating a
map for an outbound invoice, including the following:

e Mapping analysis

»  Creating the new map

e Activating EDI map components

*  Verifying EDI delimiters

»  Defining the application side of the map

*  Mapping your data

e Finalising the map

online Help for that function. The online Help system
containsfield definitions and other detailed
information.

Q Press F1 from any area of the system to access the
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Thistutorial exercise is meant to be completed in its entirety. We
recommend that you complete each task sequentially, without referring to
the completed map that is provided with the installation program (although
you may want to verify your completed map with the model).

The purpose of completing each task in this tutorial in sequential order, asiif
it were your own scenario, is not only to teach you how to perform the
individual mapping tasks, but also to teach you alogical approach and
methods that you should use when you create your own map.

For outbound translation, you will need to set up a system import map and
an import map. Generally, you will create one system import map for each
message type, and set up an import map for each partner to whom you are
sending messages.

In thistutorial exercise, your company is MWT Manufacturing Co., which
manufactures awide variety of suppliesfor pet stores. Your company sells
pet supplies directly to large pet supply retail chains. You need to create a
map that will enable your company to translate your application file to the
invoices that you will send to one of your trading partners, Pet Zone (alarge
pet supply retailer). After you ship an order to Pet Zone and generate the
corresponding invoice, and once your application fileis tranglated into an
EDI invoice, your company can send the invoice to Pet Zone. You will
invoice only one order per message. You will not be using settlement
discounts.

You have an existing application file layout from your accounts payable
department that defines the information your system will generate for the
invoice. And, from discussions with the Pet Zone, you know the
requirements for the EDI invoices that you will send them.

Thefirst step in creating a map is the analysis of the mapping requirements.
Thisanalysisis the most important step in creating a successful map. If the
analysisyou performis complete, you will have all theinformation you need
to create the map in an efficient and logical manner. If you omit this critical
step and proceed directly to creating the map, it islikely that creating the
map will be amuch longer and arduoustask, and the map may beinvalid due
to oversights and omissions.
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Analysing Your
Application File
Format

Field Name

Regardless of whether you are translating data inbound or outbound,
mapping analysis involves the following steps:

1. Analysing your application file format

2. Analysing your partner(s) EDI file

3. Correlating your application file format and the EDI file
After you complete these steps, you can begin creating the map.

The first step of mapping analysisis analysing your application file format,
because thisis probably the component that is the most familiar to you. For
an outbound map, your application file contains the data that you need to
convert to an EDI file so your system can generate the message correctly. In
thistutorial, your application file contains all the information that you need
to generate the invoice that you will send your partner. This enables your
company to bill your partner correctly for the goods you shipped to them.

You must define your application file to Sterling Gentran:Director. If your
company has an existing application file, asin this tutorial, you should
obtain the record layout from the appropriate person. If you did not have an
existing application file layout, you would need to create one by determining
what fields are necessary to process the data correctly, and then grouping the
fields logically under records.

The application file layout for the system import map in this tutorial isas
follows:

— DETE] Min Max
Description

Type Length  Length

Header Record (HEADER) 1 per message

PARTNER_ID X Partner Identifier String 1
APPL_ID Application ID String 0 6
APPL_ALIAS_VALUE Application Alias Value String 0 6

Field Name

The application file layout for the import map in this tutorial is as follows:

Min Max
Length  Length

Description

Header Record (HEADER) 1 per message

PARTNER_ID X Partner Identifier String
APPL_ID Application ID String 0 6
APPL_ALIAS_VALUE Application Alias Value String 0 6
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Field Name

Description

Beginning Record (INVBEGIN) 1 per message

Min Max
Length  Length

BILLTOACCTBEG X Bill to Acct Number String 1 9
DOCTYPBEG X Document Type String 1
INVNUMBEG X Invoice Number String 1 10
INVDATE X Invoice Date Dt/Tm 6 6
(YYMMDD)
PONUM Purchase Order Number String 0 20
PODATE Purchase Order Date Dt/Tm 6 6
(YYMMDD)
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD2 Ship To Address Line2 String 0 35
SHIPTOCITY Ship To City String 0 35
SHIPTOSTATE Ship To State String 0 35
SHIPTOPOSTALCODE Ship To Postal Code String 0 8
SHIPTOLOC Ship To Store Location String 0
BOLNUM Bill of Lading Number String 0 12
SHIPDATE Ship Date Dt/Tm 6 6
(YYMMDD)
TERMSNETDUE Terms New Due Days Number (RO) | O 3
TERMSTEXT Payment Terms Text String 0 40
Comment Group (INVCommentGroup) 10 per message
Invoice Comment Record (INVCOMMENT) 1 per message
BILLTOACCTCMT X Bill To Acct Number String 1 9
DOCTYPCMT X Document Type String 1 6
INVNUMCMT X Invoice Number String 1 10
MESSAGETEXT1 Message Text Line 1 String 0 40
MESSAGETEXT2 Message Text Line 2 String 0 40
MESSAGETEXT3 Message Text Line 3 String 0 40
MESSAGETEXT4 Message Text Line 4 String 0 40
Detail Record (INVDETAIL) up to 200,000 per message
BILLTOACCTDET X Bill To Acct Number String 1 9
DOCTYPDET X Document Type String 1 6
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Field Name Description L;\:igth Lx]a;h
INVNUMDET Invoice Number String 1 10
ITEMNUM X Item Number (Our Item) Number (RO) |1 6
QTYSHIP X Quantity Shipped Number (R0O) |1 5
UNITPRICE X Unit Price Number (R2) |1 7
UOM X Unit of Measure String 1 4
CUSTPROCODE X Customer Product Code String 1 10
UPCCODE X UPC Code String 1 12
ITEMDESC Item Description String 0 30
VATCODE X VAT Rate Code String 1 2
TEMPVATRATE Temporary Storage VAT String 0 10

Percentage Rate
TEMPLEXC Temporary Line Extended Cost Number (R4) |0 14
Temporary Storage VAT Record (TEMPVATSTL) up to 10 per message
BILLTOACCTTS X Bill To Acct Number String 1 9
DOCTYPTS X Document Type String 1 6
INVNUMTS X Invoice Number String 1 10
SEQA Sequence Number of STL Number (RO) |0 10
VATRATE VAT Rate Number (R3) |0 6
VATRATECODE VAT Code String 0 1
NUMLINES Number of Lines for VAT Code Number (RO) | O 10
LVLA Line Subtotal Amount (Before Number (R2) |0 12
VAT)
VATA VAT Amount Payable Number (R2) |0 12
Summary Record (INVSUMMARY) 1 per message
BILLTOACCTSUM Bill To Acct Number String 1
DOCTYPSUM X Document Type String 1 6
INVNUMSUM X Invoice Number String 1 10
TOTALAMOUNT X Total Monetary Value Summary Number (R2) |1 10

The above table contains the minimum information necessary to define your
application file to Sterling Gentran:Director (name, mandatory status,
description, data type, and field length). Each record contains a group of
logically-related application fields. These fieldswill contain the information
that your system needs to generate the invoice.
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Each record (except the HEADER record, which is used for selecting the
appropriate trading relationship) contains athree-field record key that
ensures that the same identifying information is located at the beginning of
each record. Your application file format contains arecord key so that each
record can beidentified individually. The record key for thisinvoice consists
of your partner’s bill to account number, the document type, and the invoice
number. The records are defined as follows:

» TheHEADER (header) record contains the three-field key (partner
identifier, application identifier, and application alias value), which is
used for selecting the appropriate trading relationship. This header
record is mandatory and occurs once for each invoice tranglated.

e TheINVBEGIN (beginning) record contains the purchase order number
and date, the shipping address information, bill of lading number, ship
date, and terms information. The beginning record is mandatory and
occurs once for each invoice.

*  The INVCommentGroup (comment information) groups all the
comment information for the invoice, including the message text. The
INV CommentGroup is mandatory and occurs up to ten times per
invoice translated.

e TheINVCOMMENT (comment record) record contains the message
text. Thefirst comment record is mandatory and occurs once per invoice
translated (once for each comment line).

* TheINVDETAIL (detail) record contains line item number and
description, quantity shipped, unit of measure, price, product code, and
VAT calculation information. The detail record is mandatory and occurs
up to 200,000 times per invoice translated (once for each line item
invoiced).

e The TEMPVATSTL (temporary storage for VAT subtotals) record
contains temporary storage fields to enable VAT subtotal calculations.
The temporary storage record is conditional and occurs up to 20 times
per invoice translated (once for each possible VAT code subtotal).

* TheINVSUMMARY (summary) record contains the total invoice
amount. The summary record is mandatory and occurs once per invoice
trandlated.

Now that you have analysed your application file, the next step isto
determine the requirements of the invoice that you will send to your partner.

To analyse the EDI file, you must first determine what you need to send your
trading partner and what your partner expects to receive. You and your
partner will need to agree on which standard, version, and message you will
be using. In thistutorial, we are using a TRADACOMS version ANAQOL,
message INVOIC (invoice), release 9. It isimportant to know the
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information that your partner expects you to send within the invoice, and
what data will be contained in each element used.

It isvery helpful to review the EDI standard that you will be using before
analysing the EDI file. Obtain an EDI standard manual for the standard and
version that you will use. Standard manuals are available from EDI standard
agencies.

After discussing with your partner what you will send, determining which
segments and elements your partner requires, and reviewing the EDI
standard, you can list the map components that you will need to make
available for use (activate). When Sterling Gentran:Director generates the
EDI side(s) of the map, the system includes all the groups, segments,
composites, and elements that are defined by the standards agency for the
version of the message you selected. The system activates all the groups,
segments, composites, and elements that are defined as “ mandatory” (must
be present) by the standard. The system does not enable you to deactivate the
mandatory groups, segments, composites, and elements.

When tranglating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elementsthat are not defined as mandatory by the standard, but that you have
determined that you need to use in mapping.

For thistutorial, the map components that are required, but not currently
active, are the following (the composite column isinformational only, so you
will know where to locate the appropriate element):

Group Segment Group Segment Comp. Element

CLO CLOC CLO1

(already active)
CNAM

CADD CADO
CAD1
CAD2
CAD3
CAD4

PYT PAYT

PAYY PAY?2

DNA GNAR GNAO
GNA1
GNA2
GNA3
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Group Segment Group Segment Comp. Element
OoDD ODD:2 ORNO ORNO
(already active) ORN2

DELN DELO
DEL1
ILD ILD:2 SPRO SPR1
(already
active) CPRO CPR1
QTYI QTYO
CDO04:2

AUCT CD04:3

TDES TDEO

May 2011

When you activate a conditional group or segment, the
mandatory subordinate segments, composites, and
elements are automatically activated.

You will be invoicing one order only per INVOIC message. Therefore, you
will need to change the maximum usage for the |RF segment (Invoice
References), PYT segment (Settlement Terms), and ODD group (Order and
Delivery Terms and Invoice Line Details) to reflect the one order that you
areinvoicing.

Also, we recommend that you set up a Document Name for each map, to
make the identification of a message created by this map easier in Sterling
Gentran:Director. The Document Name allows you to differentiate between
messages in the document browsers in Sterling Gentran:Director.

To set up a Document Name, you must select an element or field that
contains data that will distinguish the messages translated by this map. Then,
the Name field of the document browsers that contain this message will
contain the data from the selected element or field. You can choose any
element or field as the Document Name, but we strongly recommend that
you select an element or field that occurs only once in the message and has a
data type of “String”. For an INVOIC, the document name istypically the
Invoice Number. Therefore, the document name for the import map in this
tutorial will be the invoice number.

After you complete the analysis of the EDI file and your application file
format, the final step in mapping analysisis correlating the two components.
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Reconciling Your When you translate data outbound, you need to build an import map and a

Application File systemimport map. The system import map is used by Sterling

and the EDI File Gentran:Director to find the partner relationship for a message and to
determine which import map will be used to trand ate the data. The system
import map builds the key that the translator uses to find the partner
relationship. The sole function of the system import map is to identify the
appropriate partner relationship; the system import map does not map any
data

There are two ways to build the key in a system import map: the six-field
key or the three-field key. You will have to decide whether you will be using
asix-field key or athree-field key for the header record for a system import
map. In thistutorial, you will use the three-field key.

The six-field key method requires six EDI-specific fieldsin the header
record: partner key, standard, version, message, release (for TRADACOMS
only), and test/production status. The combination of these six fields defines
aunique key that identifies the appropriate partner relationship. We
recommend using this method because it is very flexible. You will typically
use this method when you are defining your application from scratch and can
easily add the EDI-specific fields that are not already present in the header
record.

The second method (which you will use in thistutorial) is easier to build
because it only requires three fields in the header record (partner key,
application 1D, and application alias value). Please note that an empty string
isavalid valuein the application ID and application alias value fields. The
combination of these three fields defines a unique key that identifies the
appropriate partner relationship. However, because only three fields are
combined to build the key, this method is not as flexible as the preferred
method. You will typically use this method when you are using a legacy
(existing) application definition, and you do not want to add EDI-specific
information.

To reconcile your application filewith the EDI file, for each application field
you must determine which EDI element you need to popul ate with that
information, and how you can map that information to the EDI file. To map
information to an element, you can use linking, standard rules, extended
rules, or acombination of the three.

Linking (simple mapping) enables you to map afield or element from the
input side of the map to afield or element on the output side of the map. The
link between two map components (hereafter referred to asfields) isvisually
represented with aline connecting the two fields. Standard rules give you
access to functions that are necessary for mapping operations that are more
complex than simple linking, but less involved than extended rules.
Extended rules enable you to use a Sterling Gentran:Director proprietary
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programming language to perform virtually any mapping operation you
require.

We recommend that you determine which mapping operations will be
required on afield-by-field basis for your application file.

The following mapping operations (by application field) will be required for
the system import map in this tutorial:

Field Name Description Mapping

Operations

Header Record (HEADER) 1 per message

PARTNER_ID Partner Identifier Select standard rule to match the
EDI code in the Partner record
(Partner by EDI Code)

APPL_ID Application ID Update standard rule to update
the Application Field 1 on the
document record

APPL_ALIAS_ VALUE Application Alias Value Update standard rule to update
the Application Field 2 on the
document record

The following mapping operations (by application field) will be required for
the import map in this tutorial:

Field Name Description Ol\p/)lgfaptiiggs
Header Record (HEADER) 1 per message
PARTNER_ID Partner Identifier No mapping required
APPL_ID Application 1D No mapping required
APPL_ALIAS VALUE Application Alias Value No mapping required
Beginning Record (INVBEGIN) 1 per message
BILLTOACCTBEG Bill to Acct Number No mapping required
DOCTYPBEG Document Type No mapping required
INVNUMBEG Invoice Number Link to IRF INVN
INVDATE Invoice Date Link to IRF IVDT and IRF TXDT
PONUM Purchase Order Number Link to ODD:2 ORNO ORNO
PODATE Purchase Order Date Link to ODD:2 ORNO ORN2
SHIPTONAME Ship To Name Link to CLO CNAM
SHIPTOADD1 Ship To Address Line 1 Link to CLO CADD CADO
SHIPTOADD2 Ship To Address Line2 Link to CLO CADD CAD1
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Field Name

Description

Mapping

Operations

SHIPTOCITY

Ship To City

Link to CLO CADD CAD2

SHIPTOSTATE

Ship To State

Link to CLO CADD CAD3

SHIPTOPOSTALCODE

Ship To Postal Code

Link to CLO CADD CAD4

SHIPTOLOC Ship To Store Location Link to CLO CLOC CLO1
BOLNUM Bill of Lading Number Link to ODD:2 DELN DELO
SHIPDATE Ship Date Link to ODD:2 DELN DEL1
TERMSNETDUE Terms New Due Days Link to PYT PAYY PAY2
TERMSTEXT Payment Terms Text Link to PYT PAYT
Comment Group (INVCommentGroup) 10 per message
Invoice Comment Record (INVCOMMENT) 1 per message

BILLTOACCTCMT

Bill To Acct Number

No mapping required

DOCTYPCMT Document Type No mapping required
INVNUMCMT Invoice Number No mapping required
MESSAGETEXT1 Message Text Line 1 Link to DNA GNAR GNAO
MESSAGETEXT2 Message Text Line 2 Link to DNA GNAR GNA1
MESSAGETEXTS3 Message Text Line 3 Link to DNA GNAR GNA2
MESSAGETEXT4 Message Text Line 4 Link to DNA GNAR GNA3

Detail Re

cord (INVDETAIL) up to 200,000 per

message

BILLTOACCTDET

Bill To Acct Number

No mapping required

DOCTYPDET Document Type No mapping required

INVNUMDET Invoice Number No mapping required

ITEMNUM Item Number (Our Item) Link to ILD:2 SEQB

QTYSHIP Quantity Shipped Link to ILD:2 QTYI QTYO0 and use
accum standard rule to calculate
extended price

UNITPRICE Unit Price Link to ILD:2 AUCT AUCO and
use accum standard rule to
calculate extended price

uoMm Unit of Measure Link to ILD:2 QTYI CD04:2 and
ILD:2 AUCT CDO04:3

CUSTPROCODE Customer Product Code Link to ILD:2 CPRO CPR1

UPCCODE UPC Code Link to ILD:2 SPRO SPR1

ITEMDESC Item Description Link to ILD:2 TDES TDEO
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Field Name Description Mappl_ng
Operations
VATCODE VAT Rate Code Extract Division lookup from
subtable “WATCODES" and Link to
ILD:2 CD12
TEMPVATRATE Temporary Storage VAT Standard rule to map Division
Percentage Rate lookup from subtable
“VATCODES”
TEMPLEXC Temporary Line Extended Cost Use accum to extract extended
price and Link to ILD:2 LEXC
Temporary Storage VAT Record (TEMPVATSTL) up to 10 per message
BILLTOACCTTS Bill To Acct Number No mapping required
DOCTYPTS Document Type No mapping required
INVNUMTS Invoice Number No mapping required
SEQA Sequence Number of STL Link to STL SEQA:7
VATRATE VAT Rate Link to STL VATP:2
VATRATECODE VAT Code Link to STL CD12:2
NUMLINES Number of Lines for VAT Code Link to STL NRIL
LVLA Line Subtotal Amount (Before VAT) | Link to STL LVLA, STL EVLA, and
STL ASDA
VATA VAT Amount Payable Link to STL VATA
Summary Record (INVSUMMARY) 1 per message
BILLTOACCTSUM Bill To Acct Number No mapping required
DOCTYPSUM Document Type No mapping required
INVNUMSUM Invoice Number No mapping required
TOTALAMOUNT Total Monetary Value Summary Link to TLR TPSI

To calculate the required VAT subtotals, summary, and invoice amount you
will need to use extended rules on the INPUT group (application file) and on
certain elements on the EDI side of the map. These extended rules will be
explained in detail later in thistutorial. You will also use a combination of
standard rules (accumulators) and direct mapping to complete the required
calculations.

You will need to use a code table to look up datafor the map. If you need to
use tables, you must decide whether to create a code table in Sterling
Gentran:Director that can only be used with this map, or to add the table to
either the partner relationship or theinterna system partner in Partner Editor.
You will set up thetable you usein thistutorial under the internal system
partner (<Internal System User>) so it can be used globally.
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In this tutorial, you need to extract information from alookup table to be
inserted into the outbound data. A lookup table is used when you want to
supplement data before it is sent to your partner. Please see the IBM®
Serling Gentran: Director® Release 5.5 User Guide for more information
on lookup tables.

You do not need to create thislookup table
(INVATCO.LKP). It isincluded with the tutorial data
that is provided when you install Serling
Gentran:Director.

After you finish correlating your application file and EDI file on paper, you
can begin creating the system import and import maps.
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Creating the System Import Map

For outbound translation, you will need to set up a system import map and
an import map. Generally, you will create one system import map for each
message type, and set up an import map for each partner to whom you are
sending messages.

A system import map is used by the system to find the partner relationship
for amessage (flat file definition), to determine which import map will be
used to trandate the data. The system import map builds the key that the
translator uses to find the partner relationship. The sole function of the
system import map is to identify the appropriate partner relationship; the
system import map does not map any data.

There are two ways to build the key in a system import map. The six-field
key method requires six EDI-specific fieldsin the header record: partner key,
standard, version, message, release (for TRADACOMS only), and test/
production status. The combination of these six fields defines a unique key
that identifies the appropriate partner relationship. We recommend using this
method because it is very flexible. You will typically use this method when
you are defining your application from scratch and can easily add the EDI-
specific fields that are not already present in the header record. You will not
be using the six-field key method for this tutorial, but you can refer to the
IBM® Serling Gentran: Director® Release 5.5 User Guide for more
information about this method.

The second method is easier to build because it only requires threefieldsin
the header record (partner key, application 1D, and application alias value).
Please note that an empty string isavalid value in the application ID and
application alias value fields. The combination of these threefields definesa
unique key that identifies the appropriate partner relationship. However,
because only three fields are combining to build the key, this method is not
asflexible as the preferred method. You will typically use this method when
you are using alegacy (existing) application definition, and you do not want
to add EDI-specific information. Since we are providing an application file,
you will be using the three-field key in this tutorial.
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Complete the following steps to create the system import map:

1. Select New from the File menu to create anew map. The Create New
Translation Object dialogue is displayed.

Create Hew Translation Object
Function ||mp0[l j
ata Saunse I ﬂ Cancel |
— Input Farmat

Type Iﬂ I Wee Standand:
SOERCY I j
TSIt I j
Tramsactong I j
Helease I 'I

— Dutput Format

Type I Vl = lse Standard:

LaEncy I j
Version | =
Tiransaction, | =
Fielease Iﬂ

2. From the Tranglation Object Function drop-down list box, select
“System Import”.

From the Input Format Type drop-down list box, select “Positiona”.

4. From the Output Format Type drop-down list box, select “Positiona”.
The system will actually ignore the Output side of the map and only
process the Input side.

5. Click OK to create the new system import map (this may take afew
seconds). The new map will be displayed in the Sterling
Gentran:Director - Application Integration Window.

After you create the new map, it isimportant to define the details of the
map and save it.

We recommend that you save your maps as often as
possible, to mitigate the possible loss of additions or
modificationsin the event of a hardware or system
error.
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6.

Select Save from the File menu to display the Trandation Object Details
diaogue.
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7. Inthe Author field, type your name. Thisfield typically contains the
name of the person who created the map.

8. Inthe Description field, type“ System Import HDR”. For system import
maps, we recommend that you type“ System Import *”, where“*” isthe
identifier for this system import map. The Imports tab of the System
Configuration program describes which system import trandation
object will be used to begin transl ation during the import process. Please
see the IBM® Serling Gentran: Director® Release 5.5 Administration
Guide for more information about how your system administrator will
need to modify the system configuration program.

9. Verify that the Translation Object Function drop-down list box contains
“System Import”.

10. Complete the Major and Minor fields to designate a version number for
thistranslation object. Type“1” asthe version number inthe Mgjor field
and accept the “0" as the release number in the Minor field.

Whenever any major changes are madeto your map,
increase the version to the next real number (e.g., 2.0,
3.0). If you make a minor change to the map, increase
the version by a percentage point (e.g., 2.1, 2.2).
11. Thelnput and Output fields (Agency, Version, Transaction, Release, and

F Group) contain information only if the Input and/or Output sides of
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the map are of EDI format. For the tutorial, do not change the

information in these fields.

Thesystem allowsyou to changetheinformation in the
Input and Output fields, but modifying this
information will not alter the content of the map. An
example of when you may wish to alter thesefieldsisif
you want the map to reflect a standard version that is
not loaded on your system. You can changethe version
on thisdialogue, and then physically alter the map to
be compliant with that version.

The Tranglation Object Details dialogue should now look like this:

e |
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12. Click OK to save the translation object details and access the Save As
diaogue.

Save As |

Save in: IEMGDS j ﬁl F =

Pet_girw.map
Pet_eord.map
Pet_tord.map

File name:  [SEMTRA&N1.map

Save as lype: IMaps [*.map] ﬂ Cancel |

13. The“Savein” drop-down list box should reflect the drive\folder where
Sterling Gentran:Director isinstalled. The default is GENTRAN
Director\Maps. If the current subfolder is not the correct one, select the
appropriate subfolder. We recommend that you store maps in the map
folder where Sterling Gentran:Director isinstalled.

14. Inthe“File name” field, type “HEADER_T.MAP” as the name of the
map. You allocate a filename to a map when you save the map for the
first time or use the Save As function to save a copy of the map under a
different name. The name of the map must be one to eight unique
characters that define the map in a meaningful way. The default file
extensionis“.MAP’. Using this extension distinguishes map files from
other types of files, such as translation objects. The naming conventions
in Sterling Gentran:Director are as follows:

The source map (map created in Sterling Gentran:Director) should
be named using the file extension . MAP (e.g., HEADER_T.MAP).

The compiled translation object (trandlation object that is the result
of compiling the source map) should be named using the same
filename that was allocated to the source map, but with thefile
extension .TPL (e.g., HEADER_T.TPL).

We recommend that you use these naming conventions to distinguish
source maps and compiled translation objects from other types of files.
We also recommend that you use the same filename (different file
extension) for a source map and the translation object that was compiled
from it.
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Be very careful not to overlay the source map with the
” compiled translation object. Usethe.TPL fileextension

to distinguish the translation object.
15. Click SAVE to save the map.

After you complete each section of thistutorial or when
you make any changesto the map, you should savethe
map by selecting Save from the File menu.

After creating the system import map, you need to define the header
record for the system import map. You will use the three-field key in
thistutorial.

Creating the

HEADER Record Theonly record that you will define for the system import map is the header
record. The header record will be subordinate to the icon on the input side of
the map.

The HEADER (header) record contains the three fields that comprise the
system import map key. This header record is mandatory and occurs only
once.

Complete the following steps to create the header record (HEADER):

1. Click the Positional Fileicon on theinput side of the map, to highlight
it. Select Create Sub from the Edit menu. Select Record from the
cascading menu.
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The Positional Record Properties dialogue is displayed.
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2. Inthe Namefield, type “HEADER” as the record identification code.

Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.

3. IntheDescfield, type“Header Record” asthe description of the record.
Thisfield is used to provide a brief explanation of the record that will
enable you to differentiate it from similar records.

4. IntheTagfield, type “HDR” astherecord identification code <TAG>.
For example, arecord is recognised by the system as the following:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognise that
record and then determine the mapping requirements.

%

You must define therecord tag on the Positional
Record Propertiesdialogue for outbound maps,

instead of defining fieldswith the purpose of explicitly
containing therecord tag.

5. Inthe Position field, accept the default of “1” for the starting column
position of the tag in the data record.
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6. IntheMin Usagefield, type“1” to make the header record mandatory.
Thisis the minimum number of times the record must repeat.

If theMin Usagefield contains“0” (zero), therecord is
conditional. If the Min Usage field contains“1” or

greater, therecord ismandatory.

The Positional Record Properties dialogue should now ook like this:
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7. Click OKto create the HEADER record.
Now you have to define the three fields that make up the system import key.

Creating the

HEADER Fields To usethe preferred method of building the system import key, you need to
define three fields for the header record (partner key, application identifier,
and application alias value). These fields do not have to bein any order or
sequence, but they must be part of the header record.

After you define the header record and fields, you can set up the mapping
operations that will define the key that the translator uses to find the partner

relationship.

The easiest way to add fields to arecord isto use the Positional Field Editor.
Thefieldsthat you need to create are listed in the following table. The name,
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mandatory status, description, datatype, and field length for each field are

listed in the table.
Field Name Description TDyagz L;\:igth Lx]a;h
Header Record (HEADER) 1 per message
PARTNER_ID X Partner Identifier String 1 9
APPL_ID Application ID String 0 6
APPL_ALIAS_VALUE Application Alias Value String 0 6

Complete the following steps to create the fields for the HEADER record:

1. Click the HEADER record with the right mouse button to access the
shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialogue.

Fozitionol Ficld Edior

Hecord

_EIK
Name= HEADER Tagp HDA Teo Pos 1
| Cancsl I
rField O alaiz
MHame I r bl ard atany
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3. Thefield you are creating isthefirst field in the record, so click NEWA
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details
section.
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4.

In the Name field, type “PARTNER_ID”, which isthe name of the first
field in the HEADER record. Each field must have a unique name.

Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.

10.

11

Click the Mandatory check box to identify it asarequired field. For the
system import map, each field in the key is mandatory.

In the Description field, type “Partner Identifier” as the description of
the field. The description is used to provide a brief explanation of the
field that will allow you to differentiate it from similar fields.

From the Data Type drop-down list box, select “ String” as the type of
the field, to specify that this field must contain alphanumeric data.

Q If you wanted to indicate the exact position of the field

in the record, you would type the starting position of
thefield in the Sart Posfield. You will want to specify
field start positionsif, for example, you will only be
using a few fields but you want them positioned exactly
in therecord.

In thistutorial, you will usethe alternative to
specifying the start position of each field; you will add
thefields sequentially in therecord and then usethe
Auto Position function. Please see step 12 below for
mor e information on the Auto Position function.

In the Min Length field, type “1” as the minimum field length.
In the Max Length field, type“9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify will be
positioned below the field.

Create the rest of the fields according to the record layout table on
page 119.

12. After you add the last field, click AUTOPCSI TI ON to automatically

position the fields in the record. The Auto Position function will
automatically calculate the start position in the record of each field
based on the criteriathat each field is positioned directly after the
previous field and is of the length specified in the Max Length field.
Click YES to acknowledge the warning message that fields will be
sequenced in order.
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Please notethat it isonly valid to usethe Auto Position
function if you define arecord tag on the Positional
Record Propertiesdialogue, and if you define every

field in therecord in the sequencethat each field
occurs (asyou are doing in thistutorial).

The Positional Field Editor dialogue should now ook like the
following:
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13. When you are finished adding fields to the HEADER record, click
CLOSE.

Defining the Key , . .
After you define the header record and fields, you can set up the mapping

operations that will define the key that the trandator uses to find the partner
relationship.

Defining the  Complete the following steps to define the partner key:
Partner Key 1. Double-click the HEADER record to display the fields you just created.
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2. Double-click the PARTNER _ID field to display the Field Properties

dialogue.
1z ["opoitics
— IF'.E\HT HEF,_ID
Descripian — { Pty |dentifer
ala Waidation Bdvancad =
Mn  Maz T Fremat
W Mandalom |'| Ig I;::g H IN
Preesition

3. If the Advanced section of the dialogueis not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

4. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Verify that the Select radio button is selected.

From the Table drop-down list box, select “Partner by EDI Code” (you
could also select “ Partner by Alternate code”, or “ Partner by Partner
Key”). Thisindicates that the system will look up the indicated partner
key in the partner database and update thisfield.

The Advanced section of the Field Properties dial ogue should now look
likethis:

rbdvancad

[¥ Usa Standaid e
(& Seledd ) Updaba ) Constant € Lsa dccum O Loop Counk ) Uaa Coda

Tab |Partrer by EDI code B [ Erclusive

Sub Tabls |

Map From Map Ta

Name
Ed Cod=
Alternate Coda

v | [+] [ [=]

7. Click OK to add the standard rule to the partner key field.
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Defining the  Complete the following steps to define the application 1D field:

Application ID 4 = b6 dlick the application ID field to display the Field Properties
Field diaogue.
I izid |'opoatizs
P IﬁF'F"L_ID
D escriplion Iﬁppi:ath o
ala ¥ aidation

rr Mendalons [0 [6 [swig 2] [ Coediliore. .

ki Max  Tppe Format

7.

If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Update radio button.

From the Table/Key drop-down list box, choose “ Document record”.
Thisindicates that you wish to store an item of datain the Sterling
Gentran:Director tracking database for the document.

From the Field drop-down list box, choose “Application Field 1”. This
indicates that you are updating the first application field in the system
buffer.

The Advanced section should now look like this:

rAdvanoed

[*¥ Uze Slandsrd Fule
! Baleol M Update ) Conelanl ) Uza dccum O Loop Court ) Usza Code

TabkeXep | Document recomd |£I

Fisld | tppicalion Fied 1 (2]

Click OK to add the standard rule to the application ID field.
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Defining the Complete the following steps to define the application alias value field:

Application Alias
Value Field

1

Double-click the application alias value field to display the Field
Properties dialogue.

izl 'opoitics

E]

L' e=criplion

IﬁF'H__N_I.&E_‘rfﬁLUE

Iﬁppicai:n Bliz= Value Canc=|

ala* aidetion

[ Mandalog |n IE farrg 2] [#

kv Max  Tppe Format
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If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Update radio button.

From the Table/Key drop-down list box, choose “ Document record” .
Thisindicates that you wish to store an item of datain the Sterling
Gentran:Director tracking database for the document.

From the Field drop-down list box, choose “ Application Field 2". This
indicates that you are updating the second application field in the system
buffer.

The Advanced section should now look like this:

dverced

[¥ Use Slandsrd Rule
! ool M Update ) Conelanl ) Uza dccum ©) Loop Court ) Usza Code

TabkeX.ep | Docurment recand |£I

Field |.'1‘-u|:-icalim Fiakd 2 H

7. Click OK to add the standard rule to the application alias value field.
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Compiling the
Map

May 2011

The Compile function compiles the map and generates a translation object.
The map that you created using Sterling Gentran:Director
(HEADER_T.MAP) isasource map. When that source map is compiled, the
result isa compiled translation object.

You must register this tranglation object with the Sterling Gentran:Director
system before you can useit. You will use the Compile function after the
map is completed and saved.

Complete the following steps to compile a map and generate atranslation
object:

1. Select Save from the File menu to save the source map, prior to using
the Compile function.

2. Select Compile from the File menu to display the Run-Time Translation
Object Name dialogue.

Run-Time Translation Object Hame |
Savein | 3 Transilbi =l & = e =

File name: |Header_t.TF'L

Save as hpe: |T[anslatiun Objects [*.TPL) j Cancel |

3. The“Filename’ field will automatically contain “header_t.tpl”. Thisis
the name of the trandation object, using the default . TPL file extension
and our recommendation that you name the translation object (. TPL
file) the same filename (one to eight characters long) as you named the
map (.MAP file). Preserving the same filename (with different file
extensions) means that the relationship between the source map and the
compiled transation object will remain evident.

Bevery careful not to overlay the source map with the
compiled translation object. Usethe . TPL fileextension

to distinguish thetranslation object.
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4. Changethe Drive and Folder where the compiled translation object will

be stored, if necessary.

5. Click SAVE and the system will compile the map and generate a
trand ation object. The Compile Error dialogue is displayed. Verify that
no errors occurred and click OK to exit the dialogue.

The date on which the translation object was compiled will be
automatically loaded into the Compiled on field on the Trandlation
Object Details dialogue.

I ranzlatien Ubgoct Wrolails

rSummmy
Aukhor Diezciiption Traredation Object Function Bpetem
Stedi 5 pelem Impat HOR Sytam Impcr| | C
rg | [Spsien impo {3 pcr 2] [ Corcel |
Memon Conbd

Major walgion I'I_ Minar version IEI_

Compiled o | Z3Eap-1936

EDI Associalions

Output

Irput
I
Yeremn I I
Tram=achon I I
Aelemrs I_
F Group I I

6. Select Save from the File menu to save the source map with the

Compiled on date.

7. You must register this translation object with the Sterling
Gentran:Director system before you can use it. See the Sterling
Gentran:Director documentation for information on registering a

trandlation object.

Printing the

Report The Sterling Gentran:Director report enables you to validate and review the
map, and make modifications as needed. If you review the report and
determine that the map is incorrect, you should refine the mapping process
as many times as necessary (make the modifications, save the map,

recompile the trandlation object, and print the report again).
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Complete the following steps to print the Sterling Gentran:Director report:

1. Select Print from the File menu to access the Print Options dialogue.

— Repart zections

¥ Frint branching diagram - 2
¥ Print record details Cancel |
¥ Print mapping details
¥ Prirt extended rules

¥ Print code lists

¥ Include only active objects

2. Accept the defaults on this dialogue (all options checked), so the report
will include all sections and only the activated map components. Click
OK and the Print dialogue is displayed.

3. Set the appropriate options. Click OK if you do not need to change
Setup options, and the mapping report will be printed.

Click SETUP... if you need to access printer setup information (to select
a specific printer, paper orientation, or size and source of paper). The
Print Setup dialogueis displayed.

4. Set the appropriate options. Click OK if you do not need to change Print
Options (dithering, intensity control, or print true type as graphics), and
you will return to the Print dialogue. Click OK on the Print dialogue and
the mapping report will be printed.

Click OPTI ONS... if you need to access printer setup options
information. The Options dialogue is displayed.

5. Set the appropriate options. Click OK to return to the Print Setup
dialogue. Click OK on the Print Setup dialogue to return to the Print
dialogue. Click OK on the Print dialogue and the mapping report will be
printed.

After you compile the map, print and verify the report, and register the
tranglation object with Sterling Gentran:Director, you should test the
tranglation object to verify that the datais translated correctly. You will test
the system import translation object (HEADER_T.TPL) when you test the
import map (please see page 213).
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Creating the Import Map

Thefirst task in creating a new map is to define the format that will be used
for the input and output sides of the map. In this example, you are creating
an import map so Sterling Gentran:Director can translate your application
file to an invoice that you are sending to your partner. Therefore, the input
side of the map needs to reflect your application file. The output side of the
map needs to reflect the TRADACOMS ANAOO1 invoice (INVOIC) that
you will send to your partner. Instead of defining the INV OIC messageto the
system yourself, you want Sterling Gentran: Director to use the standards
database on your system to build the invoice according to the standard.

Complete the following steps to create the import map for the outbound

invoice:
1. Select New from the File menu to display the Create New Translation
Object dialogue.
Create New Translation Object
Function ||mp0,t
oarans o e |
Type Iﬁ 7| sz Standard
EEEnEy I j
 ETSI I j
=i I j
ElEass Iﬂ
r~ Output Forrat
Type I - I I | e Stardard:
Agemty I j
Y ErSien I j
Tiratisachion I j
Felease Iﬁ

2. Inthe Tranglation Object Function drop-down list box, accept the
default of “Import”.

Complete the Input Format section of the dialogue. Thisisthe format of
the datathat will be trandated by the Sterling Gentran:Director system.

3.  Fromthe (Input Format) Type drop-down list box, select “Positiona” as
the type of format for the output data. Sterling Gentran:Director usesthe
term “positional” to describe any flat file that you create.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 129



Creating the Import Map Outbound Invoice (INVOIC)

Now you need to complete the Output Format section of the dialogue.

4. From the (Output Format) Type drop-down list box, select “EDI” asthe
type of format for the output data.

5. Click the Use Standards check box, because you selected “EDI” in the
Type field and because you want the system to use the standards
database on your system to build the invoice according to the standard.

6. To select adata source name from which Application Integration will
access EDI standards, select one from the Data Source drop-down list
box. This DSN will be prompted the next time you create a map.

7. From the Agency drop-down list box, select “[A] Tradacoms” as the
EDI standard you will be using for the input side of the map.

8. From the Version drop-down list box, select “[ANAOOL]
TRADACOMS UNITED KINGDOM" as the version of the standard
you will use. The versions that are available depend on which standard
you selected.

9. From the Transaction drop-down list box, select “[INVOIC] INVOICE
DETAILS’ asthetransaction set (message) you will use. The
transactions that are available depend on which standard and version
you selected.

10. From the Release drop-down list box, select “9” asthe message version
you will use. The message versions that are available depend on which
message (transaction) you selected.
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The Create New Tranglation Object dialogue should now look like this:

Create Hew Translation Object
Function [Import R T
Drata Source IGENTHAN Standards j Eamecl |
— Input Format

Tupe IF'ositionaI VI [ Wee Standard:

SEEnGCY I j
Y ETSIEr I j
UE=ir =il I j

Eelease I 'I

— Dutput Format
Type Iﬂ ¥ Use Standard:
Agercy I [&] Tradacoms j
Yersian | [4HADT1] TRADACOMS UNITED KINC 7
Transaction | [INVOIC] INVOICE DETAILS =l

Relaase IS 'I

11. Click OK to generate the new map (this may take afew seconds). The
new map will be displayed in the Sterling Gentran:Director -
Application Integration Window.

#" GENTRAM:Director - Application Integration - INVOIC
File Edit Functions Yiew Options Window Help

D|=|d| &) =] =|E0km] sz oo e o

2 INVOIC M= B3
& INFUT - N INVOIC M- INVOICE DETAILS £ -]

CLO M- 1 CUSTOMER'S LOCATION
IRF -t-1 INVOICE REFEREMNCES

00D -k- 933339 G
393 VAT RATE INVOICE SUB TRAILER
TLR -M- 1 INVOICE TRAILER

- .
«| | » 1 I 4

Far Help, press F1 4
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12.

After you create a new map, it isimportant to define the details of the
map and save it. The Save function writes (saves) the map with current
focusto disk.

Q We recommend that you save your maps as often as

possible, to mitigate the possible loss of additions or
modificationsin the event of a hardware or system
error.

Select Save from the File menu to display the Trandlation Object Details
dialogue.

Trarilalion Mlgeed Melails

rSummey
by kher Diezcliption Traredation Object Function Spetem
Impait 3| C
I I s |—I | LCancel I
Mermon Conbd

Major walgion IEI Minar version IEI D:rnpila-:iml

EDl Associaliohs

Irput Output
hgancp I_ I F ITrad.an:Im
Yexsin | | [a001 | TRADACOMS LINIT
Tramsaction | | ||Nv1:|||: |INUIIIIIDE DETAILS
Feleees I IEI
F Group | | ||Nv1:|||: |

13. Inthe Author field, type your name. Thisfield typically contains the
name of the person who created the map.

14. Inthe Description field, type “PET ANAQOL1 9 INVOIC Import”. This
field must be unique because it is used by the system to identify the
map. We recommend that you use the following identifying
characteristics: the partner that thismap is used for, the standard, the
version, the type of transaction this map uses, and the direction of the
map (e.g., Import, Export, etc.). For example, “PET ANAQOO0L 9
INVOIC Import” isthe description of amap used with partner Pet Zone,
for aTRADACOMS version ANAQOOL invoice (INVOIC) (release 9),
that is sent outbound (Import).

15. Verify that the type of map shown in the Translation Object Function

drop-down list box is*“Import”.
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16. Complete the Major and Minor fields to designate a version number for
thistranslation object. Type“1” asthe version number inthe Mgjor field
and accept the “0" as the release number in the Minor field.

%

Whenever any major changes are made to your map,
increase the version to the next real number (e.g., 2.0,
3.0). If you make a minor change to the map, increase
the version by a percentage point (e.g., 2.1, 2.2).

17. Thelnput and Output fields (Agency, Version, Transaction, Release, and
F Group) contain information only if the Input and/or Output sides of
the map are of EDI format. For the tutorial, do not change the
information in these fields.

%

Thesystem allowsyou to changetheinformation in the
Input and Output fields, but modifying this
information will not alter the content of the map. An
example of when you may wish to alter thesefieldsisif
you want the map to reflect a standard version that is
not loaded on your system. You can changethe version
on thisdialogue, and then physically alter the map to
be compliant with that version.

The Translation Object Details dialogue should now look like this:

Aukhor Deiciiption Trarelation Object Furction Eetenn
Stadi Ahlaon 3IMYOIC Import | Impoit | C
< I F I F |—I | Cancel I
Mermon Contol

Major walgich I'I Minar verzion IEI Empila-dml

EDI Associalioes

Irput DOutput

——

F ITrad.an:Im

Yerzon I

| |mm:m |rﬂmm:|:|h15 UMIT

Tram=achon I

Aeleses I_

| ||an||: ||Nunlt£ DETAILS

o

F Group I

| ||Nv1:|||: |

18. Click OK to save the translation object details and access the Save As
dialogue.
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19.

20.

The “Savein” drop-down list box should reflect the drive\folder where
Sterling Gentran:Director isinstalled. The default is GENTRAN
Director\Maps. If the current subfolder is not the correct one, select the
appropriate subfolder.

Inthe“File name” field, type “PET_TINV.MAP’ as the name of the
map. You allocate a filename to a map when you save the map for the
first time or use the Save Asfunction to save a copy of the map under a
different name. The name of the map must be one to eight unique
characters that define the map in a meaningful way. For example,
“PET_TINV.MAP” isthe name of amap for an TRADACOMS invoice
(INVOIC) for partner Pet Zone.

The default file extension for mapsis.MAP. Using this extension
distinguishes map files from other types of files, such astrandation
objects. The naming conventions in Sterling Gentran:Director are as
follows:

*  The source map (map created in Sterling Gentran:Director) should
be named using the file extension .M AP (e.g., PET_TINV.MAP).

»  The compiled translation object (trandlation object that is the result
of compiling the source map) should be hamed using the same
filename that was allocated to the source map, but with thefile
extension .TPL (e.g., PET_TINV.TPL).

We recommend that you use these naming conventions to distinguish
source maps and compiled translation objects from other types of files.
We also recommend that you use the same filename (different file
extension) for a source map and the tranglation object that was compiled
fromit.

Be very careful not to overlay the source map with the
compiled trandation object. Usethe . TPL fileextension

to distinguish the translation object.
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Activating EDI
Map
Components
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The Save As dialogue should now look like this:

Save As

Save in:

Ia b aps

Creating the Import Map

GENTRANT.map
Header_t.map
Pet_einv.map
Pet_eard. map
Pet_tord.map

File name: |PET_TINV.MAF‘

j Cancel |

Save as lwpe: |Maps [*.map)

21. Click SAVE to save the map.

%

After you complete each section of thistutorial or when
you make any changesto the map, you should savethe
map by selecting Save from the File menu.

Now that you have finished creating and saving the new Import map, you

need to define the Input and Output sides of the map.

The map components for an EDI File are the following:

EDI File

Segment

Loop (Group)
Composite Element
Element

« haga

The map components for a Positional File are the following:

Positiona File
Record

Loop (Group)
Field

Q@

The specific EDI map components that you use depends on the type of map

you are creating, the standard, version, and transaction set (message)
selected, and which segments and el ements your company requires. We
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recommend that you determine what segments and elements you will use
before starting this step.

When Sterling Gentran:Director generates the EDI side(s) of the map, the
system includes all the groups, segments, composites, and elements that are
defined by the standards agency for the version of the message you selected.
The system activates all the groups, segments, composites, and el ements that
are defined as “mandatory” (must be present) by the standard. The system
does not enable you to deactivate the mandatory groups, segments,
composites, and elements. By default, Sterling Gentran:Director displays
active map components with a black fount, and inactive map components
with agrey fount (dimmed). In the example below, the ORDHDR group,
TYP segment, SDT segment, and the SIDN composite are mandatory, so
they are already activated by the system. You also need to usethe SDT SIDN
SIDO element (a conditional element), so you will need to activate it.

ETORCHDA M- 1 DROEA FILE HEADER
TYF -M-1 TRAMSACTION TYPE DETAILS
50T M- 1 SUFPLIER DETAILS
22 SIDN M.
a

E:

=
LY
L

When tranglating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elementsthat are not defined as mandatory by the standard, but that you have
determined that you need to use in mapping.

Complete the following steps to activate the required conditional segments
and elements:

1. Double-click the groups, segments, and compositesthat are listed in the
table below to open them. These are the segments and elements that you
will need to activate. The composite (Comp.) column is provided for
your information, so you will know where to locate the appropriate
element(s).
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Opening all the necessary groups, segments, and composites before you
start to activate allows you to scroll down the map and activate the
segments and elements sequentially.

Group Segment Group Segment Comp. Element

CLO CLOC CLO1

(already active)
CNAM

CADD CADO
CAD1
CAD2
CAD3
CAD4

PYT PAYT

PAYY PAY?2

DNA GNAR GNAO
GNA1l
GNA2
GNA3
ODD ODD:2 ORNO ORNO
(already active) ORN2
DELN DELO
DEL1
ILD ILD:2 SPRO SPR1
(already
active) CPRO CPR1
QTYI QTYO
CDO04:2

AUCT CDO04:3

TDES TDEO

When you activate a group or segment, the mandatory
subordinate segments and elements are automatically
activated.

2. Click the Activate button on the Main Toolbar.

3. Click each inactive segment that you need to use. Thiswill activate the
segments.
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If you accidentally click a segment that you did not
” mean to activate, click the segment with theright

mouse button to access the shortcut menu. Select
Deactivate from the shortcut menu.

4. Click each inactive element that you need to use. Thiswill activate the
elements.

If you accidentally click an element that you did not
mean to activate, click the element with theright
mouse button to access the shortcut menu. Select
Deactivate from the shortcut menu.

5. After you activate al the necessary groups, segments, and elements,
click the Activate button on the Main Toolbar to turn activation mode
off.

Verifying EDI

Delimiters If you are using an EDI standard that contains composite elements or sub-
elements, you must verify that Sterling Gentran:Director is specifying the
correct delimiters. Delimiters are flags that you define to the system as
separating specific EDI components. Delimiters are necessary for all
variable field-length standards, because the datais compressed (and the
leading zeroes and trailing blanks are removed). Since the fields vary in
length, the system needs a flag to determine where one element ends and
another begins. For example, an element delimiter marks the beginning of a
new element.

Although verifying EDI delimitersin Serling

@ Gentran:Director ismandatory only if you areusing a
standard with composite elements or sub-elements, we
recommend that perform thistask regardless of which
standard you use.

Complete the following steps to verify EDI delimiters:

1. Click theINVOIC INVOICE DETAILSfile icon with the right mouse
button to access the shortcut menu.
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Select Properties... from the shortcut menu to display the EDI File
Format Properties dialogue.

0l File Dinmal Pogeealiees

Neme |IH¥OIC Dz |INVOICE DETAILS il

[ Stizam s=gmente
oo

b S pecify defaulla [ Dasgnbzsiecord [

Tag O ehriter -
Elemrent Delmiter +

Seament Delmiter Ii
Sub Elernert Delraker |
Rale=za Chalactal 3

[ecmal Sepaalor .

ALl

2. Inthe EDI Syntax section, verify that the Specify defaults check box is
selected.

3. Verify therequired delimiters for the TRADACOMS standard. If the
delimiters differ from the defaultsin the table bel ow, type either the
character or the hexadecimal value in the correct field. The default
delimiters for TRADACOMS are the following:

TRADACOMS TRADACOMS
Default Hex
Default Character
Value
Tag Delimiter = (equal) 0x3D
Element Delimiter + (plus) 0x2B
Segment Delimiter ' (single quote) 0x27
Sub Element Delimiter : (colon) Ox3A
Release Character ? (question mark) Ox3F
Decimal Separator . (full stop) O0x2E

4. Click OK to exit the EDI File Format Properties dialogue.

Now you can define your application file layout to Sterling
Gentran:Director.
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Copying the

HEADER Record

140

At this point, you have already defined the header record (in the system
import map) that you can copy and use in your import map. Now you must
define the rest of your application file to Sterling Gentran:Director. In the
import map, the input side of the map is positional. Your application file
must contain all the information that you need to generate the EDI message
that you will send to your partner, so that your system can accurately process
the data.

Before you define your application file format, you should obtain alayout of
the necessary records, fields, and groups. The records will contain related
fields and the groups will contain related records. Each level of your
application file format must be created sequentially.

For example, your application file format contains records and groups. The
records contain fields and the group contains records. Therefore, you must
create records and the group before you create the subordinate fields and
records.

Since you have aready defined the header record for your application file
format in the system import map, you can copy that header record to the
import map. The copied record contains subordinate fields, which will also
be copied. Copied map components retain all the information of the original
map component, so you will need to remove the standard rules you created
for the fields in the header record for the system import map.

Complete the following steps to copy the HEADER record from the system
import map to the import map:

1. Openthe HEADER.MAP system import map, if it is not already open.
2. Highlight the HEADER record.

3. Click Copy on the Main Toolbar.

4. Openthe PET_TINV.MAP import map, if it is not already open.

5

Highlight the INPUT positiona file icon that you want the copied
record pasted after.

6. Click Paste on the Main Toolbar to paste the contents of the Clipboard.

May 2011

The HEADER record is pasted as a subordinate map component to the
INPUT positional file icon.
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Removing the The HEADER record that you just copied from the system import map
HEADER Standard containsfivefields. Thefirst field (PARTNER_ID) has a Select standard
Rules ruleapplied to it in the system import map. The remaining two fieldsin the
copied HEADER record in the import map (APPL_ID and
APPL_ALIAS VALUE) have Update standard rules applied to them in the
system import map. These standard rules are not applicable to the import
map, so you will need to remove them.

Complete the following steps to remove the standard rules from the
HEADER record in the import map:

1

Double-click the PARTNER_ID field in the HEADER record to display
the Field Properties dialogue.

1zl ["epeibics
Narne [PARTHER_ID
Descripian (Pt |dentifer
ala " alidakion
M Max T Format
M Mandalom I] Ig I;::g H IH
Pesition

If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box to
remove the standard rule.

The system asks you confirm the removal of the standard rule from the
field.

GENTRAM:Server - Application Integration

Q Are pou sure you want to change the standard rule for thiz field ?

Click YES to remove the standard rule.
Click OK to save the change to the field.
Repeat steps 1 —6 for the APPL_ID and APPL_ALIAS VALUE fields.
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Creating the
INVBEGIN
Record
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The second record in your application file format you need to create
(INVBEGIN) is at the same level asthe HEADER record.

The INVBEGIN (beginning) record contains the purchase order number and
date, the shipping address information, the bill of lading number, ship date,
and terms information. The beginning record is mandatory and occurs once
for each invoice.

Complete the following steps to create the INVBEGIN record:

1. Highlight the HEADER record and select Insert from the Edit menu.
Select Record from the cascading menu to display the Positional Record
Properties dialogue.

you want to create equal records/groupsand “ Create
Sub” from the Edit menu to create subordinate groups/
records/fields.

Q Remember to select “Insert” from the Edit menu when

2. Inthe Namefield, type “INVBEGIN" asthe record identification code.
Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.

3. IntheDescfield, type “Beginning Record” as the description of the
record. Thisfieldisused to provide abrief explanation of the record that
will alow you to differentiate it from similar records.

4. IntheTagfield, type “BEG” asthe record identification code <TAG>.
For example, arecord is recognised by the system as the following:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognise that
record and then determine the mapping requirements.

You must define the record tag on the Positional
Record Properties dialogue for outbound maps,
instead of defining fields with the purpose of explicitly
containing therecord tag.

5. Inthe Position field, accept the default of “1” for the starting column
position of the tag in the data record.

6. IntheMin Usagefield, type“1” to make the record mandatory. This
field contains the minimum number of times the record must repeat.
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If theMin Usagefield contains“0” (zero), therecord is
conditional. If the Min Usage field contains“ 1" or
greater, therecord is mandatory.

Accept the default of “1” in the Max Usage field so the beginning record
only occurs once (not alooping structure).

The Positional Record Properties dialogue should now look like this:

Pozilional RBecoid Propertier

rdertfication

Mame{IH¥EEGIH
Dieac IEIE_u,'nn'ng Feoad
T |BEG Preation |1 [T UmmKey Fid | FepFidd.
'
~Looping
: ® Mamal
Min Uzage |1
) Loop Stal Ecit Fiakds. .
MaxUsage |1 {7 Loog End

~Specal Propeslies
& Mormal
! Flosting

C Widoad  Aherse Too | Postion 1

7. Click OK to create the INVBEGIN record.

Creating the
INVCOMMENT  The INVCommentGroup (comment information) groups all the comment
Group information for theinvoice, including the message text. The
INV CommentGroup is mandatory and occurs up to ten times per invoice
translated.

Complete the following steps to create the INV CommentGroup at the same
level asthe INVBEGIN record:

1. Highlight the INVBEGIN record and select Insert from the Edit menu.
Select Group from the cascading menu.

The Group Properties dialogue is displayed.
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2.

In the Name field, type “INV CommentGroup” to indicate that this
group will contain all of the comment records. Thisis the segment loop
identification code.

Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.

3.

In the Description field, type “Comment Group” astheloop description.
Thisfield is used to provide a brief explanation of the loop.

Inthe Minimum Usagefield, type“1” to make the loop mandatory. This
is the minimum number of times the loop must be repeated. For a
conditional loop, the minimum usage should always be “0” (zero). For a
mandatory loop, the minimum usage should be “1” or greater.

In the Maximum Usagefield, type“10”. Thisindicatesthat this group of
records will occur up to ten times. The Group Properties dialogue
should now look like this:

G M liees,

M are | INYCommentG mup

D eszcriplion | Cammenl Graup

birimum Uzage |1 [ Promote mcoms to paenl
Fomate
MWadrmum Uzage |10

6.

Click OK to create the INV CommentGroup.

Creating the

INVCOMMENT Inthistutorial, the INVCommentGroup contains one subordinate record
Record (INVCOMMENTL).

The INVCOMMENT (comment record) record contains the message text.
The first comment record is mandatory and occurs once per invoice
tranglated (once for each comment line).

Complete the following steps to create the INVCOMMENT1 record:

1
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Click the INVCommentGroup to highlight it and select Create Sub from
the Edit menu. Select Record from the cascading menu.

The Positional Record Properties dialogue is displayed.
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2. Inthe Namefidd, type“INVCOMMENT” asthe record identification
code.

Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.

3. IntheDescfield, type “Invoice Comment Record 1" as the description
of the record. Thisfield is used to provide a brief explanation of the
record that will allow you to differentiate it from similar records.

4. IntheTagfield, type“CMT” asthe record identification code <TAG>.
For example, arecord is recognised by the system as the following:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognise that
record and then determine the mapping requirements.

Record Properties dialogue for outbound maps,
instead of defining fields with the purpose of explicitly
containing therecord tag.

Q You must define the record tag on the Positional

5. Inthe Position field, accept the default of “1” for the starting column
position of the tag in the data record.

6. IntheMin Usagefield, type“1” to make the record mandatory. This
field contains the minimum number of times the record must repeat.

If theMin Usagefield contains“0” (zero), therecord is
conditional. If the Min Usage field contains“1” or
greater, therecord is mandatory”

Accept the default of “1” in the Max Usage field so this record only
occurs once (not alooping structure).
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The Positional Record Properties dialogue should now ook like this:

Povitinal Beconl Poopeliey
Adertfication
Mame{IH¥COMMENT
Dazc IIrM:lil:E Camrenl Aecord
T |CMT Fosifon (1 T UssKey Field [ ey Fild.
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7. Click OK to create the INVCOMMENT record.

Creating the

INVDETAIL TheINVDETAIL (detail) record is at the same level asthe HEADER and

Record

INVBEGIN records and the INV CommentGroup.

The INVDETAIL (detail) record contains line item number and description,
quantity shipped, unit of measure, price, product code, and VAT calculation
information. The detail record is mandatory and occurs up to 200,000 times
per invoice transated (once for each line item invoiced).

Complete the following steps to create the INVDETAIL record:

1. Highlight the INV CommentGroup and select Insert from the Edit menu.
Select Record from the cascading menu to display the Positional Record

Properties dialogue.

2. Inthe Namefield, type “INVDETAIL” the record identification code.
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Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.
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3. IntheDesc field, type“ Detail Record” as a description of the record.
Thisfield is used to provide a brief explanation of the record that will
allow you to differentiate it from similar records.

4. Inthe Tagfield, type“DET” astherecord identification code <TAG>.
For example, arecord is recognised by the system as the following:

<TAG>[Field_1][Field 2]
The record TAG for each record enables the system to recognise that
record and then determine the mapping requirements.

You must define the record tag on the Positional
Record Properties dialogue for outbound maps,
instead of defining fieldswith the purpose of explicitly
containing therecord tag.

5. Inthe Position field, accept the default of “1” as the starting column
position of the tag in the data record.

6. IntheMin Usagefield, type“1” to make the record mandatory. This
field contains the minimum number of times the record must repeat.

If theMin Usagefield contains“0” (zero), therecord is
conditional. If the Min Usage field contains“1” or
greater, therecord ismandatory.

7. Inthe Max Usagefield, type “200000" as the maximum number of
times the record can repeat.
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The Positional Record Properties dialogue should now ook like this:

Poritional Becard Propertias

Adertfcation
H.:H-EIIWDETAIL
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8. Click OKto create the INVDETAIL record.

Creating the

TEMPVATSTL The TEMPVATSTL (Temporary Storage VAT Subtotals) record is at the
Record samelevel asthe HEADER, INVBEGIN, and INVDETAIL records and the

INV CommentGroup.

The TEMPVATSTL (temporary storage for VAT subtotals) record contains
temporary storage fieldsto enable VAT subtotal calculations. The temporary
storage record is conditional and occurs up to 20 times per invoice translated
(once for each possible VAT code subtotal).

Complete the following steps to create the TEMPVATSTL record:

1. Highlight the INVDETAIL record and select Insert from the Edit menu.
Select Record from the cascading menu to display the Positional Record

Properties dialogue.

2. Inthe Namefield, type “TEMPVATSTL” asthe record identification

code.
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Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.
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7.

In the Desc field, type “ Temporary Storage VAT Subtotals’ asa
description of the record. Thisfield is used to provide a brief
explanation of the record that will allow you to differentiate it from
similar records.

In the Tag field, type “TMP” asthe record identification code <TAG>.
For example, arecord is recognised by the system as the following:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognise that
record and then determine the mapping requirements.

You must define therecord tag on the Positional
Record Propertiesdialogue for outbound maps,
instead of defining fieldswith the purpose of explicitly
containing therecord tag.

In the Position field, accept the default of “1” asthe starting column
position of the tag in the data record.

In the Min Usage field, accept the default of “0” so the record will be
conditional. This field contains the minimum number of times the
record must repeat.

If theMin Usagefield contains“0” (zero), therecord is
conditional. If the Min Usage field contains“1” or

greater, therecord is mandatory.

In the Max Usage field, type 20" as the maximum number of timesthe
record can repeat.
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The Positional Record Properties dialogue should now ook like this:

Povitineral Beconl Poopealiny
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8. Click OK to create the TEMPVATSTL record.

Creating the
INVSUMMARY Thefina record that you need to create isthe INVSUMMARY (summary)
Record record, whichisat the samelevel asthe INVDETAIL record.

The INVSUMMARY (summary) record contains the total invoice amount
and the total transaction amount. The summary record is mandatory and
occurs once per invoice trang ated.

Complete the following steps to create the INVSUMMARY record:

1. Highlight the INVDETAIL record and select Insert from the Edit menu.
Select Record from the cascading menu to display the Positional Record
Properties dialogue.

2. Inthe Namefield, type“INVSUMMARY” the record identification
code.

Do not use spacesor hyphens(-) in the Namefield. You
can use the under score () to separate words.
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Inthe Descfield, type“ Summary Record” asadescription of therecord.
Thisfield is used to provide a brief explanation of the record that will
allow you to differentiate it from similar records.

In the Tag field, type “SUM” as the record identification code <TAG>.
For example, arecord is recognised by the system as the following:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognise that
record and then determine the mapping requirements.

You must define therecord tag on the Positional
Record Propertiesdialogue for outbound maps,
instead of defining fieldswith the purpose of explicitly
containing therecord tag.

In the Position field, accept the default of “1” asthe starting column
position of the tag in the data record.

Inthe Min Usagefield, type “1" to make the record mandatory. This
field contains the minimum number of times the record must repeat.

If theMin Usagefield contains“0” (zero), therecord is
conditional. If the Min Usage field contains“1” or

greater, therecord ismandatory.

7. Accept the default of “1” in the Max Usage field. Thisis the maximum

number of times the record can repeat.
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The Positional Record Properties dialogue should now ook like this:
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8. Click OK to create the INVSUMMARY record.

Now that you have created the record structure of the application file, you
can define the application fields.

The application side of the map (input) should now ook like this:

EFIMPUT -

:zHEﬁDEH -1 Header Aecord

INYBEGIM -k- 1 Beginning Record

—ﬁlN\-"EDmmentGmup -t- 10 Comment Group

L@¥INVCOMMENT M- 1 lrveice Comment Record
IMNVDETAIL M- 200000 Detail Record
TEMPWATSTL -M- 20 Temporary Storage WaT Subtotalz
INWSURMARY -b- 1 Summary Record

Creating the
Application
Fields

Each record you create will contain a group of logically-related application
fields. These fields define the structure and content of the data that your

system needs to process the invoice.

The easiest way to add application fields to arecord is to use the Positional
Field Editor. You will generally create the fields for each sequential record,
starting with the INVBEGIN record.
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The application fields that you need to create are listed under their respective
recordsin the following table. The name, mandatory status, description, data
type, and field length for each field is given in the table.

Max
Length

Field Name Description

Header Record (HEADER) 1 per message
PARTNER_ID X Partner Identifier String
APPL_ID Application ID String 0 6
APPL_ALIAS_VALUE Application Alias Value String 0 6
Beginning Record (INVBEGIN) 1 per message
BILLTOACCTBEG X Bill to Acct Number String 1 9
DOCTYPBEG X Document Type String 1 6
INVNUMBEG X Invoice Number String 1 10
INVDATE X Invoice Date Dt/Tm 6 6
(YYMMDD)
PONUM Purchase Order Number String 0 20
PODATE Purchase Order Date Dt/Tm 6 6
(YYMMDD)
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD2 Ship To Address Line2 String 0 35
SHIPTOCITY Ship To City String 0 35
SHIPTOSTATE Ship To State String 0 35
SHIPTOPOSTALCODE Ship To Postal Code String 0 8
SHIPTOLOC Ship To Store Location String 0 8
BOLNUM Bill of Lading Number String 0 12
SHIPDATE Ship Date Dt/Tm 6 6
(YYMMDD)
TERMSNETDUE Terms New Due Days Number (RO) | O 3
TERMSTEXT Payment Terms Text String 0 40
Comment Group (INVCommentGroup) 10 per message
Invoice Comment Record (INVCOMMENT) 1 per message
BILLTOACCTCMT X Bill To Acct Number String 1
DOCTYPCMT X Document Type String 1 6
INVNUMCMT X Invoice Number String 1 10
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Field Name Description Lx]a;h
MESSAGETEXT1 Message Text Line 1 String 0 40
MESSAGETEXT2 Message Text Line 2 String 0 40
MESSAGETEXT3 Message Text Line 3 String 0 40
MESSAGETEXT4 Message Text Line 4 String 0 40

Detail Record (INVDETAIL) up to 200,000 per message
BILLTOACCTDET Bill To Acct Number String 1 9
DOCTYPDET Document Type String 1 6
INVNUMDET X Invoice Number String 1 10
ITEMNUM X Item Number (Our Item) Number (RO) |1 6
QTYSHIP X Quantity Shipped Number (RO) |1
UNITPRICE X Unit Price Number (R2) |1 7
UOM X Unit of Measure String 1 4
CUSTPROCODE X Customer Product Code String 1 10
UPCCODE X UPC Code String 1 12
ITEMDESC Item Description String 0 30
VATCODE X VAT Rate Code String 1 2
TEMPVATRATE Temporary Storage VAT String 0 10
Percentage Rate
TEMPLEXC Temporary Line Extended Cost Number (R4) |0 14
Temporary Storage VAT Record (TEMPVATSTL) up to 10 per message
BILLTOACCTTS X Bill To Acct Number String 1 9
DOCTYPTS X Document Type String 1 6
INVNUMTS X Invoice Number String 1 10
SEQA Sequence Number of STL Number (RO) |0 10
VATRATE VAT Rate Number (R3) |0 6
VATRATECODE VAT Code String 0 1
NUMLINES Number of Lines for VAT Code Number (RO) | O 10
LVLA Line Subtotal Amount (Before VAT) | Number (R2) |0 12
VATA VAT Amount Payable Number (R2) |0 12
Summary Record (INVSUMMARY) 1 per message
BILLTOACCTSUM X Bill To Acct Number String 1 9
DOCTYPSUM X Document Type String 1 6
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. L Data Min Max
Field Name Description Type Length Length
INVNUMSUM X Invoice Number String 1 10
TOTALAMOUNT X Total Monetary Value Summary Number (R2) |1 10

You already created the fields for the HEADER record in the system import
map, and then copied the fields to the import map and removed the standard
rules from those fields. Therefore, the first record for which you need to
definefieldsisthe INVBEGIN record.

Complete the following steps to create the application fields for the
INVBEGIN record:

1. Click the INVBEGIN application record with the right mouse button to
access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional

Field Editor dialogue.
Fozitional Ficld Editar
‘Aecord
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Cancel I
rFiakd Dalaiz
Hame I [T tardatan
Dazcnplioan I
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3. If thefield you are creating isthe first field in the record, just click NEW
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details
section.
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In the Namefield, type“BILLTOACCTBEG”, which isthe name of the
first field in the INVBEGIN record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that containsiit.
For example, you will use “BEG” for the Beginning record.

Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.

10.
11

12.

Click the Mandatory check box to identify it as arequired field.

In the Description field, type “Bill To Account Number” asthe
description of the field. The description is used to provide a brief
explanation of thefield that will allow you to differentiate it from
similar fields.

From the Data Type drop-down list box, select “ String” as the type of
the field, to specify that this field must contain alphanumeric data.

If you wanted to indicate the exact position of the field
in the record, you would type the starting position of
thefield in the Sart Posfield. You will want to specify
field start positionsif, for example, you will only be
using a few fields but you want them positioned exactly
in therecord.

In thistutorial, you will usethe alternative to
specifying the start position of each field, which isto
add the fields sequentially in therecord and then use
the Auto Position function. Please see step 12 below for
mor e information on the Auto Position function.

If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format drop-down list box.

In the Min Length field, type “1" because this is the minimum number
of charactersthat is acceptable for thisfield. If, according to the table

starting on page 152, the minimum length of thefield is“0”, then just

accept that default in the Min Length field.

Inthe Max Length field, type “9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify will be
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 153.
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13. After you add the last field, click AUTOPOSI TI ON to automatically
position the fields in the record. The Auto Position function will
automatically calculate the start position in the record of each field
based on the criteriathat each field is positioned directly after the
previous field and is of the length specified in the Max Length field.
Click YES to acknowledge the warning message that fields will be

sequenced in order.

Please notethat it isonly valid to usethe Auto Position
function if you define arecord tag on the Positional
Record Propertiesdialogue, and if you define every
field in therecord in the sequencethat each field

occurs, asyou aredoing in thistutorial.

The Positional Field Editor dialogue should now look like the following

(only the last eleven fields in the record are currently visible in the

Fields list box):
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14. When you are completely finished adding fieldsto the INVBEGIN
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Complete the following steps to create the application fields for the

INVCOMMENT record:

1. Click the INVCOMMENT application record with the right mouse
button to access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialogue.

3. If thefield you are creating isthe first field in the record, just click NEW
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details
section.

4. IntheNamefield, type“BILLTOACCTCMT”, which isthe name of the

first field in the INVCOMMENT record. Each application field must
have a unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that containsit.
For example, you will use“CMT” for the first comment record.

Do not use spacesor hyphens(-) in the Namefield. You
can use the under score () to separate words.

8.
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Click the Mandatory check box to identify it as arequired field.

In the Description field, type “Bill To Account Number” asthe
description of the field. The description is used to provide a brief
explanation of thefield that will allow you to differentiate it from
similar fields.

From the Data Type drop-down list box, select “ String” as the type of
the field, to specify that this field must contain alphanumeric data.

If you wanted to indicate the exact position of the field
in the record, you would type the starting position of
thefield in the Start Posfield. You will want to specify
field start positionsif, for example, you will only be
using afew fieldsbut you want them positioned exactly
in therecord.

In thistutorial, you will usethe alternativeto
specifying the start position of each field, which isto
add the fields sequentially in therecord and then use
the Auto Position function. Please see step 12 below for
mor e information on the Auto Position function.

If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format drop-down list box.
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10.
11.

12.

13.

In the Min Length field, type “1" because this is the minimum number
of charactersthat is acceptable for thisfield. If, according to the table

starting on page 152, the minimum length of thefield is“0”, then just

accept that default in the Min Length field.

Inthe Max Length field, type “9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify will be
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 153.

After adding the last field, click AUTOPGsI TI ON to automatically
position the fields in the record. The Auto Position function will
automatically calculate the start position in the record of each field
based on the criteria that each field is positioned directly after the
previous field and is of the length specified in the Max Length field.
Click YES to acknowledge the warning message that fields will be
sequenced in order.

Please notethat it isonly valid to usethe Auto Position
function if you define arecord tag on the Positional

Record Propertiesdialogue, and if you define every
field in therecord in the sequencethat each field
occurs, asyou aredoing in thistutorial.
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The Positional Field Editor dialogue should now look like the
following:
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14. When you are completely finished adding fieldsto the INVCOMMENT
record, click CLOSE.

Complete the following steps to create the application fields for the
INVDETAIL record:

1. ClicktheINVDETAIL application record with the right mouse button to
access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional

Field Editor dialogue.

3. Ifthefield you are creating isthe first field in the record, just click NEW

A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details
section.

4. Inthe Namefield, type“BILLTOACCTDET", which isthe name of the

first field inthe INVDETAIL record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in
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multiple records with a suffix that identifies the record that containsit.
For example, you will use “DET” for the detail record.

Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.

10.
11

12.

13.

Click the Mandatory check box to identify it as arequired field.

In the Description field, type “Bill To Account Number” asthe
description of the field. The description is used to provide a brief
explanation of the field that will allow you to differentiate it from
similar fields.

From the Data Type drop-down list box, select “ String” as the type of
the field, to specify that this field must contain alphanumeric data.

If you wanted to indicate the exact position of the field
in the record, you would type the starting position of
thefield in the Sart Posfield. You will want to specify
field start positionsif, for example, you will only be
using a few fields but you want them positioned exactly
in therecord.

In thistutorial, you will use the alternative to
specifying the start position of each field, which isto
add the fields sequentially in therecord and then use
the Auto Position function. Please see step 12 below for
mor e information on the Auto Position function.

If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format drop-down list box.

In the Min Length field, type “1" because this is the minimum number
of charactersthat is acceptable for thisfield. If, according to the table

starting on page 152, the minimum length of thefield is“0”, then just

accept that default in the Min Length field.

In the Max Length field, type “9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify will be
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 153.

After adding the last field, click AUTO PQsI TI ONto automatically
position the fields in the record. The Auto Position function will
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automatically calculate the start position in the record of each field
based on the criteriathat each field is positioned directly after the
previous field and is of the length specified in the Max Length field.
Click YES to acknowledge the warning message that fields will be
sequenced in order.

Please notethat it isonly valid to usethe Auto Position
function if you define arecord tag on the Positional
Record Propertiesdialogue, and if you define every
field in therecord in the sequencethat each field
occurs, asyou aredoing in thistutorial.

The Positional Field Editor dial ogue should now look like the following
(only the last eleven fieldsin the record are currently visible in the
Fields list box):
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14. When you are completely finished adding fields to the INVDETAIL
record, click CLOSE.
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Complete the following steps to create the application fields for the
TEMPVATSTL record:

1

Click the TEMPVATSTL application record with the right mouse button
to access the shortcut menu.

Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialogue.

If thefield you are creating isthe first field in the record, just click NEW
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details
section.

Inthe Name field, type “BILLTOACCTTS’, which is the name of the
first field in the TEMPVATSTL record. Each application field must
have a unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that containsit.
For example, you will use“TS’ for the temporary storage record.

Do not use spacesor hyphens(-) in the Namefield. You
can use the under score () to separate words.

8.

Click the Mandatory check box to identify it as arequired field.

In the Description field, type “Bill To Account Number” asthe
description of the field. The description is used to provide a brief
explanation of thefield that will allow you to differentiate it from
similar fields.

From the Data Type drop-down list box, select “ String” as the type of
the field, to specify that this field must contain alphanumeric data.

If you wanted to indicate the exact position of the field
in the record, you would type the starting position of
thefield in the Start Posfield. You will want to specify
field start positionsif, for example, you will only be
using a few fields but you want them positioned exactly
in therecord.

In thistutorial, you will usethe alternativeto
specifying the start position of each field, which isto
add the fields sequentially in therecord and then use
the Auto Position function. Please see step 12 below for
mor e information on the Auto Position function.

If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format drop-down list box.
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10.
11.

12.

13.

In the Min Length field, type “1" because this is the minimum number
of charactersthat is acceptable for thisfield. If, according to the table

starting on page 152, the minimum length of thefield is“0”, then just

accept that default in the Min Length field.

Inthe Max Length field, type “9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify will be
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 153.

After adding the last field, click AUTO PQSI TI ONto automatically
position the fields in the record. The Auto Position function will
automatically calculate the start position in the record of each field
based on the criteria that each field is positioned directly after the
previous field and is of the length specified in the Max Length field.
Click YES to acknowledge the warning message that fields will be
sequenced in order.

Please notethat it isonly valid to usethe Auto Position
function if you define arecord tag on the Positional

Record Propertiesdialogue, and if you define every
field in therecord in the sequencethat each field
occurs, asyou aredoingin thistutorial.
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The Positional Field Editor dialogue should now ook like the
following:
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14. When you are completely finished adding fields to the TEMPVATSTL

record, click CLCSE.

Complete the following steps to create the application fields for the
INVSUMMARY record:

1

Click the INVSUMMARY application record with the right mouse
button to access the shortcut menu.

Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialogue.

If thefield you are creating isthe first field in the record, just click NEW
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details
section.

Inthe Namefield, type“BILLTOACCTSUM”, which isthe name of the
first field in the INVSUMMARY record. Each application field must
have a unique name. It is useful to tag the end of the fields that occur in
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multiple records with a suffix that identifies the record that containsit.
For example, you will use “SUM” for the summary record.

Do not use spacesor hyphens(-) in the Namefield. You
can use the underscore () to separate words.

10.
11.

12.

13.

Click the Mandatory check box to identify it as arequired field.

In the Description field, type “Bill To Account Number” asthe
description of the field. The description is used to provide a brief
explanation of the field that will allow you to differentiate it from
similar fields.

From the Data Type drop-down list box, select “ String” as the type of
the field, to specify that this field must contain alphanumeric data.

If you wanted to indicate the exact position of the field
in the record, you would type the starting position of
thefield in the Sart Posfield. You will want to specify
field start positionsif, for example, you will only be
using afew fields but you want them positioned exactly
in therecord.

In thistutorial, you will usethe alternative to
specifying the start position of each field, which isto
add the fields sequentially in therecord and then use
the Auto Position function. Please see step 12 below for
mor e information on the Auto Position function.

If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format drop-down list box.

In the Min Length field, type “1" because this is the minimum number
of charactersthat is acceptable for thisfield. If, according to the table

starting on page 152, the minimum length of thefield is“0”, then just

accept that default in the Min Length field.

Inthe Max Length field, type “9” as the maximum length of the field.
To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify will be
positioned below the field.

Create the rest of the fields according to the record layout table starting
on page 153.

After adding the last field, click AUTO POSI TI ON to automatically
position the fields in the record. The Auto Position function will
automatically calculate the start position in the record of each field
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based on the criteriathat each field is positioned directly after the
previous field and is of the length specified in the Max Length field.
Click YES to acknowledge the warning message that fields will be
sequenced in order.

Please notethat it isonly valid to usethe Auto Position
function if you define arecord tag on the Positional
Record Propertiesdialogue, and if you define every

field in therecord in the sequencethat each field

occurs, asyou aredoingin thistutorial.
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The Positional Field Editor dialogue should now ook like the
following:
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14. When you are completely finished adding fieldsto the INVSUMMARY

record, click CLOSE.

After defining your application file to Sterling Gentran:Director, the next
step is to map the necessary data from the EDI file to your application fields.
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Each record in the import map contains a group of logically-related
application fields. Thesefieldswill contain the information that your system
needs to generate the invoice. The group contains logically-related
application records.

Each record (except the HEADER record that you defined for the system
import map using a three-field key) contains a three-field record key that
ensures that the same identifying information is located at the beginning of
each record. Your application file format contains arecord key so that each
record can beidentified individually. The record key for thisinvoice consists
of your partner’s bill to account number, the document type, and the invoice
number.

This section examines each application field sequentially and describes the
mapping operations that you need to perform to map the appropriate data
from each field.

For the import map, you will not map from any of the fieldsin the HEADER
(header) record. Thisrecord contains the five fields that comprise the key in
the system import map. However, since this header record is a part of your
application file, it must be defined in the import map, aswell. You did this
when you copied the HEADER record from the system import map to this
import map. This header record is mandatory and occurs only once.

This section describes the actions necessary for you to map from each field
inthe INVBEGIN (beginning) record. The INVBEGIN (beginning) record
contains the purchase order number and date, the shipping address
information, the bill of lading number, ship date, and termsinformation. The
beginning record is mandatory and occurs once for each invoice.

The BILLTOACCTBEG field is part of the application file format key, but
does not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on thisfield.

The DOCTYPBEG field is part of the application file format key, but does

not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on thisfield.
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INVNUMBEG

Changing the max use of
the IRF segment

Mapping the invoice
number

The IRF segment contains invoice references and it repeats up to 999,999
times. You only need to send one IRF segment to your partner because you
areinvoicing only one order for this message. Therefore, you will changethe
maximum usage of the IRF segment from to make it a nonrepesting
segment.

You can map the INVNUMBEG field directly to the IRF INVN element
(Invoice Number), by using the Link function. The Link function allowsyou
to map afield or element from the Input side of the map to afield or element
on the Output side of the map. The link between the two fieldsis visually
represented with aline connecting the two fields.

Also, we recommend that you set up a Document Name for each map, to
make the identification of a message created by this map easier in Sterling
Gentran:Director. The Document Name allows you to differentiate between
messages in the document browsersin Sterling Gentran:Director.

To set up aDocument Name, you must select an element or field in the map
that contains data that will distinguish the messages translated by this map.
Then, the Name field of the document browsers that contain this message
will contain the data from the selected element or field.

You can choose any element or field asthe Document
Name, but we strongly recommend that you select an
element or field that occursonly oncein the message
and hasa datatypeof “Sring”. For an Invoice, the
document name istypically the Invoice Number.

Complete the following steps to make the | RF a honrepeating segment:

1. Click the IRF segment with the right mouse button to access the shortcut
menu.

2. Select Properties... from the shortcut menu to access the EDI Segment
Properties dialogue.

3. IntheMax Usagefield, type“1” to make the IRF a nonrepeating
segment. Thisfield currently contains “999999”.

4. Click OK to accept the change to the | RF segment.

Complete the following steps to map the invoice number:

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field INVNUMBEG in the INVBEGIN record.
When you click the field, the cursor changesto a“Link
Arow”: ||k
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3. Click the IRF INVN element (Invoice Number).

4. Alineisdisplayed, visualy illustrating the link between the
INVNUMBEG field and the IRF INVN element.

Setting up the document  Complete the following steps to set up the Document Name for this invoice:

name : . )
1. Double-click the IRF INVN element (Invoice Number) to display the
Field Properties dialogue:
1zid | 'opeibics

s [

Description {INVOICE MLUMEEF:

ala ¥ afdetin

kv Max  Tppe Format —
P Mandaions 1 [17 [svig  [#] [ el

2. If the Advanced section of the Field Properties dialogue is not currently
displayed, click ADVANCED>> to access this section, which enables
you to define rules.

3. Inthe Advanced section, click the Use Standard Rule check box, to
display the rule options.

4. Click the Update radio button.

From the Table/Key drop-down list box, choose “ Document record”.
Thisindicates that you are updating the document record in Sterling
Gentran:Director.

6. From the Field drop-down list box, choose “Document Name.” This
indicatesthat you are updating the Name field in the document browsers
with the contents of this element.
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INVDATE

Mapping the invoice and
tax-point dates

PONUM

7.

The Advanced section of the dialogue should now look like this:
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Click OK to set up the document name.

You can map the INVDATE field directly to both the IRF IVDT (Date of
Invoice) and IRF TXDT (Tax-Point Date) elements by using the Link
function, because both of these dates are the same.

Complete the following steps to map the invoice and tax-point dates:

1

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field INVDATE in the INVBEGIN record. When
you click the field, the cursor changesto a“Link Arrow”: |

Click the IRF IVDT element (Date of Invoice).

A lineisdisplayed, visualy illustrating the link between the INVDATE
field and the IRF IVDT element.

Click the application field INVDATE in the INVBEGIN record again.
When you click the field, the cursor changesto a“Link Arrow”.

Click the IRF TXDT element (Tax-Point Date).

A lineisdisplayed, visualy illustrating the link between the INVDATE
field and the IRF TXDT element.

The ODD group contains order and delivery terms and invoice line details.
This group repeats up to 999,999 times. You only need to send one ODD
group to your partner because you are invoicing only one order for this
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Changing the maximum
usage of the ODD group

Using an extended rule
to specify the PYT
SEQA

message. Therefore, you will change the maximum usage of the ODD group
to make it a nonrepeating group.

Since you know that you will only be invoicing one order per INVOIC
message, you can use extended rules to hard code thefirst level sequence
numbersto one. The first level sequence numbers (PYT SEQA, DNA
SEQA:2, ODD:2 SEQA, and ILD:2 SEQA) each indicate the number of
orders that this message is invoicing.

Then, you can map the PONUM field directly to the ODD:2 ORNO ORNO
element (Customer’s Order Number), by using the Link function.

Complete the following steps to make the ODD a nonrepeating group:

Click the ODD group with the right mouse button to access the shortcut
menu.

2. Select Properties... from the shortcut menu to access the Group
Properties dialogue.

3. Inthe Maximum Usagefield, type “1” to make the ODD group a
nonrepeating group. Thisfield currently contains “999999”.

4. Click the Promote records to parent check box to specify that when the
group is compiled, the subordinate segments and group will be extracted
from the loop and located in the parent group.

5. Click OK to accept the change to the ODD group.

Complete the following stepsto create an extended rule to hard code thefirst
level sequence numbers for the PY T segment (Settlement Terms) to one,
indicating the number of orders that this message isinvoicing:

1. Double-click the PYT SEQA element (First Level Sequence Number) to
access the Field Properties dialogue.

Ciech I Mo urealiees,
Narme [sEan
[ e=ription IFIHST LEWEL SEQUEMCE NUMEER
ala ' aidation
Wi M Type Famnat —
F Madalon |1 |1n [rurnter [#] [no (2] A
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2. If the Advanced section of the dialogueis not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.
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3.

4,

Click RULE... to display the Field Level Extended Rule dialogue.

21l Level Latended Hulc

File
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Compie Enore

In the Rulelist box, type the following:
#SEQA =1,

The “#SEQA = 1" setsthefirst level sequence number for the PYT
segment to one. The system will execute this rule when it processes the
PYT SEQA element.

Click COVPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the trans ation object,
after you complete the map. However, the system allows you to compile
each ruleindividualy, so that you can verify the accuracy of the rule
after you createit.

The Compile function will compiletherule
interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated in the
compilation processwill be displayed in the Compile
Errorslist box.

6. Click OK to add the extended rule to the PY T SEQA element.
7. Click CLOSE to exit the Field Properties dialogue.
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Using an extended rule  Complete thefollowing stepsto create an extended rule to hard code thefirst
to specify the DNA  |evel sequence number for the DNA segment (Data Narrative) to one,
SEQA'2 indicating the number of orders that this message is invoicing:

1

Double-click the DNA SEQA:2 element (First Level Sequence
Number) to access the Field Properties dialogue.

| wzid | 'opeibic:
Nerma |sEnx2
[ eeription IFIHST LEWEL SEQUEMCE NUMEER
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If the Advanced section of the dialogueis not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

Click RULE... to display the Field Level Extended Rule dialogue.
In the Editor list box, type the following:
#SEQA:2 =1,

The “#SEQA:2 = 1" setsthefirst level sequence number for the DNA
segment to one. The system will execute this rule when it processes the
DNA SEQA:2 element.

Click COWPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the translation object,
after you complete the map. However, the system allows you to compile
each rule individually, so that you can verify the accuracy of therule
after you create it.

The Compile function will compiletherule
interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated in the
compilation process will be displayed in the Compile
Errorslist box.

6. Click OK to add the extended rule to the DNA SEQA:2 element.
7. Click CLOSE to exit the Field Properties dialogue.
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Using an extended rule
to specify the ODD:2
SEQA

Using an extended rule
to specify the ILD:2
SEQA

Complete the following stepsto create an extended rule to hard code thefirst
level sequence numbersfor the ODD:2 segment (Order and Delivery Terms)
to one, indicate the number of orders that this messageisinvoicing:

1

6.
7.

Double-click the ODD:2 SEQA element (First Level Sequence
Number) to access the Field Properties dialogue.

If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

Click RULE... to display the Field Level Extended Rule dialogue.
In the Rule list box, type the following:
#SEQA =1,

The “#SEQA = 1" setsthefirst level sequence number for the ODD:2
segment to one. The system will execute this rule when it processes the
ODD:2 SEQA element.

Click COVPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the trans ation object,
after you complete the map. However, the system allows you to compile
each ruleindividualy, so that you can verify the accuracy of the rule
after you createit.

Q Thiswill compiletheruleinteractively, and allow you

tocorrect any errorsthat are generated. Any errorsor
war nings generated in the compilation process will be
displayed in the Errorslist box.

Click OK to add the extended rule to the ODD:2 SEQA element.
Click CLOSE to exit the Field Properties dialogue.

Complete the following stepsto create an extended rule to hard code thefirst
level sequence numbersfor the ILD:2 segment (Invoice Line Details) to one,
indicating the number of orders that this message isinvoicing:

1

Double-click the ILD:2 SEQA element (First Level Sequence Number)
to access the Field Properties dialogue.

If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

Click RULE... to display the Field Level Extended Rule dialogue.
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6.
7.

In the Rule list box, type the following:
#SEQA =1;

The “#SEQA = 1" setsthefirst level sequence number for the ILD:2
segment to one. The system will execute this rule when it processes the
ILD:2 SEQA element.

Click COwPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the translation object,
after you complete the map. However, the system allows you to compile
each ruleindividualy, so that you can verify the accuracy of the rule
after you createit.

The Compile function will compiletherule
interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated in the
compilation process will be displayed in the Compile
Errorslist box.

Click OK to add the extended rule to the ILD:2 SEQA element.
Click CLOSE to exit the Field Properties dialogue.

Mapping the order Complete the following steps to map the customer’s order number:

number

1.

2.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field PONUM in the INVBEGIN record. When
you click the field, the cursor changesto a“Link Arrow”: |

Click the ODD:2 ORNO ORNO element (Customer’s Order Number).

A lineisdisplayed, visualy illustrating the link between the PONUM
field and the ODD:2 ORNO ORNO element.

PODATE You can map the PODATE field directly to the ODD:2 ORNO ORN2
element (Date Order Placed by Customer) by using the Link function.

Mapping the date order Complete the following steps to map the date order placed by customer
placed by customer  (purchase order date):

1.

2.
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If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field PODATE in the INVBEGIN record. When
you click the field, the cursor changesto a“Link Arrow”.
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Click the ODD:2 ORNO ORN2 element (Date Order Placed by
Customer).

A lineisdisplayed, visually illustrating the link between the PODATE
field and the ODD:2 ORNO ORNZ2 element.

SHIPTONAME The shipping name, address, and location information can be directly
mapped to the CL O segment (Customer’s L ocation), by using the Link
function.

SHIPTOADD1

SHIPTOADD2

Complete the following steps to map the customer’s name:

1

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field SHIPTONAME in the INVBEGIN record.
When you click the field, the cursor changesto a“Link
AIowW™: | |k

Click the CLO CNAM element (Customer’s Name).

A lineisdisplayed, visualy illustrating the link between the
SHIPTONAME field and the CLO CNAM element.

Complete the following steps to map the customer’s address line 1.

1

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field SHIPTOADD1 in the INVBEGIN record.
When you click the field, the cursor changesto a“Link Arrow”.

Click the CLO CADD CADO element (Customer’s Address Line 1).

A lineisdisplayed, visualy illustrating the link between the
SHIPTOADD1 field and the CLO CADD CADO element.

Complete the following steps to map the customer’s address line 2:

1

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field SHIPTOADD2 in the INVBEGIN record.
When you click the field, the cursor changesto a“Link Arrow”.

Click the CLO CADD CAD1 element (Customer’s Address Line 2).

A lineisdisplayed, visually illustrating the link between the
SHIPTOADD?2 field and the CLO CADD CAD1 element.
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SHIPTOSTATE

SHIPTOPOSTAL
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Complete the following steps to map the customer’s address line 3:

1

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field SHIPTOCITY in the INVBEGIN record.
When you click the field, the cursor changesto a“Link
AITow”: | e

Click the CLO CADD CAD?2 element (Customer’s Address Line 3).

A lineisdisplayed, visually illustrating the link between the
SHIPTOCITY field and the CLO CADD CAD2 element.

Complete the following steps to map the customer’s address line 4:

1

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field SHIPTOSTATE in the INVBEGIN record.
When you click the field, the cursor changesto a“Link Arrow”.

Click the CLO CADD CAD3 element (Customer’s Address Line 4).

A lineisdisplayed, visually illustrating the link between the
SHIPTOSTATE field and the CLO CADD CAD3 element.

Complete the following steps to map the customer’s post code:

1

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field SHIPTOPOSTAL CODE in the INVBEGIN
record. When you click the field, the cursor changesto a“Link Arrow”.

Click the CLO CADD CAD4 element (Customer’s Post Code).

A lineisdisplayed, visualy illustrating the link between the
SHIPTOPOSTAL CODE field and the CLO CADD CAD4 element.

The SHIPTOLOC (ship to location) contains additional reference
information about the Ship To address. Thisfield can be directly mapped to
the CLO segment (Customer’s Location), by using the Link function.

Complete the following steps to map the customer’s own location code:

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field SHIPTOLOC in the INVBEGIN record.
When you click the field, the cursor changesto a“Link Arrow”.
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BOLNUM

Mapping the delivery
note number

SHIPDATE

Mapping the date of
despatch by supplier

TERMSNETDUE

3. Click the CLO CLOC CLO1 element (Customer’s Own Location
Code).

4. Alineisdisplayed, visualy illustrating the link between the
SHIPTOLOC field and the CLO CLOC CLO1 element.

You can map the BOLNUM field directly to the ODD:2 DELN DELO
element (Delivery Note Number), by using the Link function.

Complete the following steps to map the delivery note (bill of lading)
number:

1. If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field BOLNUM in the INVBEGIN record. When
you click the field, the cursor changesto a“Link Arrow”: | |k

3. Clickthe ODD:2 DELN DELO element (Delivery Note Number).

A lineisdisplayed, visualy illustrating the link between the BOLNUM
field and the ODD:2 DELN DELO element.

You can map the SHIPDATE field directly to the ODD:2 DELN DEL1
element (Date of Despatch by Supplier), by using the Link function.

Complete the following steps to map the date of despatch by supplier (ship

date):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field SHIPDATE in the INVBEGIN record. When
you click the field, the cursor changesto a“Link Arrow”.

Click the ODD:2 DELN DEL 1 element (Date of Despatch by Supplier).

4. Alineisdisplayed, visualy illustrating the link between the BOLNUM
field and the ODD:2 DELN DEL 1 element.

The PYT segment contains settlement terms and it repeats up to 999,999
times. You only need to send one PY T segment to your partner because you
areinvoicing only one order for this message. Therefore, you will changethe
maximum usage of the PY T segment from to make it a nonrepeating
segment.

You can map the TERMSNETDUE field directly to the PYT PAYY PAY 2
element (Number of Days), by using the Link function.
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the PYT segment

Mapping the number of
days

TERMSTEXT

Mapping the terms of
payment

INVComment
Group
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Complete the following steps to make the PY T a nonrepeating segment:

1. Click the PYT segment with the right mouse button to access the
shortcut menu.

2. Select Properties... from the shortcut menu to access the EDI Segment
Properties dialogue.

3. IntheMax Usagefield, type“1” to make the PYT anonrepeating
segment. Thisfield currently contains “999999”.

4. Click OK to accept the change to the PY T segment.

Complete the following steps to map the number of days (terms net due

days):

1. If the Linking function is not currently active, click the Link button on

the Main Toolbar to turn on the Linking function.

Click the application field TERMSNETDUE in the INVBEGIN record.
When you click the field, the cursor changesto a“Link
Arow”: ||k

Click the PYT PAYY PAY 2 element (Number of Days).

A lineisdisplayed, visually illustrating the link between the
TERMSNETDUE field and the PYT PAYY PAY 2 element.

You can map the TERMSTEXT field directly to the PYT PAYT element
(Terms of Payment) by using the Link function.

Complete the following steps to map the terms of payment (terms text):

l

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field TERMSTEXT in the INVBEGIN record.
When you click the field, the cursor changesto a“Link Arrow”.

Click the PYT PAYT element (Terms of Payment).

A lineisdisplayed, visualy illustrating the link between the
TERMSTEXT field and the PYT PAY T element.

The INV CommentGroup (comment information) groups all the comment
information for the invoice, including the message text. The

INV CommentGroup is mandatory and occurs up to ten times per invoice
translated.
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INVCOMMENT
Record

BILLTOACCTCMT

DOCTYPCMT

INVNUMCMT

MESSAGETEXT1

Mapping the general
narrative line 1

1

MESSAGETEXT?2

This section describes the actions necessary for you to map from each field
inthe INVCOMMENT (comment) record. The INVCOMMENT (comment
record) record contains the message text. The first comment record is
mandatory and occurs once per invoice translated (once for each comment
line).

The BILLTOACCTCMT field is part of the application file format key, but
does not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on thisfield.

The DOCTYPCMT field is part of the application file format key, but does
not contain data that the system needs to use to generate the invaice.
Therefore, you will not perform any mapping operations on this field.

The INVNUMCMT field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on this field.

The message text (comment) information is contained in the DNA segment
(Data Narrative). The MESSAGETEXT1, MESSAGETEXT?2,
MESSAGETEXT3, and MESSAGETEXT4 fields can al be directly
mapped to elementsin the DNA segment.

Complete the following steps to map the general narrative line 1 (message
text 1):

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field MESSAGETEXT1 in the INVCOMMENT
record. When you click the field, the cursor changesto a“Link
AITowW”: | e

Click the DNA GNAR GNADO element (General Narrative Line 1).

4. Alineisdisplayed, visudly illustrating the link between the
MESSAGETEXTL field and the DNA GNAR GNAO element.

Complete the following steps to map the general narrative line 2 (message
text 2):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.
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2. Click the application field MESSAGETEXT?2 in the INVCOMMENT
record. When you click the field, the cursor changesto a“Link
Arow”: ||k

Click the DNA GNAR GNA1 element (General Narrative Line 2).

A lineisdisplayed, visually illustrating the link between the
MESSAGETEXT?2 field and the DNA GNAR GNA1 element.

MESSAGETEXT3 Complete the following steps to map the genera narrative line 3 (message

1

text 3):

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field MESSAGETEXT3 in the INVCOMMENT
record. When you click the field, the cursor changesto a“Link Arrow”.

Click the DNA GNAR GNA2 element (General Narrative Line 3).

A lineisdisplayed, visually illustrating the link between the
MESSAGETEXT3 field and the DNA GNAR GNA2 element.

MESSAGETEXT4 Completethe following steps to map the genera narrative line 4 (message

1

INVDETAIL
Record

BILLTOACCTDET
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text 4):

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field MESSAGETEXT4 in the INVCOMMENT
record. When you click the field, the cursor changesto a“Link Arrow”.

Click the DNA GNAR GNA3 element (General Narrative Line 4).

4. Alineisdisplayed, visualy illustrating the link between the
MESSAGETEXT4 field and the DNA GNAR GNAS3 element.

This section describes the actions necessary for you to map from each field
inthe INVDETAIL (detail) record. The INVDETAIL (detail) record
contains line item number and description, quantity shipped, unit of
measure, price, product code, and VAT calculation information. The detail
record is mandatory and occurs up to 200,000 times per invoice trandated
(once for each line item invoiced).

The BILLTOACCTDET field is part of the application file format key, but

does not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on this field.
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DOCTYPDET

INVNUMDET

ITEMNUM

Mapping the second
level sequence number

QTYSHIP

The DOCTYPDET field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on thisfield.

The INVNUMDET field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on this field.

The ITEMNUM field can be directly mapped to the ILD:2 SEQB element
(2nd Level Sequence No.), by using the Link function, because the number
of thelineitem isthe second level sequence number. The second level of the
invoice istheline item details.

Complete the following steps to map the second level sequence number
(item number):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field ITEMNUM in the INVDETAIL record.
When you click the field, the cursor changesto a“Link
AITOW™: | |k

Click the ILD:2 SEQB element (2nd Level Sequence No.).

A lineisdisplayed, visualy illustrating the link between the
ITEMNUM field and the ILD:2 SEQB element.

On the EDI side of the map, the quantity shipped information is contained in
the ILD:2 QTY1 QTYO0 element (Number of Order Units Invoiced). The
ILD:2 QTYI QTYO element is defined as a string-type element in the
standard. However, you have determined that you will send your partner a
number-type element in NO format (formatted with an implicit decimal point
and no decimal places).

Therefore, you will need to change the properties of the ILD:2 QTY1 QTYO
element to reflect the type and the format that you have determined that your
partner will send you. Then, you can map the quantity shipped directly from
the QTYSHIPfieldto the ILD:2 QTYI QTYO element.
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Changing the properties  compete the following steps to change the type and format of the ILD:2

of the ILD:2 QTYI QTYO

element
1.

QTY!I QTYO element:

Double-click the ILD:2 QTY| QTYO0 element (Number of Order Units
Invoiced) to display the Field Properties dialogue.

Fizld Propemtisz Ed

Marms {arvo
Descrifion [ NUWEE R DF ORDER: UNITS INVOICE
ala*y aldetion Bdvancad x>
ki Max  Tppe Formnat —
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From the Type drop-down list box, select “Number” to indicate that this
isanumber element. The system will prompt you with a message that
changing the field's data type will invalidate its format. Click YES to
acknowledge this message and proceed.

From the Format drop-down list box, select “NO” to indicate that this
element will be formatted with animplicit decimal point and no decimal
place.

Mapping the number of ~After changing the type and format of the ILD:2 QTYI QTYO0 element, you
order units invoiced can map the QTY SHIP field directly toit.

184

Compl ete the following steps to map the quantity shipped:

1.

2.

If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Click the application field QTY SHIP in the INVDETAIL record. When
you click the field, the cursor changesto a“Link Arrow”: |

Click the ILD:2 QTY1 QTYO0 element (Number of Order Units
Invoiced).

A lineisdisplayed, visualy illustrating the link between the QTY SHIP
fieldand the ILD:2 QTYI QTYO element.
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UNITPRICE

UoM

CUSTPROCODE

The UNITPRICE field can be directly mapped to the ILD:2 AUCT AUCO
element (Cost Price (Excluding VAT)).

Complete the following steps to map the cost price (excluding VAT):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field UNITPRICE in the INVDETAIL record.
When you click the field, the cursor changesto a“Link
AITOW”: | e

Click the ILD:2 AUCT AUCO element (Cost Price (Excluding VAT)).

A lineisdisplayed, visualy illustrating the link between the
UNITPRICE field and the ILD:2 AUCT AUCO element.

You mapped the quantity shipped to the QTY | composite and the unit price
to the AUCT composite. Therefore, you want to map the unit of measure to
both composites.

Complete the following steps to map the unit of measure:

1. If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field UOM in the INVDETAIL record. When you
click thefield, the cursor changesto a“Link Arrow”.

Click the ILD:2 QTY| CD04:2 element (Measure Indicator).

4. Alineisdisplayed, visualy illustrating the link between the UOM field
andtheILD:2 QTY| CD04:2 element.

5. Again, click the application field UOM in the INVDETAIL record.
When you click the field, the cursor changesto a“Link Arrow”.

Click the ILD:2 AUCT CD04:3 element (Measure Indicator).

A lineisdisplayed, visualy illustrating the link between the UOM field
and the ILD:2 AUCT CDO04:3 element.

You can map the CUSTPROCODE (customer product code) field directly to
the ILD:2 CPRO CPR1 element (Customer’s Item Code), by using the Link
function.

Complete the following steps to map the customer’s item code (customer
product code):

1. If the Linking function is not currently active, click the Link button on

the Main Toolbar to turn on the Linking function.
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ITEMDESC

VATCODE
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2. Clicktheapplication field CUSTPROCODE inthe INVDETAIL record.
When you click the field, the cursor changesto a“Link
AMrow”: ||k

Click the ILD:2 CPRO CPR1 element (Customer’s Item Code).

A lineisdisplayed, visually illustrating the link between the
CUSTPROCODE field and the ILD:2 CPRO CPR1 element.

You can map the UPCCODE field directly to the ILD:2 SPRO CPR1
element (Supplier’s Code for the Traded Unit), by using the Link function.

Complete the following steps to map the supplier’s code for the traded unit
(UPC code):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field UPCCODE in the INVDETAIL record.
When you click the field, the cursor changesto a“Link Arrow”.

3. Click thelLD:2 SPRO CPR1 element (Supplier’s Code for the Traded
Unit).

4. Alineisdisplayed, visualy illustrating the link between the UPCCODE
field and the ILD:2 SPRO CPR1 element.

You can map the ITEMDESC (item description) field directly to the ILD:2
TDES TDEO element (Traded Unit Descr. Line 1), by using the Link
function.

Complete the following steps to map the traded unit description (item

description):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field ITEMDESC in the INVDETAIL record.
When you click the field, the cursor changesto a“Link Arrow”.

Click the ILD:2 TDES TDEO element (Traded Unit Descr. Line 1).

A lineisdisplayed, visualy illustrating the link between the
ITEMDESC field and the ILD:2 TDES TDEO element.

The Application Integration subsystem enables you to use selected
information from the Sterling Gentran:Director partner database in your
maps via a standard rule. You can map information from your trading
partner's profile in the Partner Editor to a selected element or field in the
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Mapping the VAT rate

map. The information that you can use in the map includes any fieldin a
table (location, lookup, or cross-reference) or data from the partner record.

For this map, you need to map the appropriate VAT rate based on the codein
the VATCODE field from alookup table, to look up data that you will map
(viastandard rule) to the TEMPVATRATE field. If you need to use tables,
you must decide whether to create a code table in the Application Integration
subsystem that can only be used with this map, or to add the table to either
the partner relationship or the internal system partner in Partner Editor. You
will set up the table you usein thistutorial under the internal system partner
(<Internal System User>) so it can be used globally.

In this tutorial, you need to extract information from alookup table to be
inserted into the outbound data. A lookup table is used when you want to
supplement data before it is sent to your partner. Please see the IBM®
Serling Gentran: Director® Release 5.5 User Guide for more information
on lookup tables.

You do not need to create thislookup table

(INVATCO.LKP). It isincluded with thetutorial data
that is provided when you install Sterling
Gentran:Director.

After you look up the appropriate VAT rate, you can map the VATCODE
(VAT code) field directly to the ILD:2 CD12 element (VAT Rate Category
Code), by using the Link function.

Complete the following steps to look up the appropriate VAT rate for the
specified VAT code:

1. Double-click the VATCODE field (in the INVDETAIL record). The
Field Properties dialogue is displayed.

Nama I'Y'ATI:IZIDE
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ala™ aidetion _ Edvancad »
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2. If the Advanced section of the dialogueis not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.
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3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Verify that the Select radio button is selected.

From the Table drop-down list box, select “Division lookup”. This
indicates that the key is the partner lookup table name for the <Internal
System User> partner and enables you to map from any field on the

L ookup Entry dialogue of the Partner Editor.

6. Inthe Sub Tablefield, type“VATCODES’. Thisisthe name of the
lookup table you imported.

7. From the Map From list box, choose “ Text 1”. Thisisthe field on the
Lookup Entry dialogue of the Partner Editor from which the contents
will be mapped.

8. Fromthe Map To list box, choose “TEMPVATRATE”". Thisisthefield
to which the information from the Partner Editor will be mapped.

The Advanced section of the Field Properties dial ogue should now look
likethis:

Aohaanced
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9. Click OKto map from the lookup table to the TEMPVATRATE field.

Mapping the VAT rate  Complete the following steps to map the VAT rate category code (VAT
category code code):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Clicktheapplicationfield VATCODE in the INVDETAIL record. When
you click the field, the cursor changesto a“Link Arrow”.

3. ClickthelLD:2 CD12 element (VAT Rate Category Code).
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4. Alineisdisplayed, visudly illustrating the link between the VATCODE
field and the ILD:2 CD12 element.

TEMPVATRATE You aready used adivision lookup table and a standard rule on the
VATCODE field to map the appropriate VAT rate (based on the code in the
VATCODE field) from the VATCODES division lookup table to the
TEMPVATRATE field. To map from the partner database to the
TEMPVATRATE field, the target field (TEMPVATRATE) needed to be a
string-type field. However, in order to map the TEMPVATRATE field to the
ILD:2 VATP element (VAT rate percentage), you need to convert the
TEMPVATRATE field to a number-type. You will use an extended rule to
perform the conversion and the mapping.

Using an extended rule  Complete the following steps to create an extended rule to convert the
to convert the type of the  TEMPVATRATE field from astring-type to anumber-type field and map the
TEMPVATRATE field  TEMPVATRATE field to the ILD:2 VATP element (VAT rate percentage):

and map it
1. Double-click theILD:2 VATP element (VAT rate percentage) to access
the Field Properties dialogue.
e [
Descrption |xm AATE PERCEMTAGE
alls Wl
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2. If the Advanced section of the dialogueis not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

Click RULE... to display the Field Level Extended Rule dialogue.

4. IntheRulelist box, type the following:
#VATP = ATON($INVDETAIL #TEMPVATRATE);
The“ATON” isanumerical function that converts stringsinto real
numbers, which enables you to convert a string-type field to a number-
typefield. The “#VATP =" maps the resulting real number to the ILD:2

VATP element. The system will execute this rule when it processes the
ILD:2 VATP element.

5. Click COWPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the trans ation object,
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after you complete the map. However, the system allows you to compile
each ruleindividualy, so that you can verify the accuracy of the rule
after you createit.

The Compile function will compiletherule
interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated in the
compilation process will be displayed in the Compile
Errorslist box.

6. Click OK to add the extended rule to the ILD:2 VATP element.
7. Click CLOSE to exit the Field Properties dialogue.

TEMPLEXC You need to calcul ate the extended price (quantity shipped multiplied by unit
cost) for each line item and load that extended price into the TEMPLEXC
field. Then, the TEMPLEXC field can be directly mapped to the ILD:2
LEXC element (Extended Line Cost (Excluding VAT)).

Calculating the extended Complete the following steps to multiply the quantity shipped for each line
price  jtem by the unit price to obtain the extended price:

1. Double-click the QTYSHIPfield (in the INVDETAIL segment). The
Field Properties dialogue is displayed.

Fizld Fiopoitizz

N [ATTSHP
DR [aar
O alaValdation bdvarced =2
Min Max  Tpp= Formak =
M Mendaoy {1 1[5 [Number [#] [RD 2]
Peeition..

2. If the Advanced section of the dialogueis not currently displayed, click
ADVANCED>> to access this section.

3. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Use Accum radio button.

Click NEW.. to access the Edit Accumulator Entry dialogueto create a
new calculation for this element.

6. From the Primary Accumulator drop-down list box, select “0”. This
number is aname by which the accumulator will be referred. Before any
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calculations are performed on an accumulator, its content is“0” (zero).
When you use an accumul ator, the system adds a new accumulator to
the bottom of this drop-down list box.

Thereisonly one set of accumulatorsfor each map.
Thismeansthat accumulator “ 0", whether it isused in
the Primary Accumulator or Alternate Accum field is
the same accumulator with the same contents. If you
assign calculationsto accumulator “ 0" at thebeginning
of the map and then useaccumulator “0" again later in
the map, the content of that accumulator will bethe
result of the earlier calculation. Any additional
calculations you assign to that accumulator will be
performed on the contentsresulting from an earlier
calculation.

7. Inthe Namefield, type“Extended Price’. Thisisadescriptive alias that
will enable you to differentiate what the accumulators you create are
used for.

8. From the First drop-down list box, select “Load primary”. Thisisthe
first operation that the system will perform. This specifies that the
system will load the contents of the field into the Primary Accumulator
for each iteration of the INVDETAIL segment.

TheFirst field isactive only after you select a Primary
Accumulator.

The Edit Accumulator Entry dialogue should now look like this:

Edit Aecumulatar Entry

Priman Accurulater |0 [#] Mama [EstandedFrics I
- peralices [ Concat |
Firel IL-:--ad primany |ﬂ llamata ﬁccu‘nl [ﬂ

Secand | [2]

Thid | [z]

Fouth | 1]

9. Click CK to add the accumulator.
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The Advanced section of the Field Properties dialogue should now look
like this:

-nlsod‘l.ﬂll_rﬁl.:

[ Usga Standaid Rus
(1 Seledd () Update T Corstert @ Use ficcum O Loon Count ) Use Code

Prmary Accumdalor Opl Op2 0Op3 Dpd
(-Eklended Price Load [T

Chal

10. Click OK on the Field Properties dialogue to add the standard rule to the
QTYSHIPfield.

11. Double-click the UNITPRICE field (in the INVDETAIL segment). The
Field Properties dialogue is displayed.

Nerie {UMITRRICE
D ezmrption Il.lnt Piica
ala W aldation Bdwancad =

Mn  Max  Tpp= Frernat —
¥ Handalory |1 I? [Mumbe: [2] [R2 3] Coedilioes. .
Preiion ..

12. If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

13. Inthe Advanced section, click the Use Standard Rule check box to
display the rule options.

14. Click the Use Accum radio button.

15. Click NEW.. to access the Edit Accumulator Entry dialogue to create a
new calculation for this element.

16. From the drop-down list box, select primary accumulator “0”.
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Thereisonly one set of accumulatorsfor each map.
Thismeansthat accumulator “ 0", whether it isused in
the Primary Accumulator or Alternate Accum field is
the same accumulator with the same contents. If you
assign calculationsto accumulator “0” at the beginning
of themap and then useaccumulator “0” again later in
the map, the content of that accumulator will bethe
result of theearlier calculation. Any additional
calculations you assign to that accumulator will be
performed on the contentsresulting from an earlier
calculation.

17. From the First drop-down list box, select “Multiply with primary”. This

isthe first operation that the system will perform. This specifiesthat the
system will multiply the value of the UNITPRICE field with the
contents of the primary accumulator, and store the result in the primary
accumulator for each iteration of the INVDETAIL segment.

TheFirst field isactive only after you select a Primary
Accumulator.

The Edit Accumulator Entry dialogue should now ook like this:

Edit Aecumulatar Entry Ed

Piirary Acourukstor |0 [£] Mama IExhandB-:IF'ri:a | i |

Ih‘ll.,llid_'.l vith pimane |£| Bllemats Accum I |i|

EI

El

B

18. Click OK to add the accumulator.
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19.

20.

The Advanced section of the Field Properties dialogue should now look
like this:

Adwanced

¥ Uze Siandsrd Rule
") Sakeal ) Update O Constant @) Uze Accum © Laop Couat ) Ues Coda

Fliman Becunulston Op1l Op2 Op3 Opd
O-Exteedad Plica teull MNew... I

I§
(=]
&

Oelate

Click OK on the Field Properties dialogue to add the standard rule to the
UNITPRICE field.

Double-click the TEMPLEXC field (in the INVDETAIL segment). The
Field Properties dialogue is displayed.

Fizld Fropoitize

Narne ITEHPLE:&’.'I:

D eexription ITl:n'nl:lrury Lire Estended Cost

ala et
Win Max  Tppe Formnat —

I© Mandalop IIII I‘H INuth| EI IFM H

21.

22.

23.
24,

25.

If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

In the Advanced section, click the Use Standard Rule check box to
display the rule options.

Click the Use Accum radio button.

Click NEW.. to access the Edit Accumulator Entry dialogue to create a
new calculation for this element.

From the drop-down list box, select primary accumulator “0”.

May 2011 IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial



Outbound Invoice (INVOIC) Mapping Your Data

26. From the First drop-down list box, select “Use primary” . This specifies
that the system will load the contents of the primary accumulator into
the TEMPLEXC field.

The Edit Accumulator Entry dialogue should now look like this:

Edit Accumulatar Entry E3

Prirnany Aczurrubsto |u H Harna IExhandB-:I Prize | i |
Operalicee m
Frsl  [Use pimay [#] Hliemate Aocum | |

Sezond | (2]

Thid | 12|

Fourh | 1]

27. Click CK to add the accumulator.

The Advanced section of the Field Properties dial ogue should now look
likethis:

Advanzad

[¥ Use Skanderd Aule
) Salect 1 Updale 1 Congtant 8 UgedAccom ©) Loap Cowt 1 Usa Coda

Frimang Acacurnlaton Op1 Op2 0Op3 dpd
[-Extandad Frice Uee Hew,.

Charge...

28. Click OK on the Field Properties dialogue to add the standard rule to the
TEMPLEXC field. Thisloads the extended price for the current line
item into the TEMPLEXC field.
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After you calculate the extended price, you can map it from the TEMPLEXC
field directly to the ILD:2 LEXC element (Extended Line Cost (Excluding
VAT)).

Complete the following steps to map the extended line cost (excluding

VAT):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field TEMPLEXC in the INVDETAIL record.
When you click the field, the cursor changesto a“Link
AITOW”: | e

Click the ILD:2 LEXC element (Extended Line Cost (Excluding VAT)).

4. Alineisdisplayed, visualy illustrating the link between the
TEMPLEXC field and the ILD:2 LEXC element.

This section describes the actions necessary for you to map from each field
inthe TEMPVATSTL record (temporary storage for VAT subtotals). The
TEMPVATSTL record contains temporary storage fields to enable VAT
subtotal calculations. The temporary storage record is conditional and occurs
up to 20 times per invoice trandated (once for each possible VAT code
subtotal).

The BILLTOACCTTSfield is part of the application file format key, but
does not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on this field.

The DOCTYPTSfield is part of the application file format key, but does not
contain data that the system needs to use to generate the invoice. Therefore,
you will not perform any mapping operations on this field.

The INVNUMTSfield is part of the application file format key, but does not
contain data that the system needs to use to generate the invoice. Therefore,
you will not perform any mapping operations on this field.

The SEQA field will be used in an extended rule later in this tutorial, to
calculate the subtotals for the various VAT tax rates used in thisinvoice, and
to produce a summary of all the VAT rates. The SEQA field can be directly
mapped to the STL SEQA:7 element (First Level Sequence Number), by
using the Link function
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Complete the following steps to map the first level sequence number

(SEQA):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field SEQA in the TEMPVATSTL record. When
you click the field, the cursor changesto a“Link Arrow”: |

Click the STL SEQA:7 element (First Level Sequence Number).

A lineisdisplayed, visualy illustrating the link between the SEQA field
and the STL SEQA:7 element.

The VATRATE field will be used in an extended rule later in this tutorial, to
calculate the subtotals for the various VAT tax rates used in thisinvoice, and
to produce a summary of all the VAT rates. The VATRATE field can be
directly mapped to the STL VATP:2 element (VAT Rate Percentage), by
using the Link function.

Complete the following steps to map the VAT rate percentage (VATRATE):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field VATRATE in the TEMPVATSTL record.
When you click the field, the cursor changesto a“Link Arrow”.

Click the STL VATP:2 element (VAT Rate Percentage).

4. Alineisdisplayed, visualy illustrating the link between the VATRATE
field and the STL VATP:2 element.

The VATRATECODE field will be used in an extended rule later in this
tutorial, to calculate the subtotals for the various VAT tax rates used in this
invoice, and to produce a summary of all the VAT rates. The
VATRATECODE field can be directly mapped to the STL CD12:2 element
(VAT Rate Category Code), by using the Link function.

Complete the following steps to map the VAT rate category code
(VATRATECODE):

1. If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field VATRATECODE in the TEMPVATSTL
record. When you click thefield, the cursor changesto a“Link Arrow”.
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3. Click the STL CD12:2 element (VAT Rate Category Code).

4. Alineisdisplayed, visualy illustrating the link between the
VATRATECODE field and the STL CD12:2 element.

The NUMLINES field will be used in an extended rule later in this tutorial,
to calculate the subtotals for the various VAT tax rates used in thisinvoice,
and to produce a summary of all the VAT rates. The NUMLINES field can
be directly mapped to the STL NRIL element (Number of Line Items), by
using the Link function.

Complete the following steps to map the number of lineitems
(NUMLINES):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field NUMLINES in the TEMPVATSTL record.
When you click the field, the cursor changesto a*“Link
AITow”: | e

Click the STL NRIL element (Number of Line Items).

A lineisdisplayed, visualy illustrating the link between the
NUMLINESfield and the STL NRIL element.

The LVLA field will be used in an extended rule later in this tutorial, to
calculate the subtotals for the various VAT tax rates used in thisinvoice, and
to produce asummary of all the VAT rates. You will use the Link function to
directly map the LVLA field to three different elementsin the EDI file: the
STL LVLA element (Lines Sub-Total (Excluding VAT)), the STL EVLA
element (Extended Sub-Total Amount (Excluding VAT)), and the STL
ASDA element (Extended Sub-Total Amount (After Settlement Discount
Has Been Approved)).

Complete the following steps to map the line subtotal amount (LVLA):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field LVLA inthe TEMPVATSTL record. When
you click the field, the cursor changesto a“Link Arrow”.

Click the STL LVLA element (Lines Sub-Total (Excluding VAT)).

4. Alineisdisplayed, visualy illustrating thelink between the LVLA field
and the STL LVLA element.
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5. Click the application field LVLA in the TEMPVATSTL record again.
When you click the field, the cursor changesto a“Link
Arow”: ||k

6. Clickthe STL EVLA element (Extended Sub-Total Amount (Excluding
VAT)).

7. Alineisdisplayed, visualy illustrating the link between the LVLA field
and the STL EVLA element.

8. Click the application field LVLA inthe TEMPVATSTL record again.
When you click the field, the cursor changesto a“Link Arrow”.

9. Click the STL ASDA element (Extended Sub-Total Amount (After
Settlement Discount Has Been Approved)).

10. Alineisdisplayed, visually illustrating the link between the LVLA field
and the STL ASDA element.

The VATA field will be used in an extended rule later in thistutorial, to
calculate the subtotals for the various VAT tax rates used in thisinvoice, and
to produce a summary of all the VAT rates. The VATA field can be directly
mapped to the STL VATA element (VAT Amount Payable), by using the
Link function.

Complete the following steps to map the VAT Amount Payable (VATA):

1. If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field VATA in the TEMPVATSTL record. When
you click the field, the cursor changesto a“Link Arrow”.

Click the STL VATA element (VAT Amount Payable).

A lineisdisplayed, visudly illustrating the link between the VATA field
and the STL VATA element.

This section describes the actions necessary for you to map from each field
intheINVSUMMARY (summary) record. The INVSUMMARY (summary)
record contains the total invoice amount. The summary record is mandatory
and occurs once per invoice translated.

The BILLTOACCTSUM field is part of the application file format key, but
does not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on this field.
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The DOCTYPSUM field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on thisfield.

The INVNUMSUM field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you will not perform any mapping operations on this field.

For the system to create output segments, there must be at least one explicit
link to an element in that segment, and data to support that link. Therefore,
even though you are mapping the total amount with extended rules later in
thistutorial, you must add an explicit link with an application field that
contains data. The TOTALAMOUNT field can be directly mapped to the
TLR TPSI element (Total Amount Inc Settlement), by using the Link
function, so that the system will be able to create the TLR segment.

Complete the following steps to map the total payable including settlement
(total amount):

1. If theLinking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the application field TOTALAMOUNT in the INVSUMMARY
record. When you click the field, the cursor changesto a“Link
AITowW™: |k

Click the TLR TPSI element (Total Amount Inc Settlement).

A lineisdisplayed, visualy illustrating the link between the
TOTALAMOUNT field and the TLR TPSI element.

To calculate the subtotals (STL) for the various VAT rates, you must first
determine which VAT code is used for each line item. By grouping the line
items that use the same VAT code, you can determine the VAT rate
percentage, and then calculate the total VAT amount payable for each VAT
code. Then, you can add the extended cost for each line item that uses the
same VAT code together. Finally, by adding the total VAT amount payable
(VATA) with the total extended cost (ASDA), you have cal culated the sub-
total amount (APSI) for each group of line items with the same VAT code.

To perform these calculations, you a so will need to track the sequence
numbers of each subtotal (STL), the VAT code and corresponding VAT
percentage rate for each STL, and the total number of line items that use
each VAT code.
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Thefollowing isan example of an application file that contains six lineitems
that use three different VAT codes. “S’ (Standard rate), “E” (Export item),
and“Z" (Zerorate).

Extended Cost

L&Ziﬁ'ﬁ? C\:/c')AdTe (Quantity Shipped *Unit
Price)
1 Item 1 S 100
2 Item 2 E 50
3 Item 3 S 200
4 Item 4 z 70
5 Item 5 S 150
6 Item 6 E 300

Thefollowing are the corresponding VAT percentage ratesfor the VAT codes
used in the above example:

C\Zlfc;re VAT Percentage Rate
S 17.5
E 0
z 0

From this, you can calculate the required VAT summary information:

STL VAT Number of Line Total Total VAT Subtotal
Sequence Code Items Using this Extended Cost Amount Amount
Number VAT Code (ASDA) (VATA) (APSI)
1 S 3 450 18 468
2 E 2 350 0 350
3 z 1 70 0 70

To perform the required VAT calculations in this tutorial, you will use two
extended rules. The first extended rule you will defineisan On End rule on
the INPUT (application file) group that will be executed when the system
concludes its processing of the application file. For each VAT code used, the
first rule will calculate the total VAT amount payable and the extended cost
for each set of lineitems. The second extended rule you will defineison the
STL APSI element, and will be executed when the system concludesiits
processing of that element. The second rule will add the total VAT amount

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 201



Mapping Your Data Outbound Invoice (INVOIC)

payable (VATA) to the total extended cost (ASDA), to calculate the sub-total
amount (APSI) for each group of line items with the same VAT code.

Thefirst extended rule (on the INPUT group) will involve many different
calculations. So, you determinethat it will be easiest if you break the various
tasks involved into manageable pieces, and write the rule for that part before
building al the partsinto thewholerule. This processis outlined in the steps
below.

Theextended rulesareindicated with bold typeface (A
isused for aline continuation character).

1. You need to define two temporary variables (“i” and “j”), avariable
defined to count the number of lineitems (“invlimit”), and avariable to
count the number of STL segments (“stllimit”) that isinitialised to zero.

integer i,j,invlimit,stllimit;
invlimit = count($INVDETAIL[*]);
stilimit = 0;

You need to visit each iteration of the INVDETAIL record.

i=1;
whilei <= invlimit do
begin

i=i+1;
end
2. For eachiteration of the INVDETAIL record, you need to determine the

VAT code used, and ascertain whether or not a TEMPVATSTL (STL)
record exists for that VAT code.

=1
whilej <= stllimit do
begin
if SINVDETAIL[i].#VATCODE =
A $STEMPVATSTL[j]#VATRATECODE then

begin
end
=+
end
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3.

If aTEMPVATSTL record does exist for that VAT code, you need to add
the extended cost for that line item into the total extended cost for this
STL, and increase the number of lineitemsin this STL by one.

begin

$TEMPVATSTL[j]#LVLA = $STEMPVATSTL[j]#LVLA +
ASINVDETAIL[i]#TEMPLEXC;

$TEMPVATSTL[j]#NUMLINES =
ASTEMPVATSTL[j]#NUMLINES + 1;

break;

end

If aTEMPVATSTL record does not exist for that VAT code, you need to
create an STL for that VAT code, set the sequence number to the line
item number, set the VAT rate percentage, set the STL number, and set
the total extended cost to be the extended cost of that line item.

$TEMPVATSTL[j] #SEQA =j;
$TEMPVATSTL[j] #VATRATE =

ATON($INVDETAIL[i] #4TEM PVATRATE);
$TEMPVATSTL[j] #VATRATECODE =
$INVDETAIL[i] #VATCODE;
$TEMPVATSTL[j]#LVLA = $INVDETAIL[i] #TEMPLEXC;
$TEMPVATSTL[j] #NUMLINES = 1;

Finally, you need to calculate the VAT amount that is payable for each
STL.

=L

whilej <= stllimit do

begin

STEMPVATSTL[j].#VATA = (STEMPVATSTL[j]#LVLA *
ASTEMPVATSTL[j].#VATRATE) / 100.0;

j=i+L

end

Now you need to combine al the pieces that you wrote into one extended
rule, including the necessary keywords to define loops. The extended rule
should be executed when the system concludes its processing of the
application file (INPUT group).

Complete the following steps to create the extended rule;

1. Click the INPUT group with the right mouse button to access the

shortcut menu.
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2. From the shortcut menu, select Extended Rules... to display the Loop
Level Extended Rules dialogue.

3. Click the On End radio button to specify that the rule is executed when
the loop terminates. The system executes this rule when it has
concluded its processing of the application file.

4. Inthe Editor list box, type the following (or copy from the
PET_TINV.MAP provided for you with the tutorial datain the
GENTRAN Directo\TUTORIALS subfolder):
integer i,j,invlimit,stllimit;
invlimit = count($INVDETAIL[*]);
stilimit = 0;
i=1;
whilei <=invlimit do
begin

=L
whilej <= stllimit do
begin
if SINVDETAIL[i].#VATCODE =
$TEMPVATSTL[j] #VATRATECODE then
begin
$TEMPVATSTLI[j].#LVLA = STEMPVATSTL[j] #LVLA +
AS$INVDETAIL[i] #TEMPLEXC;
$STEMPVATSTL[j] #NUMLINES =
ASTEMPVATSTL[j]#NUMLINES + 1;
break;
end
=i+
end
if j > stllimit then
begin
$TEMPVATSTL[j] #SEQA =j;
STEMPVATSTL[j] #VATRATE =
AATON($INVDETAIL[i] #TEMPVATRATE);
$TEMPVATSTL[j] #VATRATECODE =
AS$INVDETAIL[i] #VATCODE;
$TEMPVATSTL[j] #LVLA = $INVDETAIL[i] #TEMPLEXC;
$TEMPVATSTL[j] #NUMLINES = 1;
stilimit = j;
end
i=i+1;
end
=L
whilej <= stllimit do
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begin

$STEMPVATSTL[j] #VATA = ($STEMPVATSTL[j].ALVLA *

ASTEMPVATSTLI[j].#VATRATE) / 100.0;

=ity

end
5. Click COWPI LE to validate the syntax of the extended rule. Every rule

in the map will be compiled when you compile the trand ation object,
after you complete the map. However, the system allows you to compile
each ruleindividualy, so that you can verify the accuracy of therule
after you createiit.

The Compile function will compiletherule
interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated inthe
compilation process will be displayed in the Compile
Errorslist box.

6. Click OK to add the extended rule to the INPUT group (application
file).

Using an extended rule  The second extended rule will add the total VAT amount payable (VATA)
to calculate the amount  with the total extended cost (ASDA), to cal cul ate the sub-total amount
payable for each STL  (APS|) for each group of line items with the same VAT code. The extended
rule should be executed when the system concludes its processing of the
STL APSI element.

Complete the following steps to create the extended rule:

1. Double-click the STL APSI element (Payable Sub-Total Amount
Including Settlement Discount) to access the Field Properties dialogue.

| izl | 'opoatics
e [
[ e=riphion | BOUNT INCLUDING SETTLEMEMT DISCOUMT
O
Wlin ke Type Famnzt —
F Madalon |1 |12 [rmter [#] [n2 (2] A

2. If the Advanced section of the dialogueis not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Click RULE... to display the Field Level Extended Rule dialogue.
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4. IntheRulelist box, type the following (or copy from the
PET_TINV.MAP provided for you with the tutorial datain the
C:\Program Files\Sterling Commerce\ GENTRAN
Directo\TUTORIAL S\ subfolder):

#APSI = #ASDA + #VATA,;

The system will execute this rule when it processes the STL APSI
element.

5. Click COwPI LE to vaidate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the translation object,
after you complete the map. However, the system allows you to compile
each ruleindividualy, so that you can verify the accuracy of the rule
after you createit.

interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated in the
compilation process will be displayed in the Compile
Errorslist box.

Q The Compile function will compiletherule

6. Click OKto add the extended rule to the STL APSI element.
7. Click CLOSE to exit the Field Properties dialogue.

You already used an explicit link (the TOTALAMOUNT field to the STL
TPSI element) so the system will be ableto create the TLR segment (Invoice
Trailer). Now, you need to calculate the total amount (extended cost) of all
thelineitemsintheinvoice (LVLT) and thetotal VAT amount payablefor all
thelineitemsin the invoice (TVAT). This calculation is the sum of all the
STL segmentsthat you calculated in the last section of this tutorial.

Also, because you are not using settlement discounts, you can set the EVLT
(Total Extended Amount Excluding Settlement Discount) and the ASDT
(Total Amount Excluding VAT Including Settlement) equal to the LVLT
(Lines Total Amount (Excluding VAT)). You can also set the TPSI equal to
the ASDT (Total Amount Excluding VAT Including Settlement) plus the
TVAT (Total VAT Amount Payable).

You will use an extended rule on the TLR NSTL element (Number of Total
Segments) to calculate these totals. This rule will involve many different
calculations. So, you determinethat it will be easiest if you break the various
tasksinvolved into manageabl e pieces, and write the rule for that part before
building al the partsinto the wholerule. This processisoutlined in the steps
below.
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The extended rulesareindicated with bold typeface (A
Q isused for aline continuation character).

1. You need to define avariable to count the number of TEMPVATSTL
records (“limit”), define atemporary variable (“i”) that is set to one, and
initialisethe TLR LVLT and TLR TVAT elementsto zero.

integer i,limit;

limit = count($TEMPVATSTL[*]);
i=1;

#LVLT =0;

H#TVAT =0;

2. You need to visit each iteration of the TEMPVATSTL record.

whilei <=limit do
begin
i=i+1;
end

3. You need to calculate the total amount (extended cost) of al the line
itemsin theinvoice (LVLT) and the total VAT amount payable for al
thelineitemsin the invoice (TVAT).

#LVLT =#LVLT + STEMPVATSTL[i].#LVLA;
H#TVAT = #TVAT + STEMPVATSTLIi] #VATA;
4. You need to set the NSTL (Number of Total Segments) equal to the
number of TEMPVATSTL records.
#NSTL = limit;

5. You need to set both the EVLT (Total Extended Amount Excluding
Settlement Discount) and the ASDT (Total Amount Excluding VAT
Including Settlement) equal to the LVLT (Lines Total Amount
(Excluding VAT)).

#EVLT =#LVLT,
#ASDT = #LVLT,

6. Finaly, you need to set the TPSI equal to the ASDT (Total Amount
Excluding VAT Including Settlement) plus the TVAT (Total VAT
Amount Payable).

#TPSI =#ASDT + #T VAT,
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Using an extended rule  Now you need to combine all the pieces that you wrote into one extended
to calculate TLR totals  rule, including the necessary keywords to define loops.

Complete the following steps to create the extended rule:

Double-click the TLR NSTL element (Number of Total Segments) to
access the Field Properties dialogue.

1

izl 'epoitic:
1
Desciiion  [NUMBER OF TOTAL SEGMENTS
alaWaidation
Min Mas  Typs Famnat —
W Wandaioy [1 [10 [uumeer [8] o (] Cordilior. .

2.
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If the Advanced section of the dialogue is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

Click RULE... to display the Field Level Extended Rule dialogue.
In the Rule list box, type the following:

integer i,limit;

limit = count($TEMPVATSTL[*]);

i=1;

#LVLT =0;

#TVAT =0;

whilei <= limit do

begin
#LVLT =#LVLT + STEMPVATSTL[i] #LVLA;
#TVAT = #TVAT + STEMPVATSTL[i] #VATA;
i=i+1;

end

#NSTL = limit;

H#EVLT =#LVLT;

#ASDT = #LVLT,

#TPS| = #ASDT + #TVAT;

The system will execute this rule when it processesthe TLR NSTL
element.
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5. Click COVPI LE to validate the syntax of the extended rule. Every rule
in the map will be compiled when you compile the trang ation object,
after you complete the map. However, the system allows you to compile
each ruleindividualy, so that you can verify the accuracy of the rule
after you createit.

The Compile function will compiletherule
interactively, and allow you to correct any errorsthat
aregenerated. Any errorsor warningsgenerated inthe
compilation process will be displayed in the Compile
Errorslist box.

6. Click CK to add the extended rule to the TLR NSTL element.
7. Click CLOSE to exit the Field Properties dialogue.
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Finalising the Map

After you create the import map, define your application file format, and
perform the appropriate mapping operations, you need to finalise the map.
To complete the mapping process, you need to save the map, compile the
trandation object, print and review the Sterling Gentran:Director report, and
test the map.

Compiling the
Map The Compile function compiles the map and generates a translation object.
The map that you created using Sterling Gentran:Director
(PET_TINV.MAP) is a source map. When that source map is compiled, the
result is a compiled translation object.

This trandation object will need to be registered with the Sterling
Gentran:Director system before you can use it. You will use the Compile
function after the map is completed and saved.

Complete the following steps to compile a map and generate atranslation
object:

1. Select Save from the File menu to save the source map, prior to using
the Compile function.

2. Select Compile from the File menu to display the Run-Time Tranglation
Object Name dialogue.

Aun-Time Translation Object Hame

Save n: |'E Trans0bj j gl Ig

File name: IF'et_tin\-'.TF'L
Save az lype: ITransIatiu:un Objects [*. TFL) ﬂ Cancel |

3. The“Filename’ field will already contain “PET_TINV.TPL". Thisis
the name of the trandation object, using the default . TPL file extension
and our recommendation that you name the translation object (. TPL
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file) the same filename (one to eight characters long) as you named the
map (.MAP file). Preserving the same filename (with different file
extensions) means that the relationship between the source map and the
compiled translation object will remain evident.

Be very careful not to overlay the source map with the
compiled translation object. Usethe.TPL fileextension
to distinguish the translation object.

4. Changethe Drive and Folder where the compiled trandlation object will
be stored, if necessary.

Do not store the compiled trandation object in the
GENTRAN Director\RegTransObj subfolder. This
subfolder isreserved for storing a copy of each
translation object you register with Serling
Gentran:Director.

5. Click SAVE and the system will compile the map and generate a
tranglation object. The Compile Error dialogue is displayed. Verify that
no errors occurred and click OK to exit the dialogue. The date on which
the transl ation object was compiled will be automatically |oaded into the
Compiled on field on the Trand ation Object Details dialogue.

A kher Diezcliption Traredation Object Function Spetem

Staring |m~mnu1 9IMYOIC Import Ilmpnlt |£| r ITI
CE|

Memon Conbd

Major walgion I'I Minar version IEI Compiled o |ES-EIct-1EEE

EDI Associalions

Irput Output

——

Yerzmn I

| [a001 | TRADACOMS LINIT

Tram=achon I

S i

| ||an||: ||Nun||:E DETAILS

F Group I

| ||Nv1:|||: |

6. Select Save from the File menu to save the source map with the
Compiled on date.

7. You must register this translation object with the Sterling
Gentran:Director system before you can use it. See the Sterling
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Gentran:Director documentation for information on registering a
tranglation object.

The Sterling Gentran: Director report enables you to validate and review the
map, and make modifications as needed. If you review the report and
determine that the map isincorrect, you should reiterate the mapping process
as many times as necessary (make the modifications, save the map,
recompile the translation object, and print the report again).

Complete the following steps to print the Sterling Gentran:Director report:

1. Select Print from the File menu or the Main Toolbar to access the Print
Options dialogue.

— Report sections

Iv| Print branching diagram
¥ Print record details ﬂl
¥ Print mapping details
¥ Print extended rules

¥ PFrint code lists

W Include only active objects

2. Accept the defaults on this dialogue (all options checked), so the report

will include all sections and only the activated map components. Click
OK and the Print dialogue is displayed.

3. Set the appropriate options. Click OK if you do not need to change

Setup options, and the mapping report will be printed.

Click SETUP... if you need to access printer setup information (to select
a specific printer, paper orientation, or size and source of paper). The
Print Setup dialogueis displayed as follows:

4. Set the appropriate options. Click OK if you do not need to change Print

Options (dithering, intensity control, or print true type as graphics), and
you will return to the Print dialogue. Click OK on the Print dialogue and
the mapping report will be printed.

Click OPTI ONS... if you need to access printer setup options
information. The Options dialogue is displayed.
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5.

Set the appropriate options. Click OK to return to the Print Setup
dialogue. Click OK on the Print Setup dialogue to return to the Print
dialogue. Click OK on the Print dialogue and the report will be printed.

Testing the

Translation After you compile the map, print and verify the report, and register the
Object trandation object with Sterling Gentran:Director, you should test the
translation object to verify that the datais translated correctly. To test the
compiled trandlation object, you should obtain test data from your partner(s)
and processthe data. You should also verify acknowledgement processing (if
applicable) and verify communications with your network.

Complete the following steps to test the system import (HEADER_T.TPL)
and import (PET_TINV.TPL) trandlation objects:

1

Register the HEADER_T.TPL and PET_TINV.TPL trandlation objects

with Sterling Gentran:Director. Please see the IBM® Serling
Gentran: Director® Release 5.5 User Guide for more information on
registering a trandlation object.

If you have not already done so, import the PETZONES3.PAR partner
relationship into Sterling Gentran:Director. Please see the IBM®
Serling Gentran: Director® Release 5.5 User Guide for more
information on importing a partner.

The default full path for the partner fileis: C:\Program Files\Sterling
Commerce\ GENTRAN DirectonTUTORIAL\PETZONE3.PAR

Import the division lookup table (INVATCO.LKP) for the system
partner (<Internal System User>) into Sterling Gentran:Director. Please
see the IBM® Serling Gentran: Director® Release 5.5 User Guide for
more information on importing atable.

The default full path for the lookup table is: C:\Program Files\Sterling
Commerce\ GENTRAN DirectonTUTORIAL\INVATCO.LKP

Verify (in Partner Editor) that the PET T ANAOOL 9 INVOIC Import
trandation object is selected for the Outbound Relationship. Please see
the IBM® Serling Gentran: Director® Release 5.5 User Guide for more
information on selecting outbound trandlation objects.

Ask your system administrator to add the system import translation
object (HEADER_T.TPL) to the System Configuration program. Please
see the IBM® Serling Gentran: Director® Release 5.5 Administration
Guide for more information about how your system administrator will
need to modify the system configuration program.
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Use the Import option in Sterling Gentran:Director to process the data
file (PET_TINV.TXT) through the translation object. The datafile will
be located in the TUTORIAL subfolder under the folder where Sterling
Gentran:Director isinstalled.

The default full path for the datafileis: C:\Program Files\Sterling
Commerce\GENTRAN DirectonTUTORIAL\PET_TINV.TXT

Please see the Sterling Gentran:Director IBM® Serling
Gentran: Director® Release 5.5 User Guide for more information on
importing files.

After the message istranslated, it will be located in the Workspacein
Sterling Gentran:Director. View the EDI datato ensure that the message
was trandlated correctly. Please see the IBM® Serling

Gentran: Director® Release 5.5 User Guide for more information on
viewing raw EDI data.
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Notices

This information was devel oped for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the products
and services currently available in your area. Any reference to an IBM product,
program, or serviceis not intended to state or imply that only that IBM product,
program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead.
However, it isthe user's responsibility to evaluate and verify the operation of any non-
IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.SA.

For license inquiries regarding double-byte character set (DBCS) information, contact
the IBM Intellectual

Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi
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Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions areinconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "ASIS' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
youl.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for thisIBM
product and use of those Web sitesis at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs
and other programs (including this one) and (ii) the mutual use of the information
which has been exchanged, should contact:

IBM Corporation

JBA/GA

555 Bailey Avenue

San Jose, CA__95141-1003
U.SA.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of afee.
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The licensed program described in this document and al licensed material available
for it are provided by IBM under terms of the IBM Customer Agreement, IBM
International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary
significantly. Some measurements may have been made on devel opment-level
systems and there is no guarantee that these measurements will be the same on
generdly available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-1BM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has
not tested those products and cannot confirm the accuracy of performance,
compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-1IBM products should be addressed to the suppliers of those
products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Thisinformation is for planning purposes only. The information herein is subject to
change before the products described become available. Thisinformation contains
examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examples include the names of individuals, companies,
brands, and products. All of these names are ficticious and any similarity to the names
and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programsin source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to IBM,
for the purposes of developing, using, marketing or distributing application programs
conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly
tested under all conditions. IBM, therefore, cannot guarantee or imply reliability,
serviceability, or function of these programs. The sample programs are provided "AS
IS', without warranty of any kind. IBM shall not be liable for any damages arising out
of your use of the sample programs.

IBM Sterling Gentran:Director Application Integration TRADACOMS Tutorial Guide May 2011 217



Notices

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations
may not appear.
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Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies. A
current list of IBM trademarks is available on the Web at “ Copyright and trademark
information” at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or
other countries.

IT Infrastructure Library is aregistered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States and
other countries.

Linux isaregistered trademark of Linus Torvaldsin the United States, other countries,
or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL isaregistered trademark, and a registered community trademark of the Office of
Government Commerce, and is registered in the U.S. Patent and Trademark Office.

UNIX isaregistered trademark of The Open Group in the United States and other
countries.

Javaand all Java-based trademarks and logos are trademarks or registered trademarks
of Oracle and/or its affiliates.

Cell Broadband Engineis atrademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks
of HR, IBM Corp. and Quantum in the U.S. and other countries.
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Notices

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran: Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of
others.
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Glossary

?In Documents This Sterling Gentran:Director browser contains alist of documents that
were received by the system but failed compliance checking or that do not
have an identifiable partner or transaction set.

?0ut Documents This Sterling Gentran:Director browser contains alist of documents that
were imported into the system via unattended processing but are invalid.

acknowledgement Thistermisused toindicate the ANSI 997 functional acknowledgement, the
EDIA 999 acceptance/rejection advice, and the EDIFACT CNTRL
document.

activation This function enables you to make map components available for use. The
system activates all the groups, segments, composites, and elements that are
defined as “mandatory” (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, composites,
and elements. When tranglating data, the system does not process groups,
segments, composites, and elements (or records and fields) that are not
activated. Therefore, you must activate the groups, segments, composites,
and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

AIAG The Automotive Industry Action Group (AIAG) isthe standards-setting
group for the automotive industry. The standards form a subset of the ANSI
X12 standard.

ANA  Article Numbering Association.

ANSI American National Standards Institute. ANSI sets standards for many
products and services, such as safety glasses and battery capacities. The
ANSI X12 committeeisthe chief EDI standards-setting organization for the
United States.

application file If you are creating an import or export map, you must define your
application to Sterling Gentran:Director. In Sterling Gentran:Director
terminology, your application fileisalso referred to as afixed-format file or a
positional file. Your application file must contain al theinformation that you
either need to extract from your partner’s document (if the map isinbound)
or need to send to your partner (if the map is outbound), so that your system
can accurately process the data.
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browser

button

check box

click

code list tables

colours

communications
session

Communicator

compile

compliant
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Computer systems, outside of EDI, designed to fulfill specific business
functions. These include accounting, purchasing, materials control, human
resources, shipping, and other systems.

A browser isawindow that displaysalist of items, such as documents
(transaction sets), interchanges, trand ation objects, etc. A document browser
displays only documents.

A button enables you to execute a command. You select a button either by
clicking it or by pressing TAB until the button you want is selected and then
pressing ENTER. Unavailable buttons are dimmed, and the currently
selected button has a darker border than the other buttons.

A check box enables you to select or clear options from alist. You can select
as many options from the list as you need. A selected check box contains a
checkmark. The labels of unavailable options are dimmed.

Click indicates that you should position your cursor on top of the designated
item and press and release your primary mouse button. The primary mouse

button is the button you access with your index finger, regardless of whether
you are utilizing right-handed or left-handed mouse operation.

These are used by EDI standards as repositories for lists of codes. Each EDI
standard provides a code list for each element that can be further defined
with acode.

This feature enables you to select foreground and background coloursto
visually define the various map components. The use of colour is optional.

Everything sent and received to/from one tel ephone number in one
continuous period of connection. This could include sending two or three
interchange envelopes to a network, each for a different trading partner.

Thisisthe Sterling Gentran:Director communications software. The
Communicator enables you to send, receive, resend, establish
communication port definitions, establish communication profiles, establish
communication scripts, and view and delete communication sessions.

This function compiles the map and creates a trand ation object. The map
that you create using Sterling Gentran:Director is a source map. When that
source map is compiled, the result is a compiled trandation object. This
translation object will need to be registered with the Sterling
Gentran:Director system before you can use it.

This means that the document conforms to the EDI standards as defined by
the translation object.
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component data
element

composite data
element

conditions

constant

cross-reference table

date/time

deactivation

default

dialog box

document

A simple data element that belongs to a composite data element. Component
data elements are also called sub-elements.

A contains two or more component data elements or sub-elements.
Composites are defined by the EDI standards that use them (EDIFACT,
TRADACOMS, and certain ANSI X 12 standards).

Seerelational conditions.

This standard rule enables you to move aliteral constant value to the
specified element or field, indicate a qualifying relationship with another
element or field, and map the current date or time to the specified element or
field.

Thistable is created in Partner Editor and is used to convert your values to
your trading partner's values during outbound processing, or your partner's
values to your values during inbound processing.

Thistype of field or element contains a date or time. If you specify that a
field or element will be a date/time type, you must specify exactly how the
date or time must be formatted.

This function enables you to make map components unavailable for use by
the system. The system does not enable you to deactivate the mandatory
groups, segments, composites, and elements.

A predefined value — programs use these built-in values unless you
specifically override them.

A dialog box (or dialog) contains additional information or options that you
need to act on. If you specify any options, you can select a button to execute
the command. Some dialog boxes display warnings or messages indicating
why arequested task cannot be accomplished. If the dialog box has atitle
bar, you can move it to another location on your desktop.

One transaction set containing actual data and treated as a single entity. The
amount of data does not affect whether something is a document or not, only
thefact that it istreated asasingle entity. For example, regardless of whether
apurchase order contains one item or ten thousand, if it is one purchase
order, it is one document.

If atrading partner sends you a communication containing 10 purchase
orders, you have received 10 documents. |f the communication contained 15
invoices, you have received 15 documents.
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EDI standard

EDIA
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Thisindicates that you should position your cursor on top of the designated
item and quickly press and release your primary mouse button twice. The
primary mouse button is the button you access with your index finger,
regardless of whether you are utilizing right-handed or | eft-handed mouse
operation.

International Article Numbering Association, Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can
exchange business documents directly from application to application by
computer without paper documents being produced.

Thisisthe rules for turning a business document into an EDI document.

The Electronic Data I nterchange Association, formerly known asthe
Transportation Data Coordinating Committee (TDCC).

Thisis the standards organization of the United Nations Economic and
Social Council. The acronym is short for the Electronic Data I nterchange for
Administration, Commerce, and Transport.

The smallest piece of usableinformation defined by the standards. Examples
might include a quantity, unit price, or description. An individual element
can have somewhat different meanings depending on context. Therefore,
elements are normally not considered to have useful meaning until they are
combined into segments. An element isthe EDI map component that is
mapped (linked) to a corresponding application field to move data to and
from the EDI file.

There are three types of data elements, asillustrated in the table below:

Data Element Definition

Simple data element A single piece of information defined by
the standards.

Composite data A data element that is made up of

element multiple component elements.

Component data A simple data element that belongs to a

element composite data element. Component
data elements are also called sub-
elements.
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envelope A way of separating information in transmissions for ease of processing.
Each envelope contains a header segment and a trailer segment, which
separate the envel ope from other envel opes and provide information about
the contents of the envelope.

There are three levels of envelopes, asfollows:

Transaction Set
Each transaction set (business document) is contained within a transaction
set envelope.

Functional Group

An envelope containing related business documents. The standards define
which transaction sets should be placed together into a functional group
envelope.

I nterchange Envelope

All material being sent to one trading partner in one communication. The
term Interchange Envelope is the term used by ANSI. EDIA uses the term
Transmission Envelope to refer to thislevel of envelope. Since we use the
term transmission for other uses, we will refer to Interchange Envelope only.

A communications session could easily include a

number of interchange envelopes. For thisreason, the
standar ds-setting bodies are considering a fourth level
of envelopeto cover an entire communications session.

equalize Thisfunction enablesyou to reinstate the two sides of the map with focusin
equal dimensions. The use of the Equalize function is optional.

export map This map defines how to move data from the EDI standard-formatted
documents that your partners send you to your application file (flat file
definition). An export map is necessary for inbound processing.

export translation  See export map.
object
extended rules These rules enable you to use a Sterling Gentran:Director proprietary
programming language to perform virtually any mapping operation you
require.

field The smallest piece of information defined in the application file. A field is
the application map component that is mapped (linked) to a corresponding
EDI element to move data to and from your application file.

fixed-format file Seeapplication file.
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font

functional group

group

import

import map

import translation

object

inbound mapping
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In Drawer

In Documents

May 2011

This feature enables you to globally change the font that is used in the
display of all maps. The default font that Sterling Gentran:Director usesis a
Sans Serif 9 point. The Font feature enables you to change the font type,
style, and point size. This gives you the flexibility to shrink the font if you
need to view more of the map on your monitor, enlarge the font, or change
the type and style to be more easily readable by you.

A group of transaction sets that the standards-setting body (such as ANSI)
has defined as fitting together with other related transaction sets. An
example might be a Functional Group defined as containing al purchasing
transaction sets.

A looping structure that contains rel ated records/segments and/or groups that
repeat in sequence until either the group data ends or the maximum number
of timesthat the loop is allowed to repeat is exhausted. If you create a group
that is subordinate to another group (a sub-group), this correspondsto a
nested |ooping structure (aloop within aloop). The application (positional)
file and the EDI file are both groups and therefore, they isvisually
represented the same way as other groups and sub-groupsin Sterling
Gentran:Director.

This command enables you to import data from an external application file.
Depending on the content of thefile, the system may prompt you for partner,
transaction, or translation object information.

This map defines how to move data from your application file (flat file
definition), which may contain multiple documents, to the EDI standard-
formatted documents that your partners expect to receive from you. An
import map is hecessary for outbound processing.

See import map.

The system tranglates your trading partner’s EDI standard formatted
business document to your application file format, so you can receive
documents from you partners. To translate inbound data, you need to create
an export map.

This Sterling Gentran:Director browser contains alist of documents that
were received and processed.

This Sterling Gentran:Director browser contains alist of documents that the
system received but that have not yet been processed by the user. Once the
documents are processed (printed or exported) the documents will be
transferred to the In Drawer.
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integer Aninteger isanumber that has an implied decimal point (e.g., “2.01" is
formatted as “201").

interchange Theinterchange containsall the functional groups of documents (transaction
sets) sent from one sender to one receiver in the same transmission.

Interchanges This Sterling Gentran:Director browser enables you to view a hierarchical
browser list of al the interchanges that were sent or received. It contains status
information about the interchanges, (e.g., whether or not a functional
acknowledgement was received and the status of that acknowledgement).
This browser also enables you to access the documents within the
interchanges. The Interchanges browser can always be accessed.

link Thisfunction enables you to map afield or element from the Input side of
the map to afield or element on the Output side of the map. The link
between two map components (hereafter referred to asfields) is visually
represented with a line connecting the two fields.

list box A list box displaysalist of choices. Scroll bars are provided if there are more
choices than can fit in the box.

literal constant Theseare used by the system as arepository to store information that will be
used at alater point in the map. Typically, constants are used in an outbound
map to generate a qualifier.

location table Thisisatablecreatedin Partner Editor that is used to contain address-related
information about the partner.

lookup table Thisisatable created in Partner Editor that is used to select information
related to avalue in inbound or outbound data.

loop count Thisstandard rule enables you to count the number of timesaloopis
repeated, if the element or field is part of aloop. If the loop is a nested loop,
you can track the current loop or the outer loop. For example, if the'Y loopis
nested within the X loop, and the Y loop has cycled through 15 iterations
and the X loop has cycled through 3 iterations, you can choose to count
either the“15” (Y loop) or the“3” (X loop).

loop start/loop end Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS
and L E segments differentiate between two or more loops of the same type.
If the transaction contains LS and LE segments and depending on whether
your map isinbound or outbound, you will need to definethe LS and LE
segments for the loops you will be using in the map in one of two different

ways.
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map

menu

menu bar

network

number

ODETTE

Out Documents

outbound mapping
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Out Drawer

partner

Partner Editor

positional file

post

May 2011

A set of instructions you define in the Sterling Gentran:Director Application
Integration subsystem that indicates the corresponding relationship between
your application file and the EDI standards, and defines how the system
should trand ate data.

A list of items from which you can choose. Each item represents a
command. Unavailable items on a menu are dimmed to inform you they are
disabled.

This contains the list of menus for the application.

Also known as a Third Party Network or Value-Added Network (VAN). A
service, such as IBM® Sterling B2B Collaboration Network, that accepts
and holds transmissions from companies until it is convenient for atrading
partner to accept them.

Thistype of field or element contains either an integer or real number. If you
specify that afield or element will be a number type, you must designate the
format by specifying aformat of either “N” (integer) or “R” (real) and the
number of decimal places.

The Organization for Data Exchange by Tele-Transmission in Europe.

This Sterling Gentran:Director browser contains a list of documents that are
ready to be sent. After the documents are successfully sent, they are
automatically transferred to the Out Drawer.

The system tranglates your application file format to EDI standard formats,
so you can send documents to your partners. To translate outbound data, you
need to create an import map and a system import map in Sterling
Gentran:Director.

This Sterling Gentran:Director browser contains alist of documents that
were successfully sent out by the system.

Another firm with which your company trades documents. Also referred to
as atrading partner.

This Sterling Gentran:Director function enables you to define, edit, and
delete all partner information for your company and all of your trading
partners.

See application file.

This Sterling Gentran:Director function enables you to move compliant
documents from the Workspace to the Out Documents.
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predefined

printout

promote

qualifier

radio buttons

real number

receive

record

relational condition

respond

responsible agency
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On adata entry translation object, a default value for a particular element.
You can change the value as necessary.

Thisis produced when data received from atrading partner passes through a
print tranglation object. You do not have to actually print the data. The
printout could be to afile on your hard disk.

This function extracts one iteration (instance) of a group or repeating
segment. This enables you to map unique data from your application file,
and/or enter a specialized definition. Sterling Gentran:Director specifies that
only one-to-one (no loops) or many-to-many (loop) mapping relationships
arevalid.

Thisisan element that has a value expressed as a code that gives a specific
meaning to the function of another element. A qualifying relationship isthe
interaction between an element and its qualifier. The function of the element
changes depending on which code the qualifier contains.

Radio buttons indicate a group of mutually exclusive options. You can only
select one option at atime. Select an option by clicking the radio button or
pressing the SPACE BAR until the option you want is selected. The selected
option contains a black dot. The labels of unavailable choices are dimmed.

A real number has an explicit decimal point (e.g., “2.01" isformatted as
“2.01"), and truncates trailing zeroes.

This Sterling Gentran:Director function enables you to manually initiate a
communications session to receive data from your trading partner.

Contains a group of related fields. A record can occur once or can repeat
multiple times.

This function enables to connect fields together for syntax or compliance
reasons. For example, Field A isinvalid unless Field B is present. Therefore,
if you set up acondition that pairs Fields A and B, the system will generate a
compliance error if one of those fieldsis not present.

This Sterling Gentran:Director function enables you to create a turnaround
document (using the Turn Around translation object in the partner
relationship) in response to one or more selected document(s) inthe In
Drawer.

An organization that devel ops and updates standards for EDI
communications. These organizationsinclude ANSI, EDIA, AIAG, UCS,
EDIFACT, ODETTE, and VICS.
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segment

select

send

set
simple mapping

split

standard rules

status bar

string
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A group of related elements or composite data elements that combine to
communicate useful data. Segments are defined by the EDI standards. A
segment can occur once or can repeat multiple times. For example, a catalog
price segment might consist of elementsfor item description, volume, price,
lead time, etc. By themselves, none of these elements would communicate
useful information. Together, they provide the information necessary for
someoneto tell if theitemiswhat is desired, whether the priceis reasonable,
etc. A number of segments together form a transaction set.

This standard rule enables you to select entries from alocation table, cross-
reference table, partner table, or lookup table (all tables created in the
Sterling Gentran:Director Partner Editor). You can then map the fieldsin
those tables to one or morefields in the data. The Select function uses the
value of the current field to perform the selection.

This Sterling Gentran:Director function enables you to manually start a
communications session to send data to your trading partner. Only selected
documents are envel oped and sent. If no documents are selected, ALL
documents will be sent. Successfully sent documents are moved to the Out
Drawer.

See Transaction Set.
Seelink.

This function enables you to split (break) a group or repeating segment into
two loops. You will typically use this function when you need more than one
instance of the same map component that still occurs multiple times.

These rules give you access to functions that are necessary for mapping
operations that are more complex than simple linking, but lessinvolved than
extended rules. Each of the standard rules are mutually exclusive (you can
use only one on a particular field).

The status bar of an application window defines information about a
selection, command, or process, defines Menu Bar items as the user
highlights each item, and indicates any current keyboard-initiated modes for
typing (e.g., CAPfor the“ Caps Lock” key or NUM for the“Num Lock” key,
etc.).

Thistype of field or element contains one or more printable characters. If
you specify that afield or element will be a string type, you must designate
the format by specifying a syntax token.
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syntax token Thisfunction enables you to designate a “token” that defines ranges of
characters and/or numbers that are allowed to be used for a string-type
element or field. You can then use the syntax tokens in the Format field of
the Field Properties dialog. This enables you to define what type of
characters should be used while compliance checking each element/field
(i.e., alphanumeric within a certain range, numeric within a certain range,
etc.).

system import map Thetranglator uses this map to determine which trading relationship
(established in Partner Editor) corresponds to each document in the
application file, so the system will know which import map to use to process
the document. You need a system import map that is defined in
EDIMGRI.INI to translate outbound data.

systemimport See system import map.
translation object

system translation Thesetranslation objects control the creation and separation of interchanges,
object functional groups, and transaction sets. They also used to generate and
reconcile functional acknowledgements. All the required system translation
objects are automatically installed with the Sterling Gentran:Director
system.

TDCC SeeEDIA.

TDF TDF isthe Transaction Data File. Thisfile serves as afilter between your
document files and the Sterling Gentran:Director translator. For outbound
processing, datais imported from a TDF file and translated to EDI format
using a TDF Import trandation object. The data is then ready to be posted
and sent to your trading partner. For inbound processing, EDI documents
that are received by Sterling Gentran:Director can be exported to a TDF-
formatted file using a TDF Export translation object. This datafileisthen
ready to be processed or converted to your internal application files.

third-party network See Network.

title bar Thetitle bar of an application window contains the name of the application
and enables you to move the window to another position on your desktop.

toolbar This contains buttons that graphically represent commands available in the
Menu Bar.

TRADACOMS The U.K. standards for EDI that are published by the Article Numbering
Association (UK) LTD.
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turnaround map
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Another firm with which you company trades documents. Also referred to as
apartner.

A business form as defined by the standards. Examplesinclude an ANSI 850
purchase order or an EDIFACT INVOIC (invoice). The standards define
each transaction set in terms of the segments and elements that make up the
form, the order in which they appear, and the rel ationships among them. This
isalso known as “message’ in Europe.

A predesigned layout set up to ensure that input or output for a particular
transaction set exists and is presented in a usable fashion. You must specify
which trandation object(s) will be used by each partner relationship.

Inbound Translation Objects:

Turn Around: Thistranslation object is used when a document is received,
to create the natural response document that contains as many elements from
the received document as possible.

Export File: Thistrandation object indicates that when a document is
received, it will be exported to a specified file format.

Print: Thistrandation object is used to print documents.
Outbound Trandation Objects:

Import: Thistranslation object is used to import data from an application
file.

Print: Thistrandation object is used to print documents.
Data Entry: Thistranslation object is used to enter data into the Document
Editor facility.

Thisisthe engine that processes data for Sterling Gentran:Director, the
Application Integration subsystem, and the Forms Integration subsystem.

See Communications Session.

A path an EDI communication could follow, including one company, one
trading partner, and one or more network services.

A document into which data e ements from the source document have been
automatically transferred using a turnaround map.

A series of instructions that the system uses to create aturnaround document
(alogical response document to the source) from an inbound (source)
document, by transferring data from the source document to elementsin the
target document (translation object).
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UCs

update

use accum

use code

user translation
object

version

VICS

Workspace

X12

The Uniform Communications Standard is the standard used by the grocery
industry.

This standard rule enables you to update a specific field in a document
record, envel ope segment, interchange, group, current partner, or document
(if the map side format type is EDI), with the element or field contents.

This standard rule gives you access to a set of numeric variablesthat you can
mani pulate via numeric operations, and then transfer to and from fields. This
function enables you to add, change, or delete calculations for the element/
field, including hash total's (used to accumulate numeric field values, i.e.,
quantity, price, etc.). Thisfunction also enables you to map the accumulated
total into a control total field, and use accumulators. Accumulators are used
generally for counting the occurrences of a specific element or generating
increasing or sequential record or line item numbers.

This standard rule enables you to match an element or field against a
predefined code table, specify whether or not a compliance error will be
generated if the element or field does not contain one of the valuesin the
code table, and store a code’s description in another element or field.

These trand ation objects control data entry, importing, exporting, document
turnaround, and creating printed reports. These trandlation objects are
created using the Application Integration or Forms Integration subsystems.
The Application Integration subsystem enables you to generate import,
export, and document turnaround translation objects. The Forms Integration
subsystem enables you to generate data entry and print translation objects.

Each standards-setting body updates its standards on aregular basis. Each
formal updateis referred to asaversion.

The Voluntary Inter-industry Communication Standards is the standards-
setting body for the retail industry, a subset of ANSI X12.

This Sterling Gentran:Director browser contains alist of outbound “Work in
Progress’ documents. It also contains recently imported or data entry
documents.

The ANSI committee that sets and publishes standards for EDI.
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